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Notes and cautions

The following notes and cautions apply to the Elixir
Desktop and Converters for AFP.

Drivers

Elixir software supports printing using Windows
3.11 printer drivers under Windows 3.11.  Win-
dows 95 users must use a printer driver that sup-
ports API calls rather than Escape calls.  If you
have problems printing with a non-Elixir supplied
driver, check with the vendor to ensure that the
driver is appropriate for the operating system you
use.

Help files include graphics created using screen
drivers with large fonts. If you use a screen driver
with small fonts, Help file graphics may not dis-
play clearly. For optimum graphics display, use a
screen driver with large fonts.

Video drivers must be fully compatible with the
Microsoft Windows VGA/SVGA standard to en-
sure graphical integrity. If you encounter problems
when printing shading or graphics, the cause may
be an incompatibility between a third-party video
driver and the Microsoft standard.  To determine
if the problem is the third-party driver, switch to
the Microsoft VGA/SVGA driver  (for the screen
resolution currently in use). If this resolves the
problem, contact the video card distributor to see
if there is an updated version of their driver.  If
this still does not resolve the problem, contact
Elixir Customer Support.



Current versions of Elixir software for an AFP en-
vironment are applications which use Device De-
pendent Bitmaps (DDB). This allows fast graphic
manipulation, but the size of graphic that can be
manipulated and displayed is dependent on the
Windows screen driver installed.  

If you have problems with graphics not displaying
correctly, or experience unpredictable video ef-
fects (graphic or drawing elements not appearing
as they should), Elixir recommends that you in-
stall and use the Windows screen driver supplied
with Windows with either 256-colors or 16-colors.

BWCC.DLL file version

Installing a BWCC.DLL file in a directory other than
drive:\WINDOWS\SYSTEM may cause errors when
you perform operations such as copying files from the
User Files icon to Elixir folders.  Elixir installs a
BWCC.DLL file dated 1995 or later in your
drive:\WINDOWS\SYSTEM directory during installa-
tion.  Other programs may also install BWCC.DLL
files in different directories.  Remove these other ver-
sions of the BWCC.DLL file from your system to pre-
vent errors. 

Using the Desktop under Windows NT

All current versions of Elixir software run in a Win-
dows NT (version 3.51 and 4.0) environment.

Printing to HP printers

Windows NT uses a different HP soft font handling ar-
chitecture than other operating systems.  To ensure
true WYSIWYG printing capabilities, new printing
functions using raster fonts are implemented.  

Due to the new printing functions, you must regener-
ate all HP soft fonts (from Elixir generic fonts or pro-
duction printer fonts) before printing under Windows
NT.



Elixir has successfully tested a number of HP and HP-
compatible printers and printer drivers.  However, due
to the number of printer drivers and environmental
configurations, Elixir cannot guarantee that all drivers
and printers labeled "HP-compatible" will produce cor-
rect results.
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1.   Introduction

This guide describes the Elixir Desktop for AFP, the
Windows-based operating environment for launching
and using Elixir applications such as ElixirForm for
AFP, ElixirImage for AFP and ElixirFont for AFP.

Additionally, the Desktop has numerous productivity-
enhancing features, including those which enable you
to:

convert files using icons

link files to applications, thereby allowing you to
start an application and load a file in one step

define icons for DOS or Windows-based applica-
tions you want to launch from the Desktop, such
as word processors, desktop publishers and
spreadsheets.

Because this guide describes all functions and fea-
tures of the Desktop, certain options described herein
may not apply to your specific configuration. In such
cases, unavailable options display in gray (not black)
on menus and dialog boxes, and some screens and
icons may not display at all.

See the Elixir for AFP Getting Started Guide for de-
tailed installation information.  
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Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.

See the Elixir for AFP Getting Started Guide for infor-
mation about contacting your support center.

Elixir training

Elixir Technologies Corporation offers training for the
full range of our Windows-based family of products.
For more information, contact:

Who should use this guide

This guide serves users needing first-time or ongoing
reference information about the Elixir Desktop for
AFP. 

Users should already be familiar with Microsoft Win-
dows operations, printer and font management opera-
tions and PC peripherals, and have access to refer-
ence manuals for related PC software and hardware.

     Elixir Learning
(805) 641-5900  ext. 6

INTRODUCTION
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Conventions

Most of the following conventions are the same or
similar to Windows conventions.

display conventions

typographical conventions

mouse operations

Display conventions

The Elixir Desktop, ElixirForm, ElixirFont and Elix-
irImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse.  See your Win-
dows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide and other Elixir product guides.

Keystrokes are shown enclosed in < > (angle
brackets). For example:  

<Enter>

Key combinations are denoted by a plus sign be-
tween keys. For example: 

<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

INTRODUCTION
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Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs.  For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

Commands you enter at the DOS prompt are
shown in larger text.  Within DOS commands,
variable names and keys you press are shown in
italics.  For example: 

CD \ELIXIR <Enter> 

Mouse operations

You can perform most operations in Elixir applications
by using the mouse.  The terminology is similar to
other Windows based applications.

Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.

The following mouse related terms are used in this
guide:

click
to momentarily press and release the left mouse but-
ton once.  A right mouse button click is specified
where necessary.  For example,

Click on the right mouse button to finish entering text.

double-click
to click the left mouse button twice in rapid
succession.

INTRODUCTION
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drag
to click and hold the mouse on an item and move the
item with the mouse.

drag and drop
to drag an item as above, then release the mouse but-
ton, once the item is positioned over a the area.  If the
selected object is a file and the destination is a direc-
tory, the file copies to the directory.

object
a selectable item on the screen.

open
to point and double-click on an icon -- the effect of this
operation depends on the icon.

point
to move the mouse to position the screen pointer on
an area of the screen.

select
to point to an object and click the mouse -- this usually
highlights the object.

<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.

<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.

<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time. 

INTRODUCTION
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On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.

Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

INTRODUCTION
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Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

Organization of this guide

This guide contains the following chapters and
appendices:

Chapter 1, “Introduction,” presents an overview of
Desktop functions, features and documentation.

Chapter 2, “Desktop basics,” describes the layout and
basic operation of the Desktop. 

Chapter 3, “Elixir folders,” describes the Elixir direc-
tory structure and how to use the Desktop to organize
and manage forms, fonts, images, documents and
jobs.

INTRODUCTION
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Chapter 4, “Desktop configuration,” describes how to
customize the Desktop.

Chapter 5, “Additional Desktop features,” describes
further capabilities built into the Desktop.

Chapter 6, “Peripheral devices,” describes how to
configure and use PC diskette drives, scanners and
printers.

Chapter 7, “File conversions,” describes how to per-
form various file conversions.

Chapter 8, “Accessing DOS files and applications,”
describes tools that allow you to access DOS and link
DOS files to applications.

Chapter 9, “File Transfer,” describes how to transfer
files between your PC and host computer, and how to
download and upload files for subsequent processing.

Chapter 10, “Transformations,” describes how to ap-
ply Elixir utilities to modify Elixir-format form and im-
age files.

Appendix A, “Keyboard shortcuts,” describes all Desk-
top keyboard shortcuts (fast keys).

Appendix B, “Additional files and directories,” explains
the functions and use of related files not described
elsewhere in this guide.

Appendix C, “Desktop menu bar,” describes opera-
tions accessed from Desktop pull-down menus.

Appendix D, "AFP font conversion considerations,"
describes issues and strategies relating to AFP font
conversions.   

Glossary.

Index.

INTRODUCTION
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Installation

See the Elixir for AFP Getting Started Guide for instal-
lation information.

Starting the Elixir Desktop

To start the Desktop, double-click on the Elixir Suite
for AFP icon in the Program Manager Elixir Applica-
tions window.

The Elixir Desktop displays.

Figure 1-1.  Elixir Desktop

If you are using a monochrome monitor and have diffi-
culty reading Title bar text, select [Usage Switches]
from the System menu. Then, in the Usage Switches
dialog box, select [Monochrome Monitor].

INTRODUCTION
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An Elixir logo may also display at the center of your
screen. The logo disappears when you press a key on
the keyboard or a mouse button.

Note that you cannot move icons on the Desktop.

Exiting the Elixir Desktop

To exit the Elixir Desktop or any of its associated
applications:

Double-click on the Close button at the top left of
any Elixir application.

Press <Alt> + <F4>.

Press <Alt> + <X>.

From the File menu and select [Exit]

Click on the [X] at the top right corner of the appli-
cation window.

INTRODUCTION
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2.  Desktop basics

This chapter describes the Elixir Desktop layout and
basic operation. Later chapters describe more ad-
vanced Desktop operations.

Common Windows operating system

The Elixir Desktop uses the standard Windows inter-
face for display and use of operational elements such
as icons, command buttons, tools, menus, dialog
boxes and mouse. 

See your Windows manual for complete information.

Desktop layout

The Elixir Desktop comprises two main display areas:

The top of the Desktop displays the menu bar and
message area. 

The remaining Desktop area displays icons.  

Both menu bar and icons provide access to pull-down
menus. See the "Sub-window menus" section in this
chapter, and the "Desktop configuration" and "Addi-
tional Desktop features" chapters for more infor-
mation.

The message area displays information about the op-
eration in process, including relevant warning and er-
ror messages.
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Figure 2-1.  Desktop layout

Icons

Each Desktop icon represents an application, folder,
utility or PC device configured for your system. Gener-
ally, the name, shape and appearance of an icon indi-
cate its purpose or the type of action you can perform.

The following sections briefly describe each icon and,
where applicable, refer you to chapters where you can
find more information.
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Elixir folder icons

The five icons displayed at the top left of the Desktop
represent specific DOS directories. You can access
directory files and convert them from one format to
another using these icons.  

See the "Additional Desktop features", “Elixir folders”
and "File conversions" chapters for more information.

Forms folder

Represents the drive:\ELIXIR\FORMS directory con-
taining Elixir, Input and Output form files.

Fonts folder

Represents the drive:\ELIXIR\FONTS directory con-
taining Elixir, Input and Output font files.

Images folder

Represents the drive:\ELIXIR\PICS directory contain-
ing Elixir, Input and Output image files.

Documents folder

Represents the drive:\ELIXIR\DOCS directory contain-
ing form list files referencing the Elixir-format files for
multi-page documents.

Note that Documents folder functionality for .PDF files
requires PDF option products.

DESKTOP BASICS
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Jobs folder

Represents the DOS \ELIXIR\JOBS directory and is
used with Elixir AppBuilder to create multiple Elixir
form print files called Jobs. A job includes formatting
information for the print run and individual pages and
comprises a print ticket and form files.

Clipboard icon

Temporarily stores Elixir-format (.ELX) form files dur-
ing job creation. You can copy an Elixir-format form to
the Clipboard using standard copying procedures,
then copy the form to a specific job when you need it. 

User Files icon

Provides access to all DOS directories and files, and
links applications to files.  See the "Additional Desktop
features" and “Accessing DOS files and applications”
chapters and "Additional files and directories" appen-
dix for more information.

ElixirForm/AppBuilder for AFP application icon

Represents ElixirForm.  If you have Elixir AppBuilder
for AFP installed, you can toggle the icon between the
two applications by <Ctrl>-clicking on it. 

Opening this icon clears the Desktop and starts the
ElixirForm or AppBuilder for AFP application.

Other Elixir application icons

If other Elixir applications such as ElixirFont or Elix-
irImage are installed, icons representing these appli-
cations also display at the right of the Desktop. Open-
ing these icons starts the corresponding application.  
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User Tools icon

Allows you to create and define icons for DOS appli-
cations and batch files so that opening the icon starts
the application. 

See the "Additional Desktop features" and “Accessing
DOS files and applications” chapters for more infor-
mation.

Diskette icon

Allows you to access and format a diskette in your PC
disk drive.

See the “Additional Desktop features” and “Peripheral
devices” chapters for more information.  

Printers icon

Allows you to access a local proof printer connected to
your PC. 

See the "Additional Desktop features" chapter and
"Local Printers" appendix for more information.

Scanners icon

Allows you to start a scanner connected to your PC di-
rectly from the Desktop.

See the "Additional Desktop features" and "Peripheral
devices" chapters for more information.

Dispatcher icon

Allows you to invoke DOS commands or batch files in
which you can embed replaceable parameters.

See the "Additional Desktop features" and “Accessing
DOS files and applications” chapters for more infor-
mation.  

DESKTOP BASICS
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Converter icon

Allows you to convert form, font and graphics files and
multi-page documents to different formats by using
simple “drag-and-drop” mouse operations.

See the "Additional Desktop features" and “File con-
versions“ chapters for more information.

  Trashbin icon

Allows you to delete folders and files associated with a
specific directory or application.  

See the “Deleting files and folders” section for more
information.  

Viewer icon

Allows you to view Elixir-format files associated with
an application without having to first launch the ap-
plication.

See the "Additional Desktop features" chapter for
more information.  

Sub-window menus

The Elixir Desktop offers additional functionality to
normal Windows operations by providing pull-down
menus in sub-windows (or "child" windows) that you
can access from any Elixir folder icon. The following
sections describe these functions.
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Backup button

You can access the backup button by first opening
any Elixir folder on the Desktop (Forms, Fonts, Im-
ages or Documents), then opening any Elixir, Input or
Output folder.

Each click on the backup button (or <Ctrl>+<B>) dis-
plays the contents of a directory one level closer to the
root. 

You can also use the backup button to change the de-
fault directory of an Elixir, Input or Output folder in the
SYSTEM.INI file, as follows:

Select [Save Settings on Exit] in the Usage
Switches dialog box (System menu).

Use the backup button to change to the directory
you want as the default.

Exit/close the folder.

Figure 2-2.  Backup button

Filter menu

The Filter menu allows you to display files you select
using the * and ? DOS wildcard characters.

DESKTOP BASICS
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Figure 2-3.  Filter menu

For example, in the previous window, you can enter a
filter to display files that start with X as follows:

1. Select [Enter Filter] from the Filter menu.

2. In the File Name Entry dialog box (shown
below), type X*.* 

3. Click on [OK] or press <Enter>.

The window displays only those files beginning
with the letter X.

4. To turn off the filter, select [Turn Off Filter] in
the Filter menu.
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Figure 2-4.  File Name Entry dialog box

Selection menu

The Selection menu allows you to select and dese-
lect one or more specified files within a folder.  The
following figure shows a Selection menu example.

Figure 2-5.  Selection menu

The Selection menu contains the following options:

Wildcard Selection
Highlight files specified with * and ? DOS wildcard
characters.
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Write Selection <Ctrl>+<W>
"Remember” a number of selected files (see the Re-
select option, below).

Reselect <Ctrl>+<R>
Highlight files “remembered” using [Write Selection].
When you use [Write Selection] for files accessed
from a Desktop folder (Jobs, Forms, Fonts, Graphics
or Documents) icon, use [Reselect] to highlight files
with the same stem name (and the same or different
extensions) in another folder.

Select All <Ctrl>+<A>
Highlight all files in a window.  

Unselect All <Ctrl>+<A>
Deselect all highlighted files in a window.

Make Pubfile
Copy highlighted drive:\ELIXIR\FORMS\ELIXIR and
subordinate directory form files to a diskette. See the
"Additional Desktop features" chapter for more
information. 

Archive Pubfile
See [Make Pubfile], above. 

View menu

The following figure shows the View menu and an ex-
ample of viewing files using the [Show Actual] option.
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    Figure 2-6.  Show Actual example

The View menu allows you to display files in a window
in different ways.  The available options are:

Short Name
Display files by name only.

Long Name
Display files by name, creation/revision date and size
(in bytes).

Icon
Display files as icons, with names underneath.

Show Actual
Display reduced, bit-mapped screen versions of Elixir
form, font and image files. Allows you to preview files
without invoking the application and loading the file.

Name
Display files alphabetically by file name.
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Type
Display files alphabetically by file type (extension).

Date
Display files by creation/revision date.

Size
Display files by size (in bytes).

Ascending
Display files in ascending order, either by name or
type (alphabetically, with "A" first), by date (chronologi-
cally, with oldest date first) or by size (smallest file
first).

Descending
Display files in descending order, either by name or
type (alphabetically, with "A" last), by date (chronologi-
cally, with latest date first) or by size (largest file first). 

Settings
Displays the Local View dialog box which summarizes
the file view settings for the open folder.  View
changes in this dialog box override global view
settings.

You can apply view settings to all Desktop folders us-
ing the Global View dialog box.  See the "Elixir folders"
chapter for more information. 

Accessing DOS

The DOS menu allows you to run DOS commands
from the Desktop.

Selecting the [DOS Command] option or pressing
<Ctrl>+<D> displays a dialog box to allow you to enter
any standard DOS command. 
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Enter a DOS command and select [OK] to display the
Elixir Exec window and execute the DOS command
from either of the following directories:

the \ELIXIR directory, if no windows are open on
the Desktop

the directory corresponding to the window, if a
window is open on the Desktop.

After the DOS command executes, the system
prompts you to enter any key to redisplay the
Desktop.

See the “Accessing DOS files and applications” chap-
ter for additional ways to access DOS.

Exiting the Desktop

You can exit the Desktop in any of the following ways:

Click on the Exit Box at top left of Desktop
Press <Alt>+<F4>
Press <Alt>+<X>
Select [Exit] from the File menu.
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3.   Elixir folders

This chapter describes the Elixir Desktop folder or-
ganization. To better understand this chapter, you
should already be familiar with DOS directory
structures.

Folders and DOS directories

Directories and subdirectories are structures DOS
uses to store and organize files. Folder icons on the
Desktop represent DOS directories or subdirectories.
Just as a DOS directory contains files and subdirecto-
ries, Desktop folders contain files and other folders.

Using folder icons is easier than using DOS directo-
ries because you can display folder contents as icons
in a window, and copy files from one folder to another
(see the "Desktop basics" chapter in this guide).

The Elixir folder icons shown in the following figure
display at the top left of the Desktop.

         
         

     Figure 3-1.  Elixir folder icons

Elixir folder icons allow you to use simple mouse op-
erations to:

access and display Elixir-format files

copy Elixir-format files into different folders

convert form, font, image, document and job files
to and from Elixir format.
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To the right of the Elixir folder icons, the User Files
icon shown in the following figure displays.

 Figure 3-2.  User Files icon

The User Files icon allows you to access any file or
directory on your hard disk or diskette drive. See the
“Accessing DOS files and applications” chapter in this
guide for a description of the User Files icon.

Elixir folder structure

This section describes the structure and use of the
five Elixir folder icons.

Most Elixir folder icons contain three subordinate fold-
ers labeled Elixir, Input and Output.

For example, when you open the Elixir Forms folder
icon, the following window displays.

Figure 3-3.  Forms Folders window

Similarly, opening the Elixir Fonts, Elixir Images and
Elixir Documents folder icons display a window show-
ing subordinate folders called Elixir, Input and Output.

This folder structure allows you to edit or view form,
font, image, document and job files having different
formats, as shown in the following figure.
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Figure 3-4.  Input, Elixir and Output folders

Each Input folder is similar to an “in basket" con-
taining files you can convert to Elixir format by
copying them to the Converter icon. See the “File
conversions” chapter in this guide for more in-
formation.

Each Elixir folder is similar to a “working area”
where you can edit and view converted files.  

Each Output folder is similar to an “out basket”, to
which edited Elixir-format files are written after
you convert them to their original or other non-
Elixir format by copying them to the Converter
icon. See the “File conversions” chapter in this
guide for more information.

To use Elixir folders for file editing, follow these steps:

1. Copy a file you want to edit or view to the
appropriate Input folder.

2. Convert the file to Elixir format as described
in the “File conversions” chapter of this
guide.

3. Double-click on the converted Elixir-format
file to start the appropriate Elixir application
and load the file.

4. Edit the file using the tools provided by the
Elixir application.  After editing, save the file.

5. Convert the edited Elixir-format file to the
format you want.  The converted file writes to
the appropriate Output folder.
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6. Open the Output folder and copy the
converted file to the desired location.

The “File conversions” chapter in this guide describes
this procedure in more detail.

The following sections describe the different Elixir, In-
put and Output folders.

Changing folder display

You can modify Elixir folder display and apply these
changes to all folders (global) or only to the currently
open (local) folder.

To change the global folder view:

1. Select [Global View] from the Special menu.

The Global View dialog box displays.

             Figure 3-5.  Global View dialog box

2. Click on the button in the bottom of the dialog
box until GLOBAL displays (default is
LOCAL).

3. Select display characteristics, then click on
[OK].

To change a local folder view:
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1. Open the Elixir folder you want to change.

2. Select [Settings] from the View menu.

The Local View dialog box displays.

Figure 3-6.  Local View dialog box

3. Select display characteristics, then click on
[OK].

Forms folder

The Desktop Forms folder corresponds to the
drive:\ELIXIR\FORMS directory and contains the Elixir
Forms, Input Forms and Output Forms folders shown
in the following figure.

Figure 3-7.  Forms Folders window
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Elixir Forms folder

The Elixir Forms folder corresponds to the DOS
drive:\ELIXIR\FORMS\ELIXIR directory and any user-
defined subdirectories within the drive:\ELIXIR\
FORMS\ELIXIR directory (such as drive:\ELIXIR\
FORMS\ELIXIR\ DEMO).

The Elixir Forms folder displays Elixir form files (files
with .ELX name extensions). You can edit any file us-
ing ElixirForm for AFP by opening the file.

The Elixir Forms folder also displays files with .BAK,
.PUB and .INV name extensions, as follows:

.BAK extension files are backup form files that
ElixirForm creates. You can edit .BAK files if you
rename their extensions to .ELX.

.PUB extension files are publication files used for
archiving and copying Elixir form files and all re-
lated components (such as fonts and graphics
used on the form) to a diskette.  See the “Elixir
Fonts folder” section in this chapter for more
information.

When you use the ELXINV utility to convert .ELX
files to a different orientation (from portrait to in-
verse portrait, for example), you create .INV ex-
tension files.  To edit these files using ElixirForm,
rename the extensions to .ELX.  See the “Stand-
alone utilities” chapter for more information about
the ELXINV utility.

Input Forms folder

The Input Forms folder contains the folders shown in
the following figure:
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Figure 3-8. Input Forms folder

The Input Forms folder correspond to the following
subdirectories:

Output Forms folder

The Output Forms folder contains a number of subor-
dinate folders, as shown in the following figure.

Input Forms folder DOS subdirectory and file extensions

FOB Forms \ELIXIR\FORMS\FOBIN\*.*

AFP OVE Forms \ELIXIR\FORMS\OVEIN\*.OVE

OGL Forms \ELIXIR\FORMS\OGLIN\*.OGL

LOG Forms \ELIXIR\FORMS\LOGIN\*.LOG
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   Figure 3-9.  Forms Output Folders window

When you use the Converter icon to convert files (as
described in the “File conversions” chapter of this
guide), output files write to the Output folders with ap-
propriate file extensions, as shown in the table on the
following page. 

The above Output Forms folders show all formats to
which Elixir Desktop products can be converted.

Output Forms
folder

DOS subdirectory and file extensions

HP PCL Forms \ELIXIR\PRINTS\HPPRINT\*.PRN

PostScript Forms \ELIXIR\FORMS\PSOUT\*.PS

PDF Forms \ELIXIR\FORMS\PDFOUT\*.*

FOB Forms \ELIXIR\FORMS\FOBOUT\*.FOB

AFP OVE Forms \ELIXIR\FORMS\OVEOUT\*.OVE

OGL Forms \ELIXIR\FORMS\OGLOUT\*.OGL

LOG Forms \ELIXIR\FORMS\LOGOUT\*.LOG
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Fonts folder

The Fonts folder corresponds to the drive:\ELIXIR\
FONTS directory and contains the Elixir Fonts, Input
Fonts and Output Fonts folders as shown in the fol-
lowing figure.

 

    Figure 3-10.  Fonts Folders window

Elixir Fonts folder

The Elixir Fonts folder corresponds to the DOS
drive:\ELIXIR\FONTS\ELIXIR subdirectory and dis-
plays Elixir-format font file names with .HDR exten-
sions. You can edit these files using ElixirFont by
opening (double-clicking on) the files. See the Elixir-
Font User Guide for more information. 

Although only .HDR extension files display, each
Elixir-format font consists of three files having the
same stem name but different extension, as follows:

.HDR - the font header file

.GLH - the glyph (character) header file

.GLY - the glyph (character) bitmap file

The .GLH and .GLY files are also in the drive: \ELIX-
IR\FONTS\ELIXIR subdirectory, but do not display in
the window. You can display all three components if
you open the subdirectory using the User Files icon
described in the “Accessing DOS files and applica-
tions” chapter of this guide.

When you copy a font from the Elixir Fonts folder us-
ing the Desktop copy operation (copying to a diskette,
for example), all three file components copy.
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If you want to copy an Elixir font using either the User
Files icon or DOS COPY command, remember to
copy all three components for each file.

In addition, the Elixir Fonts folder may contain .COD
(Elixir code page file) and .CDF (Elixir coded font) font
components. These components describe mapping
information for converting the font to an AFP format
font. See the "File conversions" chapter or the Elixir-
Font for AFP User Guide for more information. 

The .COD and .CDF components display when you
select [Show Code Page] and [Show Coded Fonts]
from the Filter menu in the Elixir Fonts window
header.

Elixir versions of fonts converted from AFP fonts are
composed of additional files. See the “AFP font con-
version considerations” appendix for more informa-
tion.

Input Fonts folder

The Input Fonts folder contains subordinate folders,
as shown in the following figure.

Figure 3-11.  Fonts Input Folders window

To prepare a font file for conversion, first copy it to the
appropriate Input Fonts folder. Make sure the file has
the correct name extension for the folder, as shown in
the following table. 
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In the AFP and 3800 AFP Fonts folders, C*, T1*, or X*
font components display depending on whether you
select [Show Charset], [Show Code Page] or [Show
Coded Fonts], respectively, in the Filter menu ac-
cessed from the folder header.

The Outline Fonts folder displays internal names of
the font, as specified by the "menulabel" line in the
.TDF file.

Output Fonts folder

The Output Fonts folder contains a number of subor-
dinate folders

  Figure 3-12.  Fonts Output Folders window

Input Fonts folder DOS subdirectory and file extensions

HP PCL Fonts \ELIXIR\FONTS\HPIN\*.FNT

ATM Fonts \ELIXIR\FONTS\HPIN\*.ATM

True-Type Fonts \ELIXIR\FONTS\HPIN\*.TT

Outline Fonts \ELIXIR\FONTS\CONTOURS\*.TDF
\ELIXIR\FONTS\CONTOURS\*.SPD    
(default - also user-definable)

3800 AFP Fonts \ELIXIR\FONTS\I38IN\*.*

AFP Fonts \ELIXIR\FONTS\AFPIN\*.*

ELIXIR FOLDERS

ELIXIR DESKTOP FOR AFP USER GUIDE 3-11



When you use the Converter icon to convert files (as
described in the “File conversions” chapter), output
files write to the Output folders with appropriate name
extensions, as shown in the following table. 

The above Output Fonts folders show all formats to
which Elixir Desktop products can be converted.

Note that Elixir fonts converted from AFP fonts display
different file extensions. Character sets have .240 or
.300 extensions; code pages and coded fonts do not
have file extensions.

Output Fonts folder DOS subdirectory and file extensions

HP PCL Fonts \ELIXIR\FONTS\PRINTER\*.FLJ           
                  (regular fonts)

\ELIXIR\FONTS\PRINTER\*.RLJ           
         (rotated fonts for proof-printing)

ATM Type 3 Fonts  
    

\ELIXIR\FONTS\ATM3OUT\*.PS

Screen Fonts         
(user-defined subdirectory)

\ELIX-
IR\FONTS\SCREEN\DEMO\*.VGA (for

VGA monitors)                                                          
              
\ELIXIR\FONTS\SCREEN\DEMO\*.FNT
(for all other supported monitors)

\ELIXIR\FONTS\SCREEN\DEMO\
*.WDT                                                                     
(width tables)

Windows Fonts \ELIXIR\FONTS\SCREEN\WINDOWS  
  (Windows screen fonts)

3800 AFP Fonts \ELIXIR\FONTS\I38OUT\*.*

AFP Fonts \ELIXIR\FONTS\AFPOUT\*.*

AFP Fonts \ELIXIR\FONTS\AFPIN\*.*

HP PCL Fonts \ELIXIR\FONTS\HPIN\*.FNT
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 Images folder

The Images folder corresponds to the drive:\ELIXIR\
PICS directory and contains the Elixir Images, Input
Images and Output Images folders shown in the fol-
lowing figure.

Figure 3-13.  Images Folders window

Elixir Images folder

The Elixir Images folder corresponds to the
drive:\ELIXIR\PICS\PRINTER directory and contains
Elixir image-format files with .LP3 extensions. You can
edit these files by opening (double-clicking on) the
files. Opening a file starts ElixirImage for AFP and
loads the file.

Input Images folder

The Input Images folder contains a number of subor-
dinate folders, as shown in the following figure.

  Figure 3-14.  Images Input Folders window
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To prepare a file for conversion, first copy it to the ap-
propriate Input Images folder. Make sure the file has
the correct name extension for the folder, as shown in
the following table.

The above Input Images folders show all formats from
which Elixir Desktop products can be converted.

Output Images folder

The Output Images folder contains a number of sub-
ordinate folders, as shown in the following figure.

         Figure 3-15.  Images Output Folders window

When you use the Converter icon to convert files (de-
scribed in the “File conversions” chapter of this guide),
output files write to the appropriate Output folders with
appropriate file extensions, as shown in the following
table.

Input Images folder DOS subdirectory and file extensions

PCX Images \ELIXIR\PICS\PCXIN\*.PCX

TIFF Images \ELIXIR\PICS\TIFFIN\*.TIF

BMP Images \ELIXIR\PICS\BMPIN\*.BMP

AFP PSEG Images \ELIXIR\PICS\SEGIN\*.SEG
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The above Output Images folders show all formats to
which Elixir Desktop products can be converted.  

Documents folder

The Documents folder corresponds to the DOS
drive:\ELIXIR\DOCS directory.

It also contains subordinate Elixir Document, Input
Document and Output Document folders, as illus-
trated in the following figure.

   Figure 3-16.  Documents Folders window

Output Images folder DOS subdirectory and file extensions

HP PCL Images \ELIXIR\PRINTS\HPPRINT\*.*

PCX Images \ELIXIR\PICS\PCXOUT\*.PCX

TIFF Images \ELIXIR\PICS\TIFFOUT\*.TIF

BMP Images \ELIXIR\PICS\BMPOUT\*.BMP

Screen Images \ELIXIR\PICS\SCREEN\*.LW8

AFP PSEG Images \ELIXIR\PICS\SEGOUT\*.SEG
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Elixir Documents folder

The Elixir Documents folder corresponds to the
drive:\ELIXIR\DOCS\DOCLIST subdirectory and con-
tains form list files.

A form list file is a .DAT file you create for proof print-
ing using an ASCII editor, containing a list of Elixir
(.ELX) form files for a multi-page document. 

Input Documents folder

The Input Documents folder contains two subordinate
folders, as shown in the following figure.

 

         Figure 3-17.  Documents Folders window

To prepare a file for conversion, first copy it to the ap-
propriate Input Documents folder. Make sure the file
has the correct name extension for the folder, as
shown in the following table.

ELIXIR FOLDERS

3-16 ELIXIR TECHNOLOGIES CORPORATION



The above Input Documents folders show all formats
from which Elixir Desktop products can be converted.

Output Documents folder

The Output Documents folder contains a number of
subordinate folders, as illustrated in the following
figure.

   Figure 3-18.  Documents Output Folders 
   window

Note that the PDF Docs output folder displays only if
the PDF extended converter has been installed.

When you use the Converter to convert files (as de-
scribed in the “File conversions” chapter of this guide),
output files write to an Output folder with the appropri-
ate file extension, as shown in the following table.  

Input Documents
folder

DOS subdirectory and file extensions

HP PCL Docs \ELIXIR\DOCS\HPIN\*.HP                           
 (default - also user-definable)

AFP Docs \ELIXIR\DOCS\AFPIN\*.*

TIFF \ELIXIR\PICS\AFPIN\*.TIF

BMP \ELIXIR\PICS\BMPIN\*.BMP
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The above Output Documents folders show all for-
mats to which Elixir Desktop products can be
converted.

Jobs folder

The Jobs folder corresponds to the DOS ELIXIR\
JOBS directory and contains a number of subordinate
folders, as illustrated in the following figure.

Figure 3-19. Jobs folder

Output Documents folder DOS subdirectory

AFP Docs \ELIXIR\DOCS\AFPOUT\*.*

NorAFP Docs \ELIXIR\DOCS\NRAFPOUT\*.*

HP PCL Docs \ELIXIR\DOCS\HPOUT\*.*

PostScript Docs \ELIXIR\DOCS\PSOUT\*.*

PDF Docs \ELIXIR\DOCS\PDFOUT\*.*

XGF Docs \ELIXIR\DOCS\XGFOUT\*.*
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The Jobs folder subordinate folders correspond to the
following DOS subdirectories:

Elixir Docs Jobs 

The Elixir Docs Jobs folder corresponds to the
drive:\ELIXIR\DOCS\DOCLIST directory and displays
a list of Elixir jobs (.DAT files).  Each Elixir job is an
ASCII file that contains a list of Elixir form files and
print ticket information for the individual form files.

Elixir Data Jobs

The Elixir Data Jobs folder displays files in the
drive:\ELIXIR\JOBS\ELIXIR\SYSTEM directory. 

These are job files created using Elixir AppBuilder.
Note that the DOS file names in drive:\ELIXIR\JOBS\
ELIXIR\SYSTEM are not the same as those in the
Elixir Data Jobs folder; rather, the displayed names
are extracted from the DOS files.

Input Jobs

The Input Jobs folder contains folder icons as shown
in the following figure.

Job folder  DOS subdirectory and file extension

Elixir Docs Jobs \ELIXIR\DOCS\DOCLIST\*.DAT

Elixir Data Jobs \ELIXIR\JOBS\ELIXIR\SYSTEM

Input Jobs \ELIXIR\JOBS\PPFAIN\*.*
\ELIXIR\DOCS\AFPIN\*.*

Output Jobs \ELIXIR\JOBS\PPFAOUT\*.*
\ELIXIR\JOBSS\AFPOUT\*.*
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Figure 3-20. Input Jobs folder

The PDef/FDef folder corresponds to the drive: \ELIX-
IR\JOBS\AFPIN directory. Compiled object-format
FORMDEF and/or PAGEDEF files must be copied to
this directory for importing into AppBuilder. All file ex-
tensions are valid. 

See the Elixir AppBuilder for AFP User Guide for more
information.

Output Jobs

The Output Jobs folder contains folder icons as
shown in the following figure.

Figure 3-21. Output Jobs folder

The PDef/FDef folder  corresponds to the drive:\ELIX-
IR\JOBS\AFPOUT directory.  Compiled object-format
FORMDEF and/or PAGEDEF files generated by App-
Builder write to this directory. Output files have .OBJ
extensions.  

The PPFA Source folder corresponds to the drive:\
ELIXIR\JOBS\PPFAOUT directory. Source FORM-
DEF and/or PAGEDEF files generated by AppBuilder
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write to this directory. Output files have .SRC ex-
tensions.  

See the Elixir AppBuilder for AFP User Guide for more
information.

User Files folder

In addition to the Elixir folders described in the previ-
ous sections, the Elixir Desktop installation procedure
creates a number of directories that contain mapping
or correspondence tables. You can access these di-
rectories using the User Files icon described in the
"Additional Desktop features" and "Accessing DOS
files and applications" chapters. See the "Additional
files and directories" appendix for detailed information
on mapping table directories.
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4.  Desktop configuration

To customize your Elixir Desktop for AFP, you can
use the System menu options shown in the following
figure.  You can also access some options using the
shortcut keys displayed to the right of menu options.

Figure 4-1. Desktop menu bar

The System menu contains the options shown in the
following figure.

Figure 4-2. System menu

System menu              Special menu
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Each option in the System menu allows you to per-
form certain configuration actions:

System Config<Alt> + <F6>
Configures basic system parameters.

Usage Switches
Enables/disables selected Desktop functions.

User Privileges
Specifies user access controls.

Diagnostics <Alt> + <F5>
Accesses the diagnostics application.

Make Directory <Ctrl> + <M>
Creates a DOS directory

Converter Props
Specifies control parameters for the Converter icon.

Transformer Props
Specifies parameters for the Transformer icon.

Reset to Defaults
Resets all configuration parameters to default values.

Refresh
Refreshes the screen display.

Toolset 
Provides several Desktop toolsets.

System configuration

Select the [System Config] option in the System menu
to set system configuration parameters. The Desktop
Basic Setup dialog box displays and contains the fol-
lowing options:
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     Figure 4-3. Desktop Basic Setup dialog box

Warn on low disk space
Displays a warning when  disk space falls below the
[Threshold] value (default is 500 KB; maximum is 25
MB).

Show banner logo file
Display the banner logo .BMP file each time you start
the Desktop, if there are no open window.  The default
logo is DESKLOGO.BMP, but you can enter any .BMP
file residing in drive:\ ELIXIR\PICS\BMPIN.

Show conversion parameters
Displays conversion parameters when converting
files.

Clock Attributes
Clock Running
Displays the current date and time in the menu bar.

Clock Attributes
Set Time and Date
Displays the Date & Time dialog box for setting the
current date and time.

Double Click Speed
Speed at which successive mouse clicks interpret as
a double-click: [Slowest], [Slow], [Medium] (the de-
fault) or [Fast].
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Country Keyboard Map
Displays the Browse Country Keyboard Map dialog
box for selecting a .KMP file to convert to/from AFP
font format.   The selected file name displays on the
button's face when you click on [OK].  See the "AFP
font conversion considerations” appendix for more
information.

Default CodePage
Displays the Browse Code Page dialog box for select-
ing a default code page for font conversion.  The se-
lected file name displays on the button's face when
you click on [OK].

GCID File
Displays the Browse GCID File dialog box for select-
ing aGCID mapping file for converting non-AFP Elixir
fonts to AFP fonts.  The selected file name displays
on the button's face when you click on [OK].  Default
is C0ADOBE.

Tag Display
Specifies the data tags print option:
[None] - prints no data tags

[Replace Char]- prints form with the selected field
length and replacement characters

[Tag Name] - prints tags on the form using the field
name

Desktop usage switches

Select the [Usage Switches] option in the System
menu to customize your  Desktop.  The Desktop Us-
age Switches dialog box displays and contains the fol-
lowing options:
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   Figure 4-4. Usage Switches dialog box

Confirm file deletions
Displays the Confirmation for Command dialog box
when deleting file(s).

Confirm file overwrites
Displays the Confirmation for Command dialog box for
requesting confirmation of file overwrite.  This option
is only applicable for files copied through the Desktop.

Show diskette property sheet
Displays the Diskette Properties dialog box each time
you copy a file to or open the Diskette icon. See the
“Additional Desktop features” and “Peripheral devices”
chapters for more information.

Show printer property sheet
Displays the Printer Properties dialog box each time
you print a file. See the “Peripheral devices” chapter
for more information.

Show scanner property sheet
Displays the Scanner Properties dialog box each time
you use the Scanners icon. See the “Peripheral de-
vices” chapter for more information.

Save Settings on Exit
Retains the Usage Switches change made in the cur-
rent Desktop session and displays them in future
sessions.

Monochrome Monitor
Executes the DOS MODE MONO command required
for SIGMA monitors on PS/2 systems and for newer
(after 1990) SIGMA monitors running in monochrome
(non-grayscale) mode.
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Converter
Displays the Converter Properties Dialog which con-
tains the following options:

                Figure 4-5. Converter Properties Dialog dialog box

Working Directory
Directory where temporary read/writes occurs
during transformations. Default is the root (\). We
recommend specifying a RAM disk for faster
transformations.

Confirm file overwrites during transformation
Requests confirmation before overwriting existing
output files. Deselect this option automatically
overwrite existing files.

This option is applicable only when transforming
form and .LGO files to Elixir format. 

Show properties before transformation
Specifies default dialog box setup options for
each file transformation type.

Pause after transformation
Pauses after each transformation.

Stop process after: 
Select when to stop processing:

[Error] -  stops a conversion when an error occurs

[All files processed] -  stops conversion after
processing all files
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User privileges

Select the [User Privileges] option in the System
menu to select the level of control over certain Desk-
top operations for the Elixir Desktop user.

 Figure 4-6. User Privileges dialog box

For example, you can choose whether or not to allow
a user to access an Elixir application from the Desk-
top. If you choose not to allow access, the icons rep-
resenting the Elixir application and its associated
folder do not display.

Delete Files
Users cannot delete files.

Change file properties
Users can enter the file name in a Properties dialog
box.

Backup beyond default directories
In the Elixir file structure,  backs up directories to the
specified drive. When not selected,  backs up to the
default directory for the Elixir (Forms, Fonts, Graphics,
and Documents) folders only (recommended).

Access Forms
Allows access to ElixirForm for AFP or Elixir-format
form files. The icons representing both do not display
on the Desktop if you do not select this option.
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Access Fonts
Allows access to ElixiFont or Elixir-format font files.
The icons representing both do not display on the
Desktop if you do not select this option.

Access Images
Allows access to ElixirImage or Elixir-format image
files. The icons representing both do not display on
the Desktop if you do not select this option.

Access Documents
Allows access to non-Elixir files. The User Files icon
does not display on the Desktop if you do not select
this option.

Access Userfiles
Allows access to non-Elixir applications. The User
Tools icon does not display on the Desktop if you do
not select this option.

Access Usertools
Allows access to the User Tools icon. The icon does
not display if you do not select this option.

Access Scan
Allows access to the ElixirScan icon. The icon does
not display if you do not select this option.

Access Dispatcher
Allows access to the Dispatcher icon. The Dispatcher
icon does not display on the Desktop if you do not se-
lect this option.

Access Transformer
Allows access to the Transformer icon. The icon does
not display if you do not select this option.

Access Converters
Allows access to the Converter icon. The icon does
not display if you do not select this option.

Perform Reset to Default
Enables resetting system defaults from the System
menu.

Access DOS
Allows DOS access from the Desktop.
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Diagnostics

Select the [Diagnostics] option in the System menu  
to run a number of diagnostic utilities and/or enter a
command to run a diagnostic program of your choice.
The Desktop Diagnostics dialog box displays and con-
tains the following options:

            Figure 4-7. Desktop Diagnostics dialog box

Free Memory
Displays available memory in KB.  The figure dis-
played also includes the size of the Windows swap file
on your PC.

Free Resources
Displays available Windows resources as a
percentage.

Base Memory
Displays total system RAM.

Maximum file list
Displays the maximum number of files that can dis-
play in a window.

Disk Space Left
Displays the disk space left on the hard disk on which
the Elixir Desktop displays.

Current drive:
Displays the current drive.

View Install 
Displays the log file INSTALL.LOG that generates
when installing Elixir software on your PC. When you
report any problems to the Support Center, the center
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may ask for the contents of this log file to help deter-
mine the source of your problem.

View Autoexec.BAT
Displays the contents of the AUTOEXEC.BAT file.

Show Installed ElixiKeys
Displays installed ElixiKeys on your PC.

View Config.SYS
Displays the contents of the CONFIG.SYS.

Creating a directory

Select the Directory] option in the System menu to
create a directory in the entered path.  The Enter Path
of Directory to Create dialog box displays and con-
tains the following options:

          Figure 4-8. Enter Path of Directory to Create 
          dialog box

Enter the name and path of any directory you want to
create, then click on [OK] to create the directory.

If you do not enter a full path for a directory name:

If a window is open, the directory you enter be-
comes subordinate to the directory corresponding
to the window.  

If the Desktop does not display any open win-
dows, the directory becomes subordinate to the
root directory, on the drive on which you loaded
Elixir software.
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Converter properties

Select the [Converter Props] option in the System
menu to select/enter initial setup options for convert-
ing files.

The Converters Properties dialog box displays and
contains the following options:

       Figure 4-9. Converters Properties dialog box

Converter Property Sheets
Form Converters
AFP
Displays the AFP Page Converter Options dialog box
for setting AFP page conversion parameters.

Converter Property Sheets
Form Converters
PostScript
Displays the PostScript Converter Options dialog box
for setting PostScript conversion parameters.

Converter Property Sheets
Font Converters
AFP
Displays the AFP Font Converter Options dialog box
for setting AFP font conversion parameters.

Converter Property Sheets
Font Converters
Outline
Displays the Outline-to-raster font generator dialog
box for setting outline font conversion parameters.
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Converter Property Sheets
Image Converters
AFP
Displays the AFP Image Converter Options dialog box
for setting AFP image conversion parameters.

Converter Properties
Displays the Converter Properties Dialog dialog box
described in the "Usage Switches" section.

Message Reporting
Displays the Message Options dialog box which con-
tains the following options:

     Figure 4-10. Message Options Dialog 
     dialog box

Message Reporting
Show messages after process
Displays any error messages on-screen after
processing.

Message Reporting
Write Messages to LOG file
Writes any error messages to the file (.LOG) en-
tered in the text box.

New Messages
Overwrite LOG file
Overwrites the previously-created .LOG file after
processing.

New Messages
Append to LOG file
New error messages add tot he end of the
previously-created .LOG file.

A maximum of 64 KB of text displays in the mes-
sage log window.  If message text exceeds this,
the message window displays empty and
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messages write to drive:\ELIXIR\MESSOUT.MSG
which is viewable in any text editor.

Transformer properties

The [Transformer Props] option in the System menu
displays the Transformer Properties dialog box which
contains the following options:

      Figure 4-11. Transformer Properties 
      dialog box

Transformer Properties
Displays the Transformer Properties Dialog dialog box
which contains the following options:

        Figure 4-12. Transformer Properties Dialog 
        dialog box

Working Directory
Directory where temporary read/writes occurs
during transformations. Default is the root (\). We
recommend specifying a RAM disk for faster
transformations.
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Confirm file overwrites during transformation
Requests confirmation before overwriting existing
output files. Deselect this option automatically
overwrite existing files.

This option is applicable only when transforming
form and .LGO files to Elixir format. 

Show properties before transformation
Specifies default dialog box setup options for
each file transformation type.

Pause after transformation
Pauses after each transformation.

Stop process after: 
Select when to stop processing:

[Error] -  stops a conversion when an error occurs

[All files processed] -  stops conversion after
processing all files

Message Reporting
Displays the Message Options Dialog dialog box.  See
the "Converter properties" section for more
information.

Resetting System menu options

The [Reset to Defaults] option resets the specifica-
tions selected in the [System Config], [User Privi-
leges], and [Diagnostics] options in the System menu
to initial default values.

Refreshing the screen

If closing a window does not completely remove it or
leaves “snow” on the screen, use the [Refresh] option
in the System menu to refresh the screen.
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Selecting toolsets

When you install more than one version of the Desk-
top on a PC drive, select the [ToolSet] option in the
System menu to switch between versions.

The Desktop Toolsets dialog box displays and con-
tains the following options:

          Figure 4-13. Desktop Toolsets dialog box

Full HYBRID Desktop
Allows conversion of all installed Desktop versions.

AFP Desktop
Displays the AFP Desktop.

AS/400 Desktop
Displays the AS/400 Desktop.

Distributed Desktop
Displays the Elixir Forms Editor Desktop.

Xerox B & W
Allows all black-and-white Xerox conversions.

Xerox H/L Color and B & W
Displays the Desktop for the Elixir HighLight Option
and Plus products. Allows color and black-and-white
Xerox conversions, if you installed both versions (for
users running both B&W and color monitors and
Xerox 4850 and other printers).

Xerox Distributed Printers
Displays the 4235 XES Desktop.

Desktops differ in icon appearances and allowed file
conversions which display in the Converter icon dialog
boxes. See the “File conversions” chapter for more in-
formation about file conversions, and the tabbed
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printer sections for more information about different
Desktop versions.
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5.  Additional Desktop
 features

This chapter describes additional operations you can
perform using the Desktop icons and menu bar File,
System and Special menus. You can perform most
of these operations using keyboard shortcuts, as de-
scribed in the "Keyboard shortcuts" appendix.  

The following figure shows the Desktop menu bar.

Figure 5-1.  Desktop menu bar

Operations described in this chapter include:

opening icons
setting icon properties
displaying/deleting different formats of a file
displaying a logo at start-up
copying files
using the Scheduler Desktop
viewing files.

If you are just starting to use the Desktop, you may
want to read the “Desktop basics” chapter first to be-
come more familiar with general Desktop operations.  
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Opening icons

Opening an icon typically starts a corresponding appli-
cation or causes a window or dialog box to display
showing properties related to the icon. In most cases
you can modify the properties displayed to affect the
performance of the object represented by the icon.

You can open an icon in any of the following ways:

Double-click on it
Click on it and press <Enter>
Click on it and select [Open] from the File menu.

The following sections describe the results of opening
various icons.

Opening a folder icon

When you open a (Forms, Fonts, Images or Docu-
ments) folder icon, a window showing the contents of
the folder displays. Each folder typically comprises
one or more sub-folders containing files. Note that
each folder corresponds to a DOS directory. 

Opening Elixir files

Elixir files are generic Elixir-format files that you ac-
cess from the Desktop Elixir folders, and include:

Elixir-format form files in the Elixir Forms folder
(drive:\ELIXIR\FORMS)

Elixir-format font files in the Elixir Fonts folder
(drive:\ELIXIR\FONTS)

Elixir-format graphics files in the Elixir Graphics
folder (drive:\ELIXIR\IMAGES)

Elixir-format document files in the Elixir Docu-
ments folder (drive:\ELIXIR\DOCS).
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When you open an Elixir file, the corresponding Elixir
application starts and the file loads in the application.

For example, when you open an Elixir form file, the
Elixir Forms Editor application starts, and the form file
loads (displays on the screen), ready for editing.

Note that your PC must have the corresponding appli-
cation installed and enabled. Elixir applications can be
enabled/disabled using the System menu, as de-
scribed in the “Desktop configuration” chapter.

Note also that you cannot open an Elixir document
icon in the Elixir Docs folder (drive:\ELIXIR\DOCS).

Opening the ElixirForm icon

Opening the ElixirForm icon at the right of the Desktop
starts the ElixirForm application. When you exit the
application, the Desktop redisplays. 

Note that pressing <CTRL> and clicking the right
mouse button on the icon instead displays icons rep-
resenting other installed applications.  

Opening device icons

Opening a device icon displays a dialog box for view-
ing or modifying the current properties of the device
represented, as follows:

Diskette icon

Configures your PC's internal or external diskette
drive. See the "Icon properties" section and “Periph-
eral devices” chapter for more in- formation.

Printers icon

Configures alocal proof printer connected to your PC.
See the "Icon properties" section and "Local Printers"
appendix for more information.
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Scanners icon

Configures scanners connected to your PC. See the
"Icon properties" section and “Peripheral devices”
chapter for more information.

Opening other icons

Opening the User Tools, User Files, Dispatcher, Con-
verter and Viewer icons results in different displays:

User Tools icon

Displays the User Tools window for creating an  icon
for DOS applications or batch files. See the "Access-
ing DOS files and applications" chapter for more
information.

User Files icon

Displays the User Files: Directory Paths and Tool
Links dialog box for linking  fileswith DOS applica-
tions. See the "Accessing DOS files and applications"
chapter for more information.  

Dispatcher icon

Displays the Dispatcher Commands dialog box for en-
tering DOS batch commands. See the "Icon proper-
ties" section and “Accessing DOS files and
applications” chapter for more information.

Converter icon

Displays the Converter Properties dialog box for con-
verting form, font and graphics files to and from differ-
ent formats. See the "Icon properties" section and
"Desktop configuration" and "File conversions" chap-
ters for more information.

Viewer icon

Displays the Windows Notepad for displaying the con-
tents of an Elixir-format file for editing. See the "View-
ing files" section for more information.
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Displaying Icon properties

Using the Desktop, you can view and modify property
specifications for the following:

Converter icon
Dispatcher icon
Viewer icon
device (Diskette, Scanners and Printers) icons
file icons.

To display and modify properties for any of the above,
select the appropriate icon, then perform one of the
following:

Press <F2>.
Press the right mouse button.
Select [Properties] from the File menu.

Files

Selecting [Properties] for a file icon displays the File
Object Properties dialog box which contains the fol-
lowing options:

Figure 5-2. File Object Properties dialog box

File name and extension
The name and extension of the selected file. Enter a
new file name and extension to rename the file.

File type
Selected file type.  For example, Elixir, HP PCL, or
PostScript.

File size
Size of the selected file in bytes.
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Date of last access
Date file created or last changed.

Time of last access
Time file last accessed.

If you select more than one file, a dialog box for each
subsequent file displays when you click on [OK] or
[Cancel].  

Displaying Elixir file formats

When you convert Elixir and Input folders files, files
with the same stem names but different extensions
write to the appropriate Output folders (see the “Elixir
folders' and “File conversions” chapters for more in-
formation).

The Desktop file formats feature allows you to select a
file in any Elixir folder, and to display all files with the
same stem name but different extensions on the drive
to which Elixir installs. This feature also allows you to
delete either all or selected file formats from the
directory.  

To display different versions of a file, select the de-
sired file from an Elixir folder, then select [Formats]
from the File menu. The File Formats dialog box dis-
plays and contains the following options:

           Figure 5-3. File Formats dialog box

No Operation
Performs no operations on displayed files.
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Delete * Formats
Deletes all displayed formats of a selected file.

Delete * except Elixir
Deletes all formats of a selected file, except the Elixir
format.

Printing Desktop folder contents

You can display and print a listing of all files in a
folder.

To display all files in a folder:

1. Open the desired folder.

2. Select [Enter Filter] from the Filter menu.

The File Name Entry dialog box displays.

Figure 5-4.  File Name Entry dialog box

3. Enter *.* in the [Selecting File(s)] option, then
click on [OK].

To print the listing of a folder:

1. Open the desired folder.

2. Select [Print Directory Listings] from the File
menu.

The Print dialog box displays.
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Figure 5-5.  Print dialog box

3. Select/enter print information, then click on
[OK].

Displaying a logo

You can configure the Desktop to display a logo upon
start up. The logo displays only if you closed all win-
dows when last exiting the Desktop.

The displayed logo may be any .BMP graphics file in
drive:\ELIXIR\PICS\BMPIN. The default logo is
DESKLOGO.BMP.
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To specify the logo to display:

1. Select [System Config] from the System
menu.

The Desktop Basic Setup dialog box displays.

              Figure 5-6.  Desktop Basic Setup dialog box

2. Select [Show banner logo file], enter the stem
name of the .BMP file in the
drive:\ELIXIR\PICS\BMPIN to display, then
click on [OK].

Depending on your monitor's screen resolution,
the size of the displayed logo changes.

Copying files

Copying files involves different procedures, depending
on whether you are copying files to or from:

Elixir folders 
DOS directories on the hard disk
DOS-format diskettes
DOS Elixir-format diskettes
Viewer icon
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In each case, you select files from a window and then
copy them in one of the following ways:

Drag and drop files on the destination icon.

Press <Ctrl>+<C>, then click on destination icon.

Select [Copy] from the File menu, then click on
the destination icon.

Copying files to Elixir folders

You copy files to Elixir folders when you convert files
to different formats. However, before conversion,
make sure the files have the correct  extension.  See
the “Elixir folders” chapter for more information.

Copying files to a DOS directory

This section describes how to use the Desktop to
copy files from one DOS hard disk to another.

To copy file(s) in a window to another hard disk direc-
tory, select the files and drag and drop them on the
User Files icon. The User Files: Directory Paths and
Tool Links dialog box displays and contains the follow-
ing options:

     Figure 5-7.  User Files: Directory Paths and Tool Links dia-
log box
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To specify the target directories (maximum 12), per-
form one of the following:

Enter the directory into which you want to copy
files

When the directory you want to copy files to dis-
plays, select (highlight) it

Select any line that shows a path and edit it

If the directory you enter does not exist, a dialog box
displays requesting confirmation to create a new di-
rectory.  Select [Yes] to create the new directory.  An
empty window for the new directory displays. 

You can also use wildcard characters to display a fil-
tered list of files in a directory.

Click on [OK] to copy the files. See the “Accessing
DOS files and applications” chapter for more informa-
tion.

Copying files from a DOS directory

To copy one or more files from a DOS directory, open
the User Files icon to display the User Files: Directory
Paths and Tool Links dialog box.

Enter the name of the directory from which you want
to copy files or, if the path to the directory displays, se-
lect it and click on [OK].

A window similar to the following figure displays,
showing the contents of the directory.  In the window,
select the files you want to copy, then drag and drop
the files on the Desktop target icon.  The target icon
can be any of the Elixir folders, the Diskette icon or
the User Files icon.
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      Figure 5-8.  Directory window example

Copying files to a DOS-format diskette

To copy selected files from a displayed window to a
DOS-format diskette:

1. Copy the selected file from your diskette(s) to
the Diskette icon on the Desktop.

The System Diskette dialog box displays and contains
the following options:

         Figure 5-9.  System Diskette dialog box 

Directory on Diskette to open
Destination for writing files.

Diskette Drive
Disk drive identifier for your disk drive.

Diskette Type
Select the diskette type: [DOS User-Defined] or [DOS
Elixir].
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Diskette Access
Select the diskette format:

[For WRITing] - formatted diskettes

[Perform FORMAT] - creates a DOS-formatted
diskette

2. Select/enter file copy options, then click on
[OK].

Copying files from a DOS-format diskette

To copy files from a DOS-format diskette, open the
Diskette icon to display the System Diskette dialog
box.  Select/enter the following information:

Directory on Diskette to open
The diskette directory from which you want to copy
files.

Diskette Drive
The identifier for your disk drive.

Diskette Type
[DOS User-Defined] to copy files from a DOS
directory.

A window displays showing the contents of the en-
tered directory.  Select the files, then copy the files to
a target icon on the Desktop.

Copying files to a DOS-Elixir format diskette

A DOS Elixir-format diskette is a DOS-format diskette
that contains the Elixir file directory structure. You can
copy files such as .PUB files to a DOS Elixir-format
diskette without first creating the destination Elixir di-
rectories on the diskette.

To copy selected files from a displayed window to a
DOS Elixir-format diskette, insert a diskette into your
PC disk drive. If the diskette is not already DOS Elixir
formatted, select the [DOS Elixir] and [Perform FOR-
MAT] options to format the diskette before copying
files.
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Copy the selected files to the Diskette icon on the
Desktop.

The System Diskette dialog box displays.

        Figure 5-10.  System Diskette dialog box 

Select/enter the following information, then click on
[OK]:

Directory on Diskette to open
Select [DOS Elixir] to display the drive:\ELIXIR direc-
tory.

Diskette Drive
The identifier for your disk drive (normally A or B).

Diskette Type
[DOS Elixir] -  copies files to a DOS Elixir-format
diskette. 

Diskette Access
As appropriate, select either [For WRITing] for a for-
matted diskette or [Perform FORMAT] to create a
DOS-formatted diskette with an Elixir directory
structure.

Copying files from a DOS Elixir-format diskette

To copy files from a DOS Elixir-format diskette, open
the Diskette icon on the Desktop to display a System
Diskette dialog box.
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Select/enter the following information, then click on
[OK]:

Directory on Diskette to open
Drive to copy files from.

Diskette Drive
The identifier for your disk drive.

Diskette Type
[DOS Elixir] - copies files from an Elixir diskette.

Diskette Access
[For READing]

A window displays showing the contents of the en-
tered directory. Select the file, then copy the files to a
target icon on the Desktop.

Copying files from Output to Input folders

To copy one or more files from an Elixir Output folder
to a corresponding Input folder:

1. Select the output file(s) from the Output
folder.

2. Copy the file(s) to the destination Elixir icon
on the Desktop.

The selected file(s) copy into the appropriate In-
put folder.  

You cannot copy files directly from the Output Docu-
ments folder to the Input Documents folder. Instead,
you must copy them to the User Files icon, and then
enter the path for the appropriate Document Input
folder in the User Files: Directory Paths and Tool
Links dialog box that displays.

Note also that you cannot copy files from an Input
folder to an Output folder.

Copying Elixir form files

To copy a form file and all associated elements, use
the Desktop archival feature.
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The archival feature creates a publication (.PUB) file
containing references to all font, graphics and form in-
formation for an Elixir-format (.ELX) form file in the
Elixir Forms folder (drive:\ELIXIR\FORMS\ELIXIR).

You cannot use standard DOS or Elixir copy proce-
dures to copy Elixir form files because these files con-
tain elements such as text, fonts and graphics that
reside in different Elixir directories.

Creating a .PUB file

To create a .PUB file for an Elixir form file, follow
these steps:

1. Select the .ELX file to archive.

2. Select [Make Pubfile] from the Selection
menu.

The Elixir Publication File dialog box displays.

3. Select/enter information, then click on [OK].

              Figure 5-11.  Elixir Publication File 
        dialog box 

The Elixir Publication File dialog box contains the fol-
lowing information:

PubFile name
The name of the .PUB file you want to create, based
on the .ELX file stem name.

ADDITIONAL DESKTOP FEATURES

5-16 ELIXIR TECHNOLOGIES CORPORATION



Include Screen Fonts
Includes screen fonts in the .PUB file.

Include Screen Graphics
Includes screen images in the .PUB file.

Include Printer Fonts
Includes proof printer and rotated fonts (for the proof
printer you specify in the [Proof Printer Fonts for] op-
tion) in the .PUB file.  

Include Printer Graphics
Includes printer images in the .PUB file.

Include Elixir Fonts
Includes Elixir versions of the fonts in the .PUB file.

Pubfile Version 1.0 Compatible
Disables the [Include Elixir Fonts] option so that .PUB
files you create are usable in previous versions of the
Desktop.

Proof Printer Fonts For
Specifies your proof printer as [HP LJ].

The Elixir Desktop creates a .PUB file in the Elixir
Forms folder with the same stem name as the file you
selected.  If a .PUB file with the same name exists in
the Elixir Forms folder, the program prompts you to
confirm overwriting it.

You can view the contents of a .PUB file by double-
clicking on its icon as shown in the following figure.  

            Figure 5-12.  Publication file components example
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Copying a .PUB file to a diskette

To copy a .PUB file to a diskette:

1. Insert a formatted diskette into your diskette
drive.  Open the Diskette icon and make sure
[Diskette Drive] indicates the correct drive.

2. Select the .PUB file from the Elixir Forms
window.

3. From the Selection menu, select [Archive
Pubfile].

Alternatively, copy the .PUB file to the Disk-
ette icon.

All directories and related files required for each ele-
ment of the .PUB file copy to the diskette.  If a .PUB
file with the same name exists on the diskette, the
program prompts you to confirm overwriting it. Your
confirmation also overwrites any component files with
the same stem name.

Restoring a .PUB file from a diskette

To copy a .PUB file and all associated graphics, font
and form files from a diskette to your hard disk, follow
these steps:

1. Insert the diskette into your diskette drive.

2. Open the Diskette icon, and select
[DOS-Elixir] to display a window with the
diskette contents.

3. Displays the drive:\ELIXIR\FORMS\ELIXIR (or
subordinate directory) window that contains
the .PUB file.

4. Copy the .PUB file icon to the Desktop Forms
icon.

5. Click on the Elixir Forms folder in the
displayed window.

The .PUB file and all associated files copy to the ap-
propriate Elixir folders. If a .PUB file with the same
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name exists in the Elixir Forms folder, the program
prompts you to confirm overwriting it.  Your confirma-
tion also overwrites any existing component files with
the same stem name.

If you restore a .PUB file to a PC with a different moni-
tor than the PC from which you copied the form file,
your screen fonts and screen graphics may not dis-
play correctly. For correct font and graphics display,
use the Converter icon (described in the “File conver-
sions” chapter of this guide) to regenerate the screen
fonts and graphics.  

Using the Elixir Scheduler Desktop

The Elixir SchedulerDesktop allows you to specify
automated file conversions, batch file execution and
other actions, and the conditions for their
performance. 

The actions you can specify are:

file conversions

running transcripts

executing an application defined as a User Tool

executing an application defined in the Dispatcher
icon

executing any .BAT, .EXE or .COM command.

The conditions for which you can specify the above
actions are:

the date and/or time for performing an action

checking for the existence of a file before per-
forming an action

performing an action at specified intervals.
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Examples of automated actions you can specify with
the Scheduler Desktop are:

If files in an Input Folder are present, convert
them to one or more formats.

At a certain time, perform a certain action (such
as back up files).

(Later, this section provides detailed examples.)

In addition, if you install the Elixir Desktop on a dedi-
cated PC attached to a network, the Scheduler en-
ables uploading files to another destination, for
example, to a high-speed printer.

As an example of a Scheduler setup:

You can print an application document to a file on
a Network Scheduler. 

The Scheduler Desktop detects the file and con-
verts it from its native format to a high speed
printer format.

The Scheduler then automatically sends the file to
the printer for processing.

Scheduler setup

To execute operations from the Scheduler Desktop,
follow these steps:

First, install the Scheduler Desktop on a dedicated PC
attached to the network.

If you want to specify automated file conversions, fol-
low steps 1 through 4.  If you want to specify actions
other than file conversions (such as executing batch
files), go to step 5.

1. Open the User Files icon and specify the
Network Scheduler directory to which the files
print to disk (see the "Accessing DOS files
and applications" chapter for more
information).
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2. Install the appropriate converter on the
Network Scheduler drive or set its input and
output paths to the Network Scheduler drive.

3. Right-click on the Dispatcher icon and set up
the Dispatcher to run the files for conversion
through a DOS batch file (see the "Accessing
DOS files and applications" chapter for more
information).

4. Click on [Setup] in the Dispatcher Commands
dialog box and in the displayed User
Application Setup dialog box, click on [Send
only Filename].

Create the batch file to perform the following:

convert input Dispatcher files to the output format
you previously set up in the Desktop

write an error log; you can set the Scheduler
desktop to check for the existence of the log and
to pause or to transmit an error message if it ex-
ists  

send files directly to the printer

delete any unwanted files on the PC.

(Later, this chapter describes more details about
these actions).

5. Set up the Scheduler Desktop by selecting
[Scheduler Setup] from the Special menu, or
by pressing <Alt> + <F2>

Make the appropriate selections in the Scheduler
Setup dialog box shown in the following figure.

    Figure 5-13.  Scheduler Setup dialog box
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All Scheduler Activity
Sets processing to [Processing] (on) or [OFF] for up to
eight Scheduler actions.  [Processing] polls each
Scheduler action to test it for a TRUE, condition.  If a
Scheduler action tests TRUE a consequent action
results.

Task Scheduling by
The processing mode.  [ID Priority] processes Sched-
uler actions using number 1 as the highest priority,
and number 8 as the lowest priority.  [Circular proc-
essing] processes Scheduler actions sequentially
without priority.

Number of allowable scheduler tasks
The number of Scheduler actions tested for when you
select [Processing].  The maximum is eight actions.

Timing delay between scheduler tasks
The frequency at which the Scheduler tests for TRUE
Scheduler actions, in seconds.

6. Set up the Scheduler action by selecting
[Scheduler Actions] from the Special menu, or
pressing <Alt> + <F3>.

          Figure 5-14.  Scheduler Tasks dialog box

Task
Allows definition of up to eight Scheduler actions
(tasks), and to set [Task processing ON] (select) or off
(leave deselected).  Click on [Next] or [Prev] to display
and to modify tasks 1 through 8.
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Task test
[On File(s)] tests for the existence of a file in a direc-
tory, both of which you specify (see next options),
[On DateTime] tests for a specified PC date and time,
[Test TRUE] continually executes the specified action
at the timing interval specified in step 5.

File(s) test Directory
The directory in which the Scheduler checks for the
existence of a file if you select [on File(s)] in Task
test.

Filename(s)
The file for which the Scheduler checks if you selected
[on File(s)] in Task test.  DOS wildcards are permissi-
ble.  [Any] searches for any files in the specified
directory.

Date
When testing for passage of a specified date, enter
the day, month, and year you want the Scheduler ac-
tion processed.  Select [Any] after the date to process
the Scheduler action every day at the time specified
by Time.

Time
When testing for passage of a specified time, enter
the hours, minutes, and seconds you want the Sched-
uler action processed.

Action to take
Select [Dispatch] and enter the number of the Dis-
patcher command to process the Dispatcher com-
mand, [Usertool] to process the user tool, or [BATch
File] to process the batch file specified in [Name].

After action
[Delete Files] deletes files after the Scheduler action,
[Task processing OFF] turns processing off after the
action, and [None] specifies that the Scheduler contin-
ues processing for further actions.

Please note the following Scheduler operation
conditions:

The Scheduler Desktop pauses during key-
strokes, mouse clicks or movements, menu pull
down operations, and dialog displays, but
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resumes polling after an allotted time delay once
these actions end.

To operate the Scheduler with the [DateTime] op-
tion, select the [System Config] option in the Sys-
tem menu and set the system clock on
([Clock]:On) in the Desktop Configuration dialog
box that displays.

To reset the Scheduler functions to defaults, en-
ter the following command at the DOS prompt:

          DEL
\ELIXIR\DESKTOP\SYSTEM\DISPATCH\*.SRV           
<Enter>  

The Scheduler Desktop is single tasking and you
should  operate it on a dedicated workstation. You
can accomplish Full Scheduler operations without
using network interrupts and you can perform this
from a DOS-based system.

The Scheduler Desktop is operational in non-
network environments, and can process files sent
over modems for printing to a remote printer.

Scheduler Desktop examples

This section describes examples of using the Sched-
uler Desktop.

Scheduler example 1

The following example describes setting up a Sched-
uler action to run a batch file at one minute past noon.

The example assumes that you set up the Scheduler
Desktop on a dedicated PC, attached it to a network,
and if applicable, defined the Network Scheduler di-
rectory to which files print to disk.

1. Select the [Scheduler Setup] option from the
Special menu and select the options you want
in the dialog box that displays (the options as
described earlier in this section).
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2. Select the [Scheduler Actions] option from the
Special menu and enter or select the following
to set up a Scheduler action based on a
DateTime test:  

[Task] 1
[Task test] On DateTime
[Filename(s)] *.SYS
[Date] 02 [Month] 12 [Year] 92
[Hour] 12 [Min] 1 [Sec] 0
[Action to take] BATchFile
[Name] JOBXXX
[After action] Task processing OFF

           Figure 5-15.  Testing for a passed 
    date/time example

This example sets up Scheduler action number 2 to
run the file JOBXXX on 12/02/92 at 12:01 PM.

If [Any] is selected for the Date, the Scheduler action
would occur every day at 12:01 PM.

Scheduler example 2

The following example describes setting up a Sched-
uler action that continuously runs a utility at specified
time intervals.

1. Select the [Scheduler Setup] option from the
Special menu and select the options you want
in the dialog box that displays (the options as
described earlier in this section).

2. Select the [Scheduler Actions] option from the
Special menu and enter or select the following
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to set up a Scheduler action based on a Test
TRUE test:

Task] 2
[Task test]Test TRUE
[Action to take] Usertool
[Name] NETCOMX
[After action] None

        Figure 5-16.  Testing for a TRUE 
        condition example

This example sets up Scheduler task number 2 to run
the usertool NETCOMX continuously at intervals
specified in step 5 in the Scheduler setup section.

You can use this Scheduler action to periodically send
messages over the network to inform nodes that the
Scheduler is active and waiting. 

Viewing files

The Viewer icon links applications to file extensions so
that copying a file with a certain extension to the icon
starts the application and loads the file.

For example, you can link all .PCX file to the Windows
PaintBrush program so that copying a .PCX file to the
Viewer icon starts PaintBrush and displays the .PCX
file.
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To link applications to file extensions, use any ASCII
editor to edit the ELX.INI file in the drive:\WINDOWS
directory. 

You can also click the right mouse button on the
Viewer icon to start Windows Notepad with ELX.INI
loaded.  In the file, under the [Viewer_Filemap] section
add lines in the following format:

extension=application

extension
is the file extension

application
 is the executable linked to extension.

For example:

PCX=PBRUSH.EXE

This line links .PCX files to the PaintBrush application.

Viewing Elixir image files

The Viewer icon also display Elixir format images
(.LP3) and screen graphics (.LW8) by copying the files
to the icon.  You can copy the above files from any
folder to the Viewer icon.  

ADDITIONAL DESKTOP FEATURES

ELIXIR DESKTOP FOR AFP USER GUIDE 5-27



    Figure 5-17.  Elixir image (.LP3) display example

The Elixir Image Viewer application displays Elixir im-
ages or the screen versions of Elixir images in an im-
age window, as shown in the above example.

From the File menu select [Attributes] to display infor-
mation about the image, [Print] to print the image and
[Exit] to exit the Viewer.

Clicking on the arrows in the image window header al-
lows you to zoom in to 2X, 4X, 8X, 16X, and 32X
magnifications and to zoom out to -2X, -4X, and -8X
magnifications.  The printed image size also displays
(PRN displays in the window header).

When displaying magnifications greater than 1X, the
left of the window displays the magnified view and the
right of the window shown a portion of the image at 1X
magnification.

Clicking on the button to the right of the arrow toggles
a grid at magnifications of 8X or greater.  

Moving the screen pointer in the window displays the
coordinates of the pointer in dots with respect to the
top left corner of the image
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Setting the default ElixirForm font

ElixirForm uses screen fonts by default when creating
forms.  You can change the default to Elixir-generic
format fonts by editing a parameter in the ELX.INI file.

To set the default ElixirForm font to Elixir-generic
format:

1. Close all open Elixir products.

2. Open the ELX.INI file (typically in
C:\WINDOWS, C:\WIN95, or C:\WINNT) in  
Windows Notepad or Wordpad.

3. In the [AdvancedOptions] section, change the
value of the PreferScreenFonts parameter
from 1 to 0.

where "1" represents screen fonts, and "0" repre-
sents Elixir-generic fonts

4. Restart Elixir for the change to take effect.
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6.  Peripheral devices

This chapter describes how to access and use periph-
eral devices connected to your PC. Devices covered
in this chapter include:

diskette drives (internal or external)
scanners
printers.

Diskette drive

You access diskette drives through the Desktop Disk-
ette icon.

The Diskette icon allows you to: 

specify the drive letter of the diskette drive you
want to access

copy files from the hard disk to a diskette

copy files from a diskette to the hard disk

format  a high or low density diskette in DOS or
DOS-Elixir formats (DOS format with the standard
Elixir directory structure on the diskette)

format a low density diskette with the Xerox
printer format.

The “Additional Desktop features” chapter provides
procedures for copying DOS and Xerox printer format
files to and from diskettes.  
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To assign a drive letter or to format diskettes, open
the Diskette icon to display the System Diskette dialog
box shown in the following figure. This dialog box also
displays when you copy one or more files to a diskette
(by copying file icons to the Diskette icon).

   Figure 6-1. System Diskette dialog box

Diskette Setup
To specify a drive letter, enter the letter for the [Disk-
ette Drive] option. Any actions you subsequently per-
form using the Diskette icon apply to the diskette drive
you specify.

Diskette Access
To format a diskette, select [Perform FORMAT] for
the [Diskette Access] option, then select the format
type for the [Diskette Type] option.

When you format a diskette the following options
apply:

DOS User- Defined
Formats the diskette using the DOS FORMAT
command.

DOS Elixir
Formats the diskette using the DOS FORMAT com-
mand and creates an \ELIXIR subdirectory on the
diskette.  
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When you copy files to and from a diskette, the follow-
ing options also apply:

Directory on Diskette to open
The diskette directory you want to access. The default
is A:\*.*

Diskette Access
[Perform FORMAT] - formats a diskette (see above);
[For READing] - displays a window showing a list of
files and directories on the diskette. [For WRITing] -
applicable only when you copy files from the hard
disk; copies the hard disk files to the diskette. 

Scanner device

You can access any scanning device connected to
your PC through the Desktop Scanners icon when you
have the appropriate scanner software installed that
can create a .TIF or .PCX file.

Before using your scanner, configure the Desktop as
described in the following section.

You can run only one scanner from the Desktop.

Configuration

To use your scanner from the Desktop, first select the
scanner specifications as follows:

Select the Scanners icon and press <F2> or select
[Properties] from the File menu. The User Application
Setup dialog box displays and contains the following
options:
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        Figure 6-2. User Application Setup dialog box

Command to Execute
The command that executes the application associ-
ated with the icon. For example, to create a WordPer-
fect icon, you would specify WP.

If you want to link the application to files in the same
directory as the application (see the “Linking files to an
already defined User Tool” section), you can also type
in the DOS command with an embedded %1 parame-
ter. The embedded %1 parameter specifies the loca-
tion in the command at which you want the file name
to appear. See also the [Prompt for parameters]
option.

Nickname for application
A nickname (up to 8 characters) for the application
you want to run. For example, you may specify VENT
as a nickname for Ventura Publisher. After creating an
icon, the User Tools window displays the icon with the
nickname under it.  
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Optional Long Name
A descriptive name for the application (up to 29 char-
acters). For example, for Ventura Publisher, you can
enter Ventura Publisher. The long name is informa-
tional only; it identifies the application in the dialog
box.

Working Directory
The DOS path for the executable. Use this field if the
application you are running is not present in the
drive:\ELIXIR directory and if you have not specified a
DOS PATH= statement for the directory in which the
application executable resides.

Command Options
Select command options:

[DOS Application]- for running a DOS applications

[Send Only Filename] - uses only the file's stem name
for command execution

[Prompt for parameters] - program  prompts for an ar-
gument to appends to the command in the  [Com-
mand to execute] option

[Run Minimized]-  executes the command in a mini-
mized window

Command Attributes
Select command attributes:

[Command is .BAT file] - for DOS batch file com-
mands; redisplays the Desktop when you exit the ap-
plication.  If the application is a batch file that calls
another batch file, the Desktop does not redisplay
when you exit the application.  See the “Starting batch
files” section for more information.

Deselect to return to the directory specified in the
batch file.

[Pause after execution]- pauses after exiting the
application

Display Options
Select a command display option:

[Window] - displays command execution in a window
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[Full Screen] - displays command execution in a full
screen environment

Browse
Displays the contents of a DOS directory from which
you can select a file.

Using scanners

To use your scanner, double-click on the Scanners
icon. After confirming that the information in the User
Application Setup dialog box is correct, click on [OK]
to start the scanner application. 

See your scanner user manual for information on con-
figuring your system for your scanner.

Proof printing

This section describes information required for print-
ing form files on local proof printers attached to your
PC.

The local printer option uses the installed Windows
print drivers. To print a file, copy it to the Printers icon
on the Desktop, select [Print] from the File menu, or
press <Ctrl> + <P>.

The Elixir Desktop supports local printing as follows:

You can print Elixir forms on a HP PCL printer
connected to your PC and configured in
Windows.

When printing non-Elixir, non-ASCII files, you can
either specify a binary copy operation to the
printer port or specify a user-defined print driver. 

You can print ASCII text files or formatted data
streams if the proof printer connected to your PC
can correctly interpret the files or data streams. 

You can print PostScript using either the Elixir
PostScript converter or a Windows PostScript
driver.
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You can print highlight shading as different gray
shades on Elixir forms that contain highlight color.

Printing Elixir forms

You can add, change, or delete printer drivers (for
printing Elixir forms) from the Windows Control Panel.

You can also change the current printer's setup by
right-clicking on the Printers icon.  The Print dialog
box displays and contains the following options:

Figure 6-3. Print dialog box

Printer
The Print dialog box shows the default printer speci-
fied is a HP LaserJet IIP connected to the LPT1: port.

Orientation
The orientation of the printed page: [Landscape] or
[Portrait].

Page Shift
The number of dots you want the printed page shifted
to the right ([Xshift]) or down ([Yshift]). Negative val-
ues are permissible.

Copies
The number of copies of the printed page.
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Print to File
When selected, creates an HP PCL print file instead
of printing.

Print Fonts as Graphics
Rasterizes fonts as graphics. This requires less printer
memory, speeding up printing time.

Message
Displays the Message Options dialog box.

Setup
Displays a Windows-provided, print driver-specific
Document Properties dialog box that allows you to se-
lect paper and graphic options.

Printing Elixir forms with highlight color

Elixir forms that contain highlight color shades print as
solid black with the Elixir HP Driver.  Printing these
forms via the Converter icon produces print output
with the highlight shading displaying as gray shades.

To print Elixir forms with highlight color:

1. Select [Converter props] from the System
menu.

The Converter Properties dialog box displays.

Figure 6-4.  Converter Properties dialog box

2. Click on the [Converter props] button.
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The Converter Properties Dialog dialog box dis-
plays.

                  Figure 6-5.  Converter Properties Dialog dialog box

3. Select [Use Elixir HP PCL and PostScript
converters], then click on [OK] until all dialog
boxes close.

4. Open the Elixir forms folder, select the forms
to print, then press <Ctrl> + <V>.

The Forms Converter Options dialog box
displays.

Figure 6-6. Form Converter Options dialog box

5. Select [HP PCL], then click on [OK].

The Print Driver Dialog dialog box displays.
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Figure 6-7.  Print Driver Dialog dialog box

6. Select print options, then click on [OK].

Printing non-Elixir forms

When printing non-Elixir forms from the Output or In-
put Forms folders, the Printer Setup dialog box
displays.

Figure 6-8. Printer Setup dialog box

Copy to printer on Port
Perform a binary copy operation to the selected [Port].
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User-Defined Print Driver
Specify a user-defined print driver. Click on [Setup] to
select the driver.

Port
Specify the port as [LPT1], [LPT2] or [LPT3].

Copies to Print
The number of copies you want printed.

Setup
Not applicable.

Using the Elixir HP print driver

The Elixir HP print driver produces files that require
substantially less disk space and take less time to
print. To use the Elixir HP print driver:

1. Select and drag the file to the Printers icon.

The Print dialog box displays.

Figure 6-9.  Print dialog box

2. Select [Elixir HP Driver] and click on [Setup].

PERIPHERAL DEVICES

ELIXIR DESKTOP FOR AFP USER GUIDE 6-11



The Elixir HP Driver dialog box displays and con-
tains the following options:

Figure 6-10.  Elixir HP Driver dialog box

Printer
Select the type of HP LaserJet printer : II, III, or 4.

Printer Port
Select the printer's port: [LPT1], [LPT2], or [LPT3].

Output Mode
Select an output mode [Use PCL commands] or [Use
rasterization].  The [Use rasterization] option allows
you to print some embedded objects (such as circles
and paths) that HP PCL may ignore or print other ob-
jects in their place.

Font Substitution Tables
Select a font substitution table option:

[No] - uses printer-resident fonts

[Selected] - uses fonts from the table selected/ en-
tered in the [Selected Table] option

Create As Macro
Select and enter a value in [Macro ID number] to store
your form on the printer for future use.

Select Font Table
Displays the Select Font Table dialog box from which
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you can select the font table that displays in the [se-
lect Table] option.

3. Select/enter print driver options, then click on
[OK] until all dialog boxes close.

Printing PostScript

You can print PostScript using either the Elixir Con-
verter or a Windows PostScript driver.

To print PostScript using the Elixir converter:

1. Select [Converter Props] from the System
menu.

The Converter Properties dialog box displays.

                  Figure 6-11. Converter Properties dialog box

2. Click on the [Converter Properties] button.

The Converter Properties Dialog dialog box
displays.
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Figure 6-12. Converter Properties Dialog 
dialog box

3. Select [Use Elixir HP PCL and PostScript
converters], then click on [OK] until all dialog
boxes close.

4. Copy the file to print to the Printers icon.

The Print dialog box displays.

  Figure 6-13. Print dialog box

5. Select print options, then click on [OK].

To print PostScript using a Windows driver:
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6. Select [Converter Props] from the System
menu.

The Converter Properties dialog box displays.

Figure 6-14.  Converter Properties dialog box.

7. Click on the [Converter Properties] button.

The Converter Properties Dialog dialog box dis-
plays.

                 Figure 6-15.  Converter Properties Dialog 
dialog box

8. Deselect [Use Elixir HP PCL and PostScript
converters], then click on [OK] until all dialog
boxes close.

9. Copy the file to print to the Printers icon.

The Print dialog box displays.
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Figure 6-16.  Print dialog box

10. Select print options, then click on [OK].
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7.  File conversions

The primary function of the Elixir Desktop is to convert
form, font, image and document (multi-page form)
files to and from different formats.

Note that conversion of Elixir Jobs (AppBuilder re-
sources) is not currently supported by the Desktop.

General procedures

The simplest way to convert files is to use the desktop
Converter icon. To convert a file or files:

1. Select the file(s) to convert from the
appropriate Elixir or Input folder.

2. Copy the file(s) to the Converter icon.

3. Specify the output file format(s) in one or
more dialog boxes that display.

Based on the type of file (as determined by file loca-
tion and extension), one or more output files with the
correct file extensions write to the appropriate Output
folders.

Note that converting a form, font or page segment file
whose name is one of the restricted OGL keywords
can result in printing problems. See the IBM Overlay
Generation Language/370 User's Guide and Refer-
ence manual for a list of restricted OGL keywords.
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The Converter icon also allows you to run a number of
Elixir utilities, as described in this chapter.

Elixir folders

This section describes how to convert files to different
formats. You may want to review the information in
the “Elixir folders” chapter before reading this section.

Each Font, Form, Image and Document folder dis-
played on the desktop contains subordinate Input,
Elixir and Output folders.

Figure 7-1.  Subordinate folders example

Forms folder

The Input Forms folder comprises folders containing
non-Elixir, single-page form files you can convert to
other formats. To convert a non-Elixir single-page file
to another format, you must copy it to the appropriate
folder in the Input Forms folder.

The Elixir Forms folder contains Elixir-format form
(.ELX) files and/or other subordinate folders contain-
ing Elixir forms. When you create Elixir Forms or con-
vert form files to Elixir-format, files write to this folder.

When you convert form files from the Input Forms
folder to any non-Elixir format, or when you convert
Elixir forms from the Elixir Forms folder, the resulting
output form files write to folders in the Output Forms
folder.
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Fonts folder

The Input Fonts folder comprises folders containing
non-Elixir font files you can convert to other formats.
To convert a non-Elixir font, you must copy it to the
appropriate folder in the Input Fonts folder.

The Elixir Fonts folder contains Elixir-format font
(.HDR) files. When you create Elixir Fonts or convert
font files to Elixir-format, files write to this folder.

When you convert font files from the Input Fonts
folder to any non-Elixir format, or when you convert
Elixir fonts from the Elixir Fonts folder, the resulting
output font files write to folders in the Output Fonts
folder.

Images folder

The Input Images folder comprises folders containing
non-Elixir image files you can convert to other for-
mats. To convert a non-Elixir image, you must copy it
to the appropriate folder in the Input Images folder.

The Elixir Images folder contains Elixir-format image
(.LP3) files.  When you create Elixir images or convert
image files to Elixir-format, files write to this folder.

When you convert image files from the Input Images
folder to any non-Elixir format, or when you convert
Elixir images from the Elixir Images folder, the result-
ing output files write to folders in the Output Images
folder.
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Documents folder

The Input Documents folder comprises folders con-
taining non-Elixir multi-page documents you can con-
vert to other formats. To convert a non-Elixir
document, you must copy it to the appropriate folder in
the Input Documents folder.

The Elixir Documents folder contains .DAT files, AS-
CII files that reference the Elixir-format form (.ELX)
files comprising a multi-page document. When you
convert documents to Elixir-format, .DAT files write to
this folder and .ELX files write to the Elixir Forms
folder.

When you convert documents from the Input Docu-
ments folder to any non-Elixir format, or when you
convert .DAT files from the Elixir Documents folder,
the resulting output files write to folders in the Output
Documents folder.

Initial converter setup

Before you start file conversions, you may find it help-
ful to select several setup parameters that are com-
mon to most conversions and which display in dialog
boxes when you convert files.  Select these options in
the Converters Properties dialog box.

To display the Converters Properties dialog box, se-
lect the Converter icon then perform one of the
following:

select [Properties] from the File menu

press <F2>

right-click on the icon

select [Converter Props] from the System menu

FILE CONVERSIONS
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        Figure 7-2. Converter Properties dialog box

Converter Property Sheets
Form Converters
AFP
Displays the AFP Page Converter Options dialog box
for setting AFP page conversion parameters.

Converter Property Sheets
Form Converters
PostScript
Displays the PostScript Converter Options dialog box
for setting PostScript conversion parameters.

Converter Property Sheets
Font Converters
AFP
Displays the AFP Font Converter Options dialog box
for setting AFP font conversion parameters.

Converter Property Sheets
Font Converters
Outline
Displays the Outline-to-raster font generator dialog
box for setting outline font conversion parameters.

Converter Property Sheets
Image Converters
AFP
Displays the AFP Image Converter Options dialog box
for setting AFP image conversion parameters.
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Converter Properties
Displays the Converter Properties Dialog dialog box
which contains the following options:

        Figure 7-3. Converter Properties Dialog 
       dialog box

Working Directory
Directory where temporary read/writes occurs
during transformations. Default is the root (\). We
recommend specifying a RAM disk for faster
transformations.

Confirm file overwrites during transformation
Requests confirmation before overwriting existing
output files. Deselect this option automatically
overwrite existing files.

This option is applicable only when transforming
form and .LGO files to Elixir format. 

Show properties before transformation
Specifies default dialog box setup options for
each file transformation type.

Pause after transformation
Pauses after each transformation.

Stop process after: 
Select when to stop processing:

[Error] -  stops a conversion when an error occurs

[All files processed] -  stops conversion after
processing all files
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Message Reporting
Displays the Message Options dialog box which con-
tains the following options:

     Figure 7-4.  Message Options Dialog dialog box

Message Reporting
Show messages after process
Displays any error messages on-screen after
processing.

Message Reporting
Write Messages to LOG file
Writes any error messages to the file (.LOG) en-
tered in the text box.

New Messages
Overwrite LOG file
Overwrites the previously-created .LOG file after
processing.

New Messages
Append to LOG file
New error messages add tot he end of the
previously-created .LOG file.

A maximum of 64 KB of text displays in the mes-
sage log window.  If message text exceeds this,
the message window displays empty and mes-
sages write to drive:\ELIXIR\MESSOUT.MSG
which is viewable in any text editor.

File conversion procedures

This section briefly describes file conversion steps.
Later sections provide more detailed descriptions.
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To convert a form, font, image or document file to a
different format:

1. To convert a non-Elixir file, copy the file to the
Input folder appropriate for the file format.

(If to convert an Elixir-format file, the file may
already reside in an Elixir folder.)

2. Open the appropriate Input or Elixir folder and
select the file(s) to convert.

3. Copy the selected file(s) to the Converter
icon.

The Converter Properties dialog box displays.

           Figure 7-5.  Converter Properties dialog box

4. Select the output file format(s), then click on
[OK].

The file(s) you specify convert and the generated out-
put file(s) write to the appropriate Output folder. If you
specify more than one output format in step 4, each
input file converts to the formats you specify and write
to the appropriate Output folders.

If any errors occur during conversion, a message dis-
plays in a separate window.

If errors do not occur, a dialog box displays showing a
status for the conversion. Following conversion, click
on [OK] in the dialog box.    
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Converting forms

To convert forms, copy one or more Input or Elixir
form files of the same format to the Converter icon.
The Form Converter Options dialog box displays and
contains the following options:

  Figure 7-6. Form Converter Options dialog box

Input Format 
The selected format conversion type.

Output
The output form conversion format(s).

Converting forms to and from AFP format

When converting an AFP form file to Elixir format or
when converting an Elixir form file to AFP format, the
AFP Page Converter Options dialog box displays. 

Options in this dialog box may or may not display, de-
pending on the selected form file type.
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      Figure 7-7. AFP Page Converter Options dialog box

The following notes apply to conversions for the for-
mats specified:

When converting Elixir form files to OGL, OVE or
LOG formats, output file names alter as follows:
OGL output file names truncate after six charac-
ters; OVE and LOG output file names truncate af-
ter six characters and get a 01 prefix.

When converting to OGL, the following messages
display if you do not specify a default code page
in the Desktop Basic Setup dialog box:

Error: Cannot load ELIXIR Code Page xxxxxxx
Error: Unable to build default ASCII to EBCDIC table

To access the Desktop Basic Setup dialog box,
pull down the System menu and click on [System
Config].

When converting an OVE form to Elixir format,
dashed and dotted lines (box borders and individ-
ual lines) convert to genned images and write to
drive:\ELIXIR\PICS\GENIMAGE directory. Also,
box borders thicker than 32 pels convert as lines,
not boxes. This is due to the IBM overlay format,
where outlines larger than 32 pels convert to mul-
tiple lines instead of single thick lines.

FILE CONVERSIONS

7-10 ELIXIR TECHNOLOGIES CORPORATION



Rasterized images such as paths, rounded corner
boxes, and embedded segments are handled as
bitmapped images and stored in drive:\
ELIXR\PICS\GENIMAGE as .LP3 files. The .LP3
file names contain the form name without the 01
prefix, and a sequence number in positions seven
and eight. For example, a file named 01TESTAA
becomes TESTAA01. When you load the form in
ElixirForm, the image is treated as a PIC and you
can move or delete it as such. When you proof
print the form, the print utility looks in the GEN-
IMAGE directory and downloads the genned im-
age to the printer.

If you convert the form back to OVE format, the
genned image is automatically re-embedded in
the form. If you delete the form, the genned im-
age file also deletes.

If you convert the form to OGL format, the gen-
ned images convert to patterns in the OGL file
(see your OGL/370 manual for more information).
If you reconvert this OGL file to Elixir format, the
pattern translates back into a genned image. The
[Embed Page Segments] option in the AFP Page
Converter Options dialog box has no effect on
this type of image.

AFP Page Converter Options dialog box

Options in this dialog box may or may not display, de-
pending on your selections in the Form Converter Op-
tions dialog box.

Elixir Pages in
Source directory for Elixir forms (default is drive:\
ELIXIR\FORMS\ELIXIR\).

Text Justification
Applicable for conversions to OVE and OGL. The de-
fault [Inter-Word] justifies text by adding or deleting
spaces between words. This option reduces the com-
plexity of your form so the form prints faster. [Inter-
Character] justifies text by adding or deleting spaces
between characters. This option makes the form more
readable but extends printing time.
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Rotate Pages
Rotates the screen version of a form clockwise by the
number of degrees selected. 

If you converted Elixir forms to another format and
now want to convert them back to Elixir format, you
must adjust the page rotation as follows:

   Output rotation      Input rotation

[0] [0]
[90] [270]
[180] [180]
[270] [90]

Output rotation is the rotation option selected when
the original Elixir form was converted to another for-
mat. Input rotation is the rotation option you should se-
lect when you convert the form back to Elixir format so
the form displays correctly.

Resolution of AFP Printer
Select your printer's resolution: [240 Pels] or [300 R-
Units]. When converting forms to Elixir format, the
program marks the file with the value you select.
When reconverting from Elixir to another format, you
must specify the printer resolution for resizing as
follows:

If the Elixir file contains the resolution value to
which you want to convert the file, it does not
resize.

If the Elixir file contains a resolution value differ-
ent from the value to which you want to convert, it
resizes accordingly.

If the Elixir file contains no mark, it resizes if the
[Resolution of AFP Printer] value is other than
[300 R-Units].

When converting an Elixir form originally converted
from AFP format, specify [240 Pels] to retain the size.

Format of output files
Select the output format for AFP file(s):
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[VBM] - creates AFP-format files for uploading to MVS
hosts using IBM 3270, IRMA FT/3270 or compatible
file transfer packages

[AS400] - creates AFP-format files for uploading to
AS400 hosts

[IRMA] - creates AFP-format files for uploading to
MVS hosts using the IRMA FTTSO and compatible
file transfer packages

[OS/2] - creates AFP-format files for use with PSF/2

[DOS/VSE] - creates AFP-format files for uploading to
DOS/VSE hosts

Font Type
When converting to Elixir format:

[Universal X0] - creates call-outs to X0 universal
(bounded box) fonts in the Elixir form file

[Separate X1-X4] - creates callouts that emulate un-
bounded box font types in the Elixir form file, based on
the following:

text direction = Across, X1 is called out

text direction = Down, X2 is called out

text direction = Back, X3 is called out

text direction = Up, X4 is called out

When converting AFP and OVE format forms to Elixir
format, if the form contains call-outs for X0 fonts, the
[Separate X1-X4] option is not effective. Font call-outs
in the Elixir form remain X0 call-outs regardless of the
font type option selected.

When outputting fonts to AFP or OVE and back to
Elixir format, if fonts in your form are all one direction
and/or you do not want the two-digit AFP prefix ad-
ded, select [No AFP Prefix]. 

Deselect [No AFP Prefix] if you have mixed-directional
fonts in your form and plan on proof-printing.  See the
"Font requirements for an HP-compatible printer" sec-
tion for an example.
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Units
Units for horizontal or vertical offset in pels, inches or
millimeters.

Remove Image Whitespace
Not applicable to form conversions.

Embed Page Segments
Includes converted Page Segments within the data
stream when converting to OVE.  Deselecting this op-
tion includes only a reference to the Page Segment.
Note that the Page Segment must exist in your host
Page Segment library.

Floating Offsets
[Horizontal] is applicable for converting to AFP format.
Shifts output right for portrait orientation, and shifts
output down for a landscape orientation by the num-
ber of dots specified. The offset value displays in the
unit of measurement selected in the Units option. The
default unit is pels, so offset values converted to
inches or millimeters may be slightly off due to round-
ing errors. You can edit the value displayed if
necessary.

[Vertical] is applicable for converting to AFP format.
Shifts output down for portrait orientation, and shifts
output right for a landscape orientation by the number
of dots specified. The offset value displays in the unit
of measurement selected in the Units option. The de-
fault unit is pels, so offset values converted to inches
or millimeters may be slightly off due to rounding er-
rors. You can edit the value displayed if necessary.

Fonts
Displays the MCF Fonts dialog box which contains the
following options:
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      Figure 7-8.  MCF Fonts dialog box

MCF(1)
Uses Map Coded Font Format 1 (MCF(1)) struc-
tured fields in the resulting output file.  MCF(1) is
IBM's original AFP font specification and AFP ar-
chitecture supports it as a coexistence object.
MCF(1) has been superseded by MCF(2) but is
still valid.

MCF(2)
Uses Map Coded Font Format 2 structured fields
in the resulting output file.  MCK(2) is recom-
mended for MO:DCA compliance.

Default
Converter looks in the file entered in the Charac-
ter Mapping File Name option for individual font
handling instructions.  If an entry is found for a
font used in the original Elixir form or document,
the RTYPE keyword format is used; else the font
using the coded font name in a MCF(1) structures
field record is used (default).

Coded Font Name
Converter writes all font references using the
coded font name.

Charset + Code Page Name
Converter writes all font references using a char-
acter set/code page pair.  The original font's char-
acter set and code page are referenced for fonts
originating in the AFP environment.
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The six character assigned Elixir name generates
the character set name and the code page comes
from the Default Code Page option in the Desktop
Basic Setup dialog box for non-AFP fonts.

Outline
Converter writes all font references using PSF
outline font parameters (only valid for Adobe Type
1 or True Type fonts).  You must set-up font fam-
ily name references in your AFP font mapping file
before selecting this option.  If no font matches
are found, the character set and code page
names are used.

To set up font family name references, open your
font mapping file (default is
drive:\ELIXIR\FONTS\MAPS\DEFAULT.FAM),
then follow the instructions in the "Font Family
Descriptors" section.

FGID
Converter writes all font references using the
previously-specified Global Resource Identifier
(GRID).  The GRID includes the Font Typeface
Global Identifier (FGID), Graphic Character Set
Global Identifier (GCSGID) and the Code Page
Global Identifier (CPGID) mappings.

Character Mapping File Name
Path and name of your AFP font mapping file
which provides the Converter with output overlay
and document font mapping information.  Default
is drive:\ELIXIR\FONTS\MAPS\DEFAULT.FAM.
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AFP
Displays the AFP Settings dialog box which con-
tains the following options:

           Figure 7-9.  AFP Settings dialog box

This dialog box allows you to select your target
environment and specify record format, block and
record lengths, DocuTag for AFP converter op-
tions and form page bottom marker settings.

OGL
Displays the Page Source Converter Options dialog
box which contains the following options:

Figure 7-10. Page Source Converter Options dialog box
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Include Author Banner
Includes the form's Page Author information in
the file conversion.  The author banner includes
the author's name at the top of the form file. See
the Page Databasing Information defaults sub-
menu in your ElixirForm for AFP User's Guide for
more information. 

Keep Texts Boxed (OGL only)
Writes boxed text on a form into OGL as a
DRAWBOX WITHTEXT command during conver-
sion.  Boxed text with no visible border is written
as DRAWBOX WITHTEXT xxPELS xxPELS 0,
and justified text is always written as JUSTIFY
LASTNO (last line remains LEFT justified).  All
justification in this mode is done INTERWORD
(only option the OGL compiler supports).  The
BALANCE option is not supported. 

Code Page Translation (OGL only)
Writes OGL out to EBCDIC rather than ASCII
format.

Include Description Text
Converter generates a specialized comment for
inclusion after the Author Banner in OGL or LOG
source files.  The format for this comment is:

'1 [InternalName].[LocalID] [MadeFor] [Short Page
Description]

where "1" is used as a search string for host pro-
grams which produce listings of overlay source
libraries, and [InternalName] is the six-character
name of the OGL or LOG source.

See the Page Databasing dialog box in your Elix-
irForm for AFP User's Guide for information on
the other options included in this comment. Note
that the Date/Time Stamp and Long Page Com-
ments for a form are also included in the
conversion. 

Generate BPSD Tags 
Automatically generates and displays BPSD tags
in the OGL formats.
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Font Assignment
For OGL, select [Auto] to map fonts from their
coded font names to six-character internal names
without the 'Xn' prefix. For LOG, the full eight-
character 'X' coded font name is retained. 

Select [Mapped] to load and use the DEFAULT.
FAM table in drive:\ELIXIR\FONTS\MAPS for
mapping font names. 

For LOG, use this table to assign local four-
character identifier names for fonts residing on
the printer's disk. 

For OGL, use this table to assign individual
DDNAMES to fonts.  

For OVE or AFPDS, use this table to assign Font
Global Identifiers (FGIDs) to font names.  See the
"Using FGIDs in a form" section for an example of
mapping FGIDs to fonts.

You can also change your target environment
from MVS to VM by editing the drive:\ELIXIR\
DESK TOP\ SYSTEM\AFP.INI file included with
the Desktop. See the "Changing your target envi-
ronment from MVS to VM" section for more
information.

In the [Map table] field, enter the file name of the
mapping table in drive:\FONTS\MAPS to use
when you select [Mapped] in the [Font Assign-
ment] option. DEFAULT.FAM is the default.

Pseg Assignment
Select [Auto] to map page segment image names
from their external file names to six-character in-
ternal names without the 'S1' prefix. For LOG, the
full eight-character S1 name is retained.  Select
[Mapped] to load and use the DEFAULT.SAM ta-
ble in drive:\ ELIXIR\PICS\MAPS to map page
segment names. Once compiled, the page seg-
ments store inside the overlay. 

For LOG, you can use DEFAULT.SAM to assign
local four-character identifier names for fonts re-
siding on the printer's disk.  For OGL, you can
use this table to assign DDNAMES to page
segments.
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You can change your target environment from
MVS to VM by editing the
drive:\ELIXIR\DESKTOP\ SYSTEM\AFP.INI file
included with the Desktop.  See the "Changing
your target environment from MVS to VM" section
for more information.  

In the [Map table] field, enter the file name of the
mapping table in drive:\ELIXIR\PICS\MAPS to
use when you select [Mapped] in the [Pseg As-
signment] option.  DEFAULT.SAM is the default.

CONTROL
Builds the CONTROL statement used in OGL and
LOG source files:

[noSTORE] -  specifies that the form is not stored
in a library

[STORE] - stores the form in a library

[REPLACE] - stores the form in a library and re-
places any existing forms with the same name

[ALL] - displays every message the system gener-
ated during processing

[WARN] - displays only the warning messages
generated during processing

[ERROR] - displays only the error messages gen-
erated as a result of OGL/370 processing

[noSUMMARY] - specifies that a summary does
not display as part of the source listing

[SUMMARY] - displays a statistical summary as
part of the source listing

Formwidth 
Enter the FORMWIDTH command arguments di-
rectly.  For example, 3600 PELS.

Formlength 
Enter the FORMLENGTH command arguments
directly.  For example, 3200 PELS.
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Copies 
This option is valid in certain circumstances. See
your Comparex documentation for information.

Margin
Enter the offset from the edge of the paper to the
beginning of the printing area. If you specify a
margin value in the Form Control Block, use the
same value. The default margin is 0. 

Sequence Numbers
Appends 8-digit sequence numbers to output in
columns 73-80. 

Delete
Deletes the overlay from the printer's disk after
use.  Deselect to save the overlay on the printer's
disk.

Generating source .OGL and .LOG files

OGL output does not include Formwidth, Form-
length, Delete, Margin or Copies option data, and
has DDNAME parameters instead of Font and Pseg
mapping information.  

Information from the Page Databasing dialog box (be-
low) and the Page Source Converter Options dialog
box was used as input to generate the sample
SOURCE.LOG file that follows.

Figure 7-11. Page Databasing dialog box
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_'**************************************'

_'**************P E T E R ***************'

_'**************P E T E R ***************'

_'**************P E T E R ***************' AUTHOR BANNER)

_'**************P E T E R ***************'

_'**************P E T E R ***************' _'**************************************'

_'1 FEDBANK.CEF CE SERVICES Federal Bank Line of Credit Application'

(DESCRIPTION TEXT)

_'Created 8/23/93 9:15:34 AM' (DATE/TIME STAMP)

CONTROL NOSTORE WARN SUMMARY;  (CONTROL STATEMENT)

ORIENT 0 FORMWIDTH 3600 PELS FORMLENGTH 3200 PELS MARGIN 4;

(ORIENTATION / FORM WIDTH / FORM LENGTH / MARGIN)

SEGMENT PSEG00 S1FBLOGO (AUTO PSEG MAPPING)

FONT FONT00 X1HE07NP ;

FONT FONT01 X1HE08BP ;

FONT FONT02 X1HE08NP ; (AUTO FONT MAPPING)

FONT FONT03 X1HE24BP ;

FONT FONT04 X1HE14BP ;

DELETE CEFRM2; (DELETE Y/N using Local ID name)

OVERLAY CEFRM2 SIZE 2040 PELS 2640 PELS OFFSET 24 PELS 8 PELS;

(OVERLAY NAME, SIZE, and OFFSETS / COPIES [1] NOT SHOWN)

_'This form is designed for the 1993 FedBank Line of Credit'

_'Application approved in 1992 by measure 23A in the bylaws.'

_'Updates to this form must be approved by the finance'

_'committee.' (LONG PAGE COMMENTS)

_'LINES SECTION: 21 lines--------------------'  (LINES/BOXES/TEXT/IMAGES SECTIONS)

POSITION ABSOLUTE 0528 PELS ABSOLUTE 0398 PELS;

DRAWRULE ACROSS 0960 PELS MEDIUM SOLID;

_'BOXES SECTION: 22 boxes--------------------'

POSITION ABSOLUTE 0095 PELS ABSOLUTE 0079 PELS;

DRAWBOX 1848 PELS 0480 PELS LIGHT SOLID;

POSITION ABSOLUTE 0094 PELS ABSOLUTE 0598 PELS;

DRAWBOX 1848 PELS 0080 PELS MEDIUM SOLID SHADE MEDIUM;

_'TEXT SECTION: 50 texts--------------------'

POSITION ABSOLUTE 0516 PELS ABSOLUTE 0500 PELS;

SETTEXT 0 MODERN

   LINE FONT04 'Preferred Customer Line of Credit Application';

_'PSEGS SECTION: 1 psegs--------------------'

POSITION ABSOLUTE 0720 PELS ABSOLUTE 0160 PELS;

PLACE SEGID PSEG00;



Information in the SOURCE.LOG file associated with
options in the dialog boxes shows as the bold text in
parentheses.

Changing the target environment from MVS to VM

When you generate OGL source code, the FONT and
SEGMENT keywords write with either a DDNAME
(MVS) or a FILETYPE (VM) parameter.

The JCL or VM EXEC use these statements to identify
the system libraries where these resources exist. As a
default, Elixir writes out OGL with MVS DDNAME
parameters. 

On a VM site, you can change the default by editing
the Target_environment=MVS statement in the
drive:\ELIXIR\DESKTOP\SYSTEM\AFP.INI file to 

Target_environment=VM

When you change MVS to VM, the Converter changes
the parameter to FILETYPE. 

There are two other files in which you can modify the
default DDNAME or FILETYPE statements. The name
and structure of each is as follows:

drive:\ELIXIR\FONTS\MAPS\DEFAULT.FAM file

%%Elixir_Font_Name_Assignment_Table: AFP 2.10
August 1993
MVS_default_ddname=FONTDD;
VM_default_filetype=FONT38PP;
%Usage: font_id=X0aaaaaa[, dd=aaaaa][, ft=aaaaa][,
id=hxhx];
%Example: font_id=X0MYFONT, ft=FONT3820,
id=2B4F, dd=FONTLIB;

drive:\ELIXIR\PICS\MAPS\DEFAULT.SAM file

%%Elixir_Pseg_Name_Assignment_Table: AFP 2.10
August 1993
MVS_default_ddname=SEGDD;
VM_default_filetype=PSEG38PP;
%Usage: Pseg_id=S1aaaaaa, dd=aaaaa;
%Example: Pseg_id=S1MYSEG, dd=SEGLIB;  
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Converting Elixir forms to HP PCL

You can convert Elixir forms to HP PCL using Win-
dows printer drivers (default) or by selecting the Elixir
HP print driver.

Using the Elixir HP print driver produces optimized
output files that are significantly smaller than those
produced by Windows drivers, yet produce identical
printer output. For information on selecting  the Elixir
HP print driver as the default, see the "Peripheral de-
vices" chapter.  

Leave the  Elixir HP print driver deselected to use the
Windows HP PCL print driver.

Converting using the Elixir HP print driver

To select the Elixir HP print driver as default:

1. Right-click on the Converter icon.

The Converter Properties dialog box displays.

Figure 7-12.  Converter Properties dialog box

2. Click on the [Converter Properties] button.
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The Converter Properties Dialog dialog box
displays.

     Figure 7-13.  Converter Properties Dialog 
     dialog box

3. Select [Use Elixir HP PCL and PostScript
converters], then click on [OK].

4. Copy the Elixir form(s) to the Converter icon.

The Form Converter Options dialog box displays.

               Figure 7-14.  Form Converter Options 
dialog box

5. Select [HP PCL], then click on [OK]. 
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The Form Print Properties (FORMPRN) dialog
box displays.

       Figure 7-15.  Form Print Properties dialog box

6. Select/enter print options, then click on [OK].

The Form Print Properties dialog box contains the fol-
lowing options:

File Name
The name of the selected file.

Output
The output destination: [Printer] or [Disk].

Printer Port
Your printer's port: [LPT1], [LPT2] or [LPT3].

Tray
The desired printer tray for paper selection.

Copies
The desired number of copies.
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Spacing
Select [InterWord] to justify text by adding or de-
leting spaces between words.  This option re-
duces the complexity of your forms so they print
faster. Select [InterChar] to justify text by adding
or deleting space between characters.  This op-
tion may make the form more readable, but
causes it to print slower.

Printer Options
Select [Print] to send your form to the printer. Se-
lect [Store] to store your file on the printer hard
disk for future use. Select [StorePrint] to print your
form and store it on the printer. Select [Constant]
to store your form (one page only) in the printer's
memory until the printer is turned off or reset.

Macro
The macro number you assigned to your form.
This also stores your form in the printer's memory
until the printer is either turned off or reset.

Format
Select [ASCII] to produce ASCII output for writing
to disk. Select [EBCDIC] to produce EBCDIC out-
put for Xerox printers connected to your PC via
coaxial cable and a protocol converter. Select
[SmartBox] if your PC is connected to the printer
through a SmartBox or Agile protocol converter.

Printer Font Loading
Select when to load the fonts onto the printer ([Al-
ways], [Once] or [Never]). Select [Always] to
download fonts each time you print. Select [Once]
to download fonts to the printer only once, as they
are encountered (fonts stay resident until printer
is reset). Select [Never] to use only those fonts
resident on the printer (no fonts are downloaded).

Page Shift
The number of dots you want the printed page
shifted to the right ([Xshift]) or down ([Yshift]).
Negative values are permissible.

The converted files write to the Output HP PCL
forms folder (drive:\ELIXIR\PRINTS\HPPRINT).
Note that converted HP PCL files have .PRN
extensions.
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Converting forms to PostScript format

You can convert Elixir forms to PostScript using Win-
dows printer drivers (default) or by selecting Elixir's
PostScript driver.

Elixir's PostScript driver produces optimized output
files significantly smaller than those produced by Win-
dows drivers with identical printer output.  Leave
Elixir's PostScript driver deselected to use the Win-
dows printer driver.

Converting using Elixir's PostScript driver

To convert files with Elixir's PostScript driver:

1. Right-click on the Converters icon.

The Converter Properties dialog box displays.

Figure 7-16.  Converter Properties dialog box

2. Click on the [Converter Properties] button.

The Converter Properties Dialog box displays.

         Figure 7-17.  Converter Properties Dialog box
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3. Select [Use Elixir HP PCL and PostScript
converters], then click on [OK] until all dialog
boxes close.

4. Copy the Elixir form(s) to the Converter icon.

The Form Converter Options dialog box displays.

                 Figure 7-18.  Form Converter Options 
dialog box

5. Select [PostScript], then click on [OK].

The PostScript Converter Options dialog box dis-
plays.

Figure 7-19. PostScript Converter Properties 
dialog box
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6. Select/enter conversion options, then click on
[OK].

The PostScript Converter Options dialog box contains
the following options:

PostScript Level
Select the printer's PostScript level: [PS Level 1] or
[PS Level 2].

KMP
Enter the path for your KMP file or click on the [...] but-
ton and select one from the Browse KMP File dialog
box.

Font Mapping File
Enter the path for your font mapping file or click on the
[...] button and select one from the Browse Font Map-
ping File dialog box.

Source Directories
Fonts
Enter the path for your input font file or click on the
[DIR] button and select one from the Browse Input
Fonts Directory dialog box.

Source Directories
Images
Enter the path for your input image file or click on the
[DIR] button and select one from the Browse Input Im-
ages Directory dialog box.

Source Directories
Forms
Enter the path for your input form file or click on the
[DIR] button and select on from the Browse Input
Forms Directory dialog box.

Place each character separately
Approximates the position of non-standard Adobe
Type 1 fonts in the converted PostScript file.

Converting using the Windows printer driver

To convert files with the Windows printer driver:

1. Copy the Elixir form(s) to the Converter icon.
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The Form Converter Options dialog box displays.

               Figure 7-20.  Form Converter Options 
dialog box

2. Select [PostScript], then click on [OK]. 

The Print Driver Dialog dialog box displays.

       Figure 7-21.  Print Driver Dialog dialog box

3. Select your print options, then click on [OK].

The Print Driver Dialog dialog box contains the follow-
ing options:
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Orientation
The orientation of the printed page: [Landscape] or
[Portrait].

Page Shift
The number of dots you want the printed page shifted
to the right (Xshift) or down (Yshift).  Negative values
are permissible.

Copies
The number of copies of the printed page.

Print Fonts as Graphic
When selected, rasterizes fonts as graphics.  This op-
tion also requires less printer memory and may speed
up printing time.

Load Fonts
[Always] includes (in the output data stream) every
font used on every form you convert.  [Once] includes
every font the first time that the Desktop session en-
countered it.  [Never] does not include fonts in the out-
put data stream (this option assumes that all required
PostScript fonts reside on the printer).

Setup
Allows you to specify Windows setup parameters for
your printer.

You must use the Efont Factory to generate the
screen fonts used on forms that to convert to Post-
Script format.  See the “Generating fonts from out-
lines” section for more information.

After conversion, one-page PostScript-format files
write to the Output PostScript Forms folder
(drive:\ELIXIR\FORMS\PSOUT). Converted Post-
Script files have .PS extensions.

Message
Displays the Message Options dialog box.
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Converting Elixir forms to PDF format

The Desktop allows you to convert a single-page Elixir
form to Adobe's Portable Document Format (PDF).
However, converting multiple-page form and docu-
ment files require installation of the Elixir PDF option
key.

To convert Elixir forms to PDF format:

1. Copy the Elixir form(s) to the Converter icon.

The Form Converter Options dialog box displays.

                Figure 7-22.  Form Converter Options 
dialog box

2. Select [PDF], then click on [OK].

The PDF Settings dialog box displays.
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            Figure 7-23.  PDF Settings dialog box

3. Select/enter conversion options, then click on
[OK].

The PDF Settings dialog box contains the following
options:

Input ELX File
The name of the input file (form) to be converted.

Output PDF Directory
The output directory for the .PDF file. The default is
drive:\ELIXIR\DOCS\PDFOUT.

DIR
Allows you to browse and select a file from the Output
PDF Directory. 

Output PDF File
The name of the output file. When processing multiple
files, leave this option blank.

Substitute All Fonts (MM Fonts)
Creates Multiple Master versions of all fonts in your
job. Requires that Elixir versions of the fonts are in
drive:\ELIXIR\FONTS\ELIXIR.

Use this option when your document text consists
mostly of alphanumeric information with common
typefaces.
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The Converter scans each Elixir font in the form and
in the .PDF file, embeds hints for generating Adobe
Multiple Master instances. Because these are vector
fonts, .PDF file size is minimized.

To view the file you must have Adobe Type Manager
3.0 or newer installed. Note that custom characters
(such as logos or special symbols fonts) display as al-
phanumeric characters. For documents containing
fonts of this type, see the [Rasterize All Fonts] or [Use
Font Mapping] options described below. 

Rasterize All Fonts (Type 3 Fonts)
Embeds all form fonts in the .PDF file as Adobe Type
3 raster fonts. Requires that Elixir versions of the fonts
are in drive:\ELIXIR\FONTS\ ELIXIR.

Used when most fonts in your form are special char-
acters or images (such as logos) to ensure that the
special characters are viewable when the file is distrib-
uted. Because the actual raster graphics of the char-
acters are embedded in the file, .PDF files are fairly
large. 

Use Font Mapping
Uses a mapping table to control, on a font-by-font ba-
sis, the .PDF file's font format. Allows the Converter to
use a combination of Multiple Master, Adobe Type 3
raster fonts and Adobe Type 1 (PostScript) name
mappings for the fonts. The name entry box allows
you to specify the mapping file. The default file is
drive:\ELIXIR\PSSTASH\PSFONTS.MAP.

Use this option when form character mappings do not
match standard Windows character mappings.

When you select this option, the Converter scans the
specified file and compares the Elixir font names in
the form with the names found in the file (see example
below). If a match for a font is not found, a Multiple
Master instance is generated. If a match is found, the
Converter looks at the right half of the entry to deter-
mine whether to rasterize as a Type 3 font or call the
font out by a Type 1 name.
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The mapping file is an editable text file with a simple
equivalence table. The syntax for entries is:

font name= [RASTERIZE] [TYPE1fontname-weight
point-size]

For Example:

TR11NP=Times-Roman 11
TR12NP=Times-Roman 12
HE07BP=Helvetica-Bold 7
CH14SP=ZapfChancery-MediumItalic14
SIGFNT=RASTERIZE

If you specify a Type 1 font, you must enter it exactly
as it appears in the Adobe Type Manager "Installed
ATM Fonts" window. If you want to view the resulting
.PDF file on another PC, the chosen font must also be
available through ATM on the target machine.

MAP
Press this button to browse and select other files re-
siding on the Font Mapping Table.

KMP Map Table
Uses a customized mapping table to control transla-
tion of .PDF file keystrokes. The name entry box dis-
plays the specific mapping file to be used for the
conversion. The default file is drive:\ELIXIR\FONTS\
MAPS\X1000437.KMP (U.S.) See the ElixirForm for
AFP User Guide and ElixirFont for AFP User Guide
for more information.

KMP
Press this button to browse and select other files re-
siding on the Keyboard Country Mapping Table. See
the ElixirForm User for AFP Guide and ElixirFont for
AFP User Guide for more information. 

Converting forms to Elixir images

To convert (or rasterize) a form to an Elixir image
(.LP3 file in drive:\ELIXIR\PICS\PRINTER), select the
[Images] option in the Form Converter Options dialog
box.  The Image Converter Options dialog box dis-
plays.  You can specify the image resolution as 240 or
300 dpi (the default).
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Using FGIDs in a form

To use FGIDs in a form, select the fonts and create a
new .FAM file or edit the DEFAULT.FAM file as
follows:

1. Identify the FGIDs for the selected fonts and
find a similar AFP bitmapped (raster) font.

2. Edit a .FAM file as in the following example.

%%Elixir_Font_Name_Assignment_Table: AFP 3.11 June 1995
MVS_default_ddname=FONTDD;
VM_default_filetype=FONT38PP;Default_gcsgid  = -1;
Default_cpgid  = -1;
%Usage: font_id=X0aaaaaa[, option][, option]...
%where following nonpositional case insensitive options are avail-
able (only first two chars significant):
%name  =aaaaaa - internal name for OGL out conversion
%ddname=aaaaaa - ddname for OGL on MVS
%ftype =aaaaaa - filetype for OGL on VM
%id    =hhhh   - HexId for LOG
%gcsgid=nnnn   - A Graphic Character Set Global Identifier
%cpgid =nnnn   - A Code Page Global Identifier
%fgid  =nnnn   - A Font Global Identifier

%Examples: 

%font_id = X0A075B0, name=HE12B, ftype=FONT3820,
DDName=FONTLIB, gc=1234, cp=5678, fg=1000;
%font_id = X0G0550U, name=Charly, ftype=FONT3820,
DDName=FONTLYN, gc=4095, cp=256, fg=4096
%font_id = X0G0558U, name=Patsy,  ftype=FONT38PP,
DDName=FONTTIM, fg=4097;

Note:  CPGID is the Code Page ID and GCSGID is
the Global Character Set ID.

3. Use the AFP raster fonts in your form.

4. When converting, in the Page Source
Converter Options dialog box,  select
[Mapped] in the [Font Assignment] field, then
enter the table name that maps the FGIDs.
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Converting fonts

This section describes font conversion and generation
procedures. 

The Desktop allows you to perform the following font
operations:

convert AFP and double-byte AFP fonts to Elixir
format

convert Elixir fonts to HP PCL, Windows and
Screen formats

convert Contour (outline) fonts to Elixir, HP PCL,
Windows and Screen formats

convert ATM and TrueType fonts to Elixir, HP
PCL and Screen formats

generate Elixir, non-Elixir and Screen fonts

To convert all other fonts, select and copy either the
.HDR font components from the Elixir Fonts folder or
fonts from the Input Fonts folder to the Converter icon.
The Font Converter Options dialog box dis- plays.

      Figure 7-24. Font Converter Options 
dialog  box

The Font Converter Options dialog box contains the
following options:

Input Format
The format of the font selected for conversion.
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Output
The font's output format(s).

Font requirements for an HP or compatible printer

If you plan on proof-printing your form using an HP or
compatible printer, you must have every font orienta-
tion (X1 through X4) present on conversion.  

The following explains how to create X1 through X4
fonts after converting a contour font (from the Outline
Fonts folder) to Elixir, screen or HP PCL font format.  

To create every font orientation, you must first convert
the font to AFP, then reconvert from AFP to either
Elixir, screen or HP PCL format and select [Universal
X0] from the AFP Font Converter dialog box. Every
font orientation (X1 through X4) generates in the
drive:\ELIXIR\FONTS\PRINTER directory.  

AFP Font Converter Options dialog box

This section describes all the options in the AFP Font
Converter Options dialog box. 

When converting AFP bounded or unbounded box
fonts to Elixir screen format, you should also convert
the AFP code page to Elixir format.  

The AFP Font Converter Options dialog box contains
the following options:
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Figure 7-25. AFP Font Converter Options dialog box

Text Direction Support/Orientation to Assign
Applicable when converting bounded box AFP fonts to
Elixir format, and bounded box AFP and Elixir-AFP
fonts to HP PCL format:

[Universal X0] - creates one screen version of the
font that ElixirForm can rotate when designing
Elixir forms

[Separate Fonts] - creates separate screen fonts
for each rotation (X1, X2, X3, X4) or all four
screen font rotations

Screen Fonts in
Directory for screen fonts. Default is
\ELIXIR\FONTS\SCREEN\DEMO\.

Resolution of AFP Printer
Applicable when converting Elixir and HP PCL fonts to
AFP: [240 Pels] or [300 R-Units]. The image resizes
for different resolutions. 

Format of output files
Output format for AFP fonts:

[VBM] - creates files for uploading to MVS hosts
using IBM 3270, IRMA FT/3270, or compatible file
transfer packages
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[AS400] - creates files for uploading to AS/400
hosts

[IRMA] - creates files for uploading to MVS hosts
using the IRMA FTTSO and compatible file trans-
fer packages, and OS/2 creates files for use with
PSF/2

[DOS/VSE] - creates AFP format files for upload-
ing to DOS/VSE hosts

Font Type (3800)
Applicable when converting fonts to AFP 3800 (un-
bounded box) font format: [X1], [X2], [X4], or [All] cre-
ate AFP unbounded box fonts in the output 3800 AFP
Fonts folder. These selections correspond to output
font rotations of 0°, 90°, and 270°, in a clockwise
direction.

Unbounded box font characters have a smaller maxi-
mum cell size than bounded box font characters. Due
to this size difference, during conversion from Elixir
bounded box fonts to AFP unbounded box fonts, a
message may display indicating that there is an error
generating the AFP 3800 character set, and the con-
version may abort. If you receive this message during
a conversion, you should edit the font in ElixirFont to
shrink the character cells. 

Create
When converting an AFP font to Elixir or HP PCL
formats:

[Full AFP Font] - converts the entire AFP font to
Elixir or HP PCL format. Use this option if you
plan to edit and reconvert the font back to AFP
format). See the previous sections and the "AFP
font conversion considerations" appendix for
more information.

[PC Mapped Font] - creates a PC mapped or sub-
set version of an AFP font. Use this option if the
font will be converted to a format that uses ASCII-
based fonts (e.g., Xerox Centralized), or you will
be converting forms using this font to full-page
images or using one of Elixir's PreProcessor
products to convert a datastream to PDF.
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Keep ASCII Mapped Font
An ASCII Mapped font (or PC Mapped font) is an in-
termediate font file used for generating screen (for
use in ElixirForm) and HP proof printer fonts. It con-
tains only those characters from the AFP character
set that match those in the selected Country Keyboard
map (.KMP) file.

Keeps the PC mapped font file after a conversion.
Deselected to automatically delete the file after a con-
version (does not affect the generation of screen
fonts). 

Set MCIR Flag
Sets a flag in your font file which says that this font
can be used with magnetic ink character recognition
(MCIR) printers.

Country Keyboard Map
Displays the Browse Country Keyboard Map dialog
box.  The selected KMP file name displays on the but-
ton when you click on [OK].

Notify on mismatch
Provides a notice when an original font code page
does not match one in the Keyboard Map file. 

You can select a keyboard mapping file from the list of
files that reside in the drive:\ELIXIR\FONTS\MAPS di-
rectory. See the "AFP font conversion considerations"
appendix for more detailed information about .KMP
files.

Converting AFP fonts to Elixir format

To convert AFP fonts to Elixir format:

1. Download the three components for each AFP
font (Coded Font, Character Set and Code
Page) to drive:\ELIXIR\FONTS\AFPIN (for
bounded box fonts) or to drive:\ELIXIR\
FONTS\I38IN (for unbounded box fonts)

See the “File transfer” chapter for more
information.

2. Verify that the Country Keyboard Map (.KMP
file) is correct.
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See the “AFP font conversion considerations” ap-
pendix for more information. 

3. Open the Input Fonts folder (AFP Fonts for
bounded box fonts or 3800 AFP Fonts for
unbounded box fonts), then select [Show
Coded Fonts] from the Filter menu.

The X* components of the AFP fonts display.

4. Copy the font(s) to the Converter icon. 

5. In the displayed Font Converter Options
dialog box, select [Elixir].

The AFP Font Converter Options dialog box dis-
plays. 

Figure 7-26. AFP Font Converter Optionsdialog box

6. Select/enter information in the following
options, then click on [OK]:

Text Direction Support
Depending on your printer and on the type of AFP
font to convert: 

Select [Separate Fonts] and either [All], [X1],
[X2], [X3], or [X4] to create different screen
font rotations.
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Select [Universal X0] to create a single
screen font which ElixirForm can rotate. 

The [Text Direction Support] option is disabled for
unbounded box fonts. The orientation of the font
you are converting is the orientation of the output
font.

See the "AFP font conversion considerations" ap-
pendix for more information.

Create
Select the font type to create:

[PC Mapped Font]  - generates an Elixir font from
a partial subset of the AFP font for use with Elixir-
Form; also generates HP PCL fonts for proof
printing. Use this option if you do not want to re-
convert the Elixir font back to AFP format.  See
the "AFP Font Converter Options dialog box" sec-
tion for more information.

[Full AFP Font] - converts the entire AFP font and
generates an Elixir version of the coded font,
character set, and code page.  This option should
be used if you plan to reconvert the Elixir font
back to AFP format.  

Keep ASCII Mapped Font
Creates a PC mapped font file after an AFP to
Elixir conversion.  Deselect (the default) to auto-
matically delete the file after a conversion.

When converting AFP fonts to Elixir fonts the gener-
ated font components have the following file prefixes:
character sets begin with "C", coded fonts begin with
"X", and code pages begin with "T". Character set file
extensions may or may not generate, and will vary
with the software version you are using. Extensions of
".num", .240 (pels) and .300 (R-Units) denote the
resolution you select in the [Resolution of AFP printer]
option.  Generated code pages and coded fonts have
no file extensions.

For information on the files generated when you con-
vert AFP fonts to Elixir format, see the "AFP font con-
version considerations" appendix.
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Converting double-byte AFP fonts to Elixir format

To convert double-byte AFP fonts to Elixir format:

1. Copy the coded font (X0xxxxxx) file to the
Converter icon.

The Font Converter Options dialog box displays.

                Figure 7-27.  Font Converter Options dialog box

2. Select [Elixir], then click on [OK].

The AFP Font Converter Options dialog box dis-
plays.

Figure 7-28.  AFP Font Converter Options dialog box
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3. Select [Full AFP Font], deselect [Keep ASCII
Mapped Font], then click on [OK] until all
dialog boxes close.

Character set sections display as C0xxxxxx.HDR
files and code page sections display as
T1xxxxxx.COD files in the Elixir fonts folder.

Conversion to SCREEN, Windows or HP PCL fonts is
for future implementation.

Converting double-byte Elixir fonts to AFP format

To convert double-byte Elixir fonts to AFP format:

1. Copy the font (X0xxxxxx.CDF) file to convert
to the Converter icon.

The Font Converter Options dialog box displays.

              Figure 7-29.  Font Converter Options dialog box

2. Select either [AFP Bounded] or [AFP
Unbounded 3800], then click on [OK].

The AFP Font Converter Options dialog box dis-
plays.

FILE CONVERSIONS

7-46 ELIXIR TECHNOLOGIES CORPORATION



Figure 7-30.  AFP Font Converter Options dialog box

3. Select [Full AFP Font], then click on [OK] until
all dialog boxes close.

The font outputs to either:

drive:\ELIXIR\FONTSS\I38OUT (bounded)

drive:\ELIXIR\FONTSS\AFPOUT
(unbounded)

Converting fonts to HP PCL format

To convert fonts to HP PCL format:

1. Copy the font file(s) to the Converter icon.

The Font Converter Options dialog box displays.

2. Select [HP PCL] and click on [OK]. 

The HP Font Converter Options dialog box dis-
plays.
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      Figure 7-31.  HP Font Converter 
Options dialog box

3. Select/enter information then click on [OK].

The HP Font Converter Options dialog box con-
tains the following options:

Create All 4 Rotations
Select to create font versions rotated in all four
(0o, 90o, 180o and 270o) inline print directions.

Create Rotated Version
Select to create rotated font version for proof
printing a form containing rotated fonts.

Converting Elixir fonts to HP PCL soft fonts

When converting Elixir fonts to HP PCL soft fonts, all
characters in the Elixir font are maintained if you add
the following entry to the drive:\WINDOWS\ELX.INI
file:

[ADVANCEDOPTIONS]
GENSPACEGLYPHS=1

Where 1 maintains all characters below position x064,
and 0 removes these characters.

Adding HP PCL fonts to Windows applications

The following procedure describes the steps neces-
sary to add HP PCL fonts to your Windows application
fonts list.

1. Open the Windows Control Panel and select
the Printers icon.  

FILE CONVERSIONS

7-48 ELIXIR TECHNOLOGIES CORPORATION



The Printers dialog box displays.

2. Select the desired printer in the [Installed
Printers] option, then click on [Setup].

3. Click on [Fonts], then in the Font Installer
dialog box, click on [Add Fonts].

4. In the Add Fonts dialog box, set the directory
path to drive:\ELIXIR\FONTS\PRINTER, then
click on [Add].

The installer reads all soft font files in the direc-
tory and builds a list that displays a default font
name and point size.

Note that you can simplify this process by con-
verting one font at a time.

5. Select the desired font from the right list box.

The actual file name displays at the bottom of the
dialog box.  Check the file name to ensure you
selected the correct file.

6. Click on [Add].

Unless otherwise necessary, accept the default
directory (drive:\PCLFONTS) by clicking on [OK]
in the Add fonts dialog box.

7. Select the font from the left list box and click
on [Edit].

The Edit dialog box displays.

8. Modify the name to match the font file name
and click on [OK].

9. Exit to the Program Manager.

The HP PCL fonts are now available in the fonts
list of your Windows applications.
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Converting AFP and Elixir-AFP fonts to HP PCL format

When you convert an AFP or Elixir-AFP font (an Elixir
font created from an AFP font) to HP PCL format, you
should select the coded font file (X*) for conversion.
To display the coded font file component of a font, pull
down the Filter menu in the Input Fonts folder and se-
lect [Show Coded Fonts].  We do not recommend
converting character sets (C* files) because fonts do
not map to the keyboard and results are
unpredictable.

If you convert an unbounded box font (X1- X4* files)
or choose to output only one text direction of a
bounded box font (X0* files) when converting to HP
PCL, both portrait and landscape versions of the se-
lected font rotation are created. 

When you convert an Elixir-AFP unbounded box font
to HP PCL format the conversion is automatic and no
further dialog boxes display.  

For other conversions, depending on the type of font
(bounded box or unbounded box) you are converting
from and to, the AFP Font Converter Options dialog
box displays. The available (non-grayed) options de-
pend on the type of conversion. See the "AFP Font
Converter Options dialog box" section in this chapter
for a description of the options that apply to your con-
version type.

Converting Elixir and contour fonts to HP PCL format

When you convert fonts to non-AFP Elixir or outline
fonts to HP PCL format, the HP Font Converter Op-
tions dialog box also displays and contains the follow-
ing options:

Figure 7-32. HP Font Converter 
Options dialog box
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Create All 4 Rotations
Select to create a version of the font having all four
rotations. 

Create Rotated Versions
Select to create rotated versions of each FLJ font file,
thereby allowing proof-printing of HP PCL forms con-
taining mixed orientations.

Adding the following entry to
drive:\WINDOWS\ELX.INI maintains all characters in
the Elixir font when converted to HP PCL soft fonts:

[ADVANCEDOPTIONS]
GENSPACEGLYPHS=1;

Note:

GENSPACEGLYPHS=0 - removes all characters
below x0'64'

GENSPACEGLYPHS=1 - maintains all characters
below x0'64'

Converting TrueType fonts

You can use TrueType fonts on your Elixir forms, but
you must first convert the fonts to bitmap format.

You can display the TrueType Fonts window by either
opening the Input Fonts, TrueType Fonts icon; select-
ing [TrueType Fonts] from the Special menu; or
pressing <Alt>+<T>.

Note:  TrueType underline and overstrike styles are
not supported during Desktop conversion.  You must
first convert to Elixir format, then use ElixirFont to add
these styles.  You can then convert the
underline/overstrike Elixir font to other formats.

To convert TrueType fonts to supported formats:

1. Copy a file from the TrueType Fonts folder to
the Converter icon.

The Font Converter Options dialog box displays.
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2. Select the desired output format, then click on
[OK].

Depending on the output format, a Font Converter
Options dialog box may display prior to the True-
Type Fonts Attributes dialog box.

3. If a Font Converter Options dialog box
displays, select the desired font rotation
and/or output options, then click on [OK].

For more information on these options, see the
procedures for converting fonts to Xerox and HP
formats.

The TrueType Fonts Attributes dialog box dis-
plays with the following options:

Figure 7-33. TrueType Fonts Attributes dialog box

Selected Fonts
The name of the font you want to convert.

Size
The point size for the converted file.  The Desktop
does not output scaleable TrueType fonts, so you
must create all desired sizes.
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Output Font/Custom Name
The font prefix as specified in the Custom Name
text block. If a font with the specified prefix exists,
the system prompts for a different prefix.

Output Font/Auto Name
The system-generated name based upon the font
name and point size.  The naming convention for
half-point sizes uses alpha characters in the third
position of the name to represent the point size.

For example, A=1 point, B=2 points, C=3 points,
through Z=26 points.  The auto-name for an Arial
10.5 normal font is ARJ5NP.  AR for Arial, J for
10 points, 5 for .5 of a point, N for normal, and P
for portrait.

Output Fonts
The list of fonts to convert and output.  Click on
the [ADD] button to add the selected font to the
list or [DEL] to delete it. 

Sample text
Displays a sample of the selected font and point
size.

Character set mapping
The lowest and highest character positions in the
font's range in either decimal ([DEC]), hexadeci-
mal ([HEX]), or ASCII ([ASC]) representation.

Map font
Allows selection of non-standard keyboard maps
for the TrueType fonts you are converting, and for
your output fonts.

Target
Displays a dialog box for selecting the keyboard
mapping file (.KMP) to use for the non-default
character layout you want to map to.

Windows
Displays a dialog box for selecting the keyboard
mapping file (.KMP) when the TrueType font you
are converting uses a non-standard keyboard
map.
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Orientation
The orientation of the output font: portrait, in-
verted portrait, landscape, or inverted landscape.
You can click on [ADD] after selecting each orien-
tation to simultaneously create all four font rota-
tions for use in ElixiForm.

Style
The character style of the output font: italic, bold,
underlined, or overstrike.

DPI
The dots per inch resolution of the output font:
[240], [300], or [Custom], including the custom
horizontal and vertical measures.

Prepare for PostScript use
Adds an entry in the PSFONT.MAP file for each
font generated, and for each font's corresponding
PostScript font (for printing).

Converting HP PCL fonts to Elixir and AFP formats

When you convert a HP PCL font to Elixir format the
conversion is automatic and no further dialog boxes
display.

When you convert a HP PCL font to AFP or 3800 AFP
format the AFP Font Converter Options dialog box
displays. The available (non-grayed) options depend
on the type of conversion. See the "AFP Font Con-
verter Options dialog box" section in this chapter for a
description of the options that apply to your conver-
sion type.

Converting Elixir fonts to AFP format

To convert Elixir fonts to AFP, use one of the following
procedures:  

Creating a full AFP font from an Elixir coded font

To generate a full AFP font (code page, coded font,
and character set) from an Elixir font:
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1. From the Filter menu in the Elixir Fonts folder,
select [Show Coded Fonts].

2. Copy the Elixir font from the Elixir Fonts
folder to the Converter icon and select [AFP
Bounded] or [AFP Unbounded 3800] as the
output format for bounded box and
unbounded box fonts, respectively.

Note that you can convert Elixir bounded box
fonts to either AFP bounded or unbounded box
fonts.

3. In the displayed AFP Font Converter Options
dialog box, select the following:

the printer resolution (normally 240 Pels for
AFP printers) 

the output format (depending on your AFP
host)

if converting to unbounded box fonts, select
the rotation ([X1], [X2], or [X4]). Note that
3800 printers do not support [X3], the BACK
rotation

[Full AFP Font] - the AFP Font-Related Con-
verter Options dialog box displays

              Figure 7-34. AFP Font-Related Converter 
              Options dialog box

This dialog box shows the coded font name and
the code page and character set the coded font
points to.

The generated AFP fonts are:
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When converting to a bounded box font: C0*.num
(character set) where .num denotes the printer
resolution, X0* (coded font), and T1* (code page)
in drive:\ELIXIR\FONTS\AFPOUT.

When converting to an unbounded box font:
C1*.num - C4*.num, X1* - X4*, and T1* in  
drive:\ELIXIR\FONTS\I38OUT.  

Creating full AFP fonts from Elixir character sets

To create an entirely new AFP font from either an AFP
originated or non-AFP originated Elixir character set:

1. Select [Show Charset] from the Filter menu in
the Elixir Fonts folder .

2. Copy the selected file from the Elixir Fonts
folder to the Converter icon and select [AFP
Bounded] or [AFP Unbounded] (3800) as the
output format for bounded box and
unbounded box fonts, respectively.  

CAUTION: Convert only full character set Elixir
fonts. These fonts start with C0 (for fonts con-
verted from bounded box) or C1 - C4 (for fonts
converted from unbounded box). PC mapped
Elixir fonts are named X*.HDR and must not be
used for conversions to AFP format.

You can convert Elixir bounded box fonts to AFP
bounded or unbounded box fonts.

3. In the displayed AFP Font Converter Options
dialog box select the following:

the printer resolution (normally 240 pels for
AFP printers) 

the output format (depending on your AFP
host)

if converting to unbounded box fonts, select
the rotation ([X1], [X2], or [X4])(Note that
3800 printers do not support [X3], the BACK
rotation)
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[Full AFP Font]  - the AFP Font-Related Con-
verter Options dialog box displays

            Figure 7-35. AFP Font-Related Converter 
              Options dialog box

This dialog box shows the character set name to
convert, the coded font name (based on the char-
acter set name) and the default code page you
specified in the Desktop System Configuration
dialog box. You can change the code page and
coded font names if desired. 

Initially, the default code page specified in the
Desktop Basic Setup dialog box (accessed by
pulling down the System menu and selecting
[System Config]) displays.  If you change the
code page in the Font Components dialog box,
the code page you enter generates for the current
conversion and the default generates for subse-
quent conversions.

The generated AFP fonts are:

When converting to a bounded box font: C0*.num
(character set) where .num denotes the printer
resolution, X0* (coded font), and T1* (code page)
in drive:\ELIXIR\FONTS\AFPOUT.

When converting to an unbounded box font:
C1*.num - C4*.num, X1* - X4*, and T1* in  drive:\
ELIXIR\FONTS\I38OUT.

Creating individual font components

You can create an individual character set, code page,
or coded font using one of the following procedures: 
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Creating a coded font file

You can create a new coded font file for use in the fol-
lowing procedures by setting the Filter menu in the
Elixir Fonts folder to [Show Coded Fonts], and then
pressing <Alt> + <N> or selecting [New] from the File
menu. An AFP Font-Related Converter Options dialog
box displays and allows you to enter the character set,
coded font, and code page names. Only X0 or X1-X4
prefixes are permissible for the coded font name.

Converting a coded font

If you modified an Elixir coded font by changing the
code page or character set, or have created a new
coded font and want to upload it to your host:

1. From the Filter menu in the Elixir Fonts folder,
select [Show Coded Fonts].

2. Copy the Elixir font from the Elixir Fonts
folder to the Converter icon and select [AFP
Bounded] or [AFP Unbounded] (3800) as the
output format for bounded box and
unbounded box fonts, respectively.

Note that you can convert Elixir bounded box
fonts to either AFP bounded or unbounded box
fonts.

3. In the displayed AFP Font Converter Options
dialog box select the output format and
[Coded Font Only]. 

 The generated AFP fonts are:

When converting to a bounded box font: X0*
(coded font) in drive:\ELIXIR\FONTS\AFPOUT.

When converting to an unbounded box font: X1* -
X4* in  drive:\ELIXIR\FONTS\I38OUT .

Creating a character set

If you modified the font character set only (no code
page or coded font changes), you need only convert
the character set to AFP using the following steps: 
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1. From the Filter menu in the Elixir Fonts folder,
select [Show Charset].

2. Copy the Elixir font from the Elixir Fonts
folder to the Converter icon and select [AFP
Bounded] or [AFP Unbounded] (3800) as the
output format for bounded box and
unbounded box fonts, respectively.

CAUTION:  Convert only full character set Elixir
fonts.  These fonts start with C0 (for fonts con-
verted from bounded box) or C1 - C4 (for fonts
converted from unbounded box). PC mapped
Elixir fonts are named X*.HDR and must not be
used for conversions to AFP format.

Note that you can convert Elixir bounded box
fonts to either AFP bounded or unbounded box
fonts.

3. In the displayed AFP Font Converter Options
dialog box select the output format and
[CharSet Only]:

The generated AFP fonts are:

When converting to a bounded box font: C0*.n
(character set) where .n denotes the printer reso-
lution in pels, in drive:\ELIXIR\FONTS\AFPOUT .

When converting to an unbounded box font:
C1*.n - C4*.n where .n denotes the printer resolu-
tion in pels in  drive:\ELIXIR\FONTS\I38OUT.

If you want to create a screen version of the new or
modified Elixir character set, select its Coded Font
(.CDF file) component, copy it to the Converter icon,
and select the [Screen] option.  The PC mapped file
regenerates with the modifications you made. If you
convert only the character set (.HDR file) to screen
format, the screen font that generates does not prop-
erly map for the keyboard. 

Creating a code page

If you created a new code page or modified an exist-
ing code page follow these steps:
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1. From  Filter menu in the Elixir Fonts folder,
select [Show CodePage].

2. Copy the Elixir code page from the Elixir
Fonts folder to the Converter icon and select
[AFP Bounded] or [AFP Unbounded] (3800) as
the output format for bounded box and
unbounded box fonts, respectively.

3. In the displayed AFP Font Converter Options
dialog box select the output format.

The generated AFP fonts are:

When converting to a bounded box font: T1*
(code page) in drive:\ELIXIR\FONTS\AFPOUT.

When converting to an unbounded box font: T1*
in  drive:\ELIXIR\FONTS\I38OUT.

Changing the code page

To change just the code page for an AFP font (for ex-
ample, when using a character set for European
languages):

1. Download the AFP coded font from your host
to the drive:\ELIXIR\FONTS\AFPIN or
drive:\ELIXIR\FONTS\I38IN directory.

2. Convert the AFP font to Elixir by specifying
[Full AFP Font] to generate an Elixir version of
the font.

3. Select [Show Coded Fonts] from the Filter
menu in the Elixir Fonts folder.

4. Right-click on the coded font to change the
code page. 

The Font-Related Converter Options dialog box
displays.
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Figure 7-36. Font-Related Converter 
Options dialog box

5. After conversion, upload the generated files to
your AFP host using the procedures
described in the "File transfer" chapter.

Editing the Elixir Code Page

To edit an Elixir Code Page, select [Show Code
Pages] from the Filter menu in the Elixir Fonts folder.
In the displayed window double-click on any Code
Page to edit. The ElixirFont program starts.  See the
ElixirFont for AFP User Guide for information about
editing Code Pages.

Alternatively, you can use the DOS EDIT editor to edit
the Elixir Code Page.  See the "AFP font conversion
considerations" appendix for an example of editing an
Elixir Code Page.

Reconverting fonts created with Elixir Desktop version 1.00

If you created a non-AFP font or modified an existing
AFP font and exported the font using the T1ELIXIR
code page in version 1.00 of the Desktop, and then
converted the font back to Elixir format, the font does
not map properly for (screen and HP PCL) keyboard
use.

To properly map the font for keyboard use:

1. Make a note of the current Country Keyboard
Map displayed in the Desktop System
Configuration dialog box.

FILE CONVERSIONS

ELIXIR DESKTOP FOR AFP USER GUIDE 7-61



2. Change the Country Keyboard Map file name
to T1ELIXIR. This .KMP file comes with the
current software version.

3. Convert the version 1.00 font to Elixir format.

4. Reset the Country Keyboard Map to the map
noted in step 1.

To remap fonts using the T1ELIXIR code page GCIDs
to fonts using standard IBM GCIDs, convert the origi-
nal non-AFP font in Elixir format to AFP format using
the C0ADOBE GCID mapping file. See the "Desktop
configuration" chapter for more GCID file information.

Generating fonts from outlines

The Elixir desktop includes the Elixir Font Factory
(Efont Factory), a utility that uses contour (outline)
fonts compatible with Bitstream Facelift to generate
Elixir (printer and screen versions), and AFP bounded
box and unbounded box bit-mapped (or raster) fonts.

Note: Efont Factory cannot generate fonts from Bit-
stream Fontware and Fontware-compatible fonts. 

The Elixir desktop installation procedure installs 35
contour fonts compatible with Bitstream Facelift in
(drive:\ELIXIR\FONTS\CONTOURS\) the Outline
Contour Fonts folder.

If not already installed, you can install Bitstream 
Facelift fonts on your PC:

1. Select [Install Fonts] from the Desktop Special
menu.

2. Insert the first Bitstream Facelift diskette into
your diskette drive and follow the on-screen
instructions.

Once installed, you can generate up to 6 point sizes of
a font each time you use the Efont Factory.  

FILE CONVERSIONS

7-62 ELIXIR TECHNOLOGIES CORPORATION



The Efont factory also allows you to:

generate whole or partial character sets

generate different font resolutions

automatically generate font names

perform additional transformations such as font
rotation and darkening when generating Xerox
fonts

map to standard Windows character sets

You can display the Contours fonts window by double-
clicking the Outline Fonts icon, by selecting [Efont
Factory] from the Special menu, or by typing <Alt> +
<E>.

The following figure shows the Input Contour Fonts
folder window.

         Figure 7-37. Input Contour Fonts folder window

To generate an Elixir font from a contour font, copy
one or more outline fonts from the Input Contour
Fonts folder to the Converter icon. In the Font Con-
verter Options dialog box that displays, select one or
more output font formats, then click on [OK].  The
Outline-to-raster font generator dialog box displays.
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       Figure 7-38. Outline-to-raster font generator 
       dialog box

The Outline-to-raster font generator dialog box con-
tains the following options:

Font Name
The name of the converted raster font(s). If converting
to more than one point size (see the description for
the next option), enter a file name stem ending with
01. Names for converted files increment by 1 for each
point size selected, in order of ascending point size. If
you convert more than one contour font file to multiple
point sizes, the converted files become similarly
named. The maximum number of files you can create
is 99.

Autoname
Names the font files using the naming conventions
described in the “Font naming conventions” section
which follows. We recommend using [Autoname]
rather than [Font Name] for naming fonts.  To identify
newly created fonts using this option, view the fonts
using the [By Date] option in the Elixir Fonts folder
View menu.

Point Size(s)
The point size(s) for the converted font file(s). Enter
any size from 2 to 99. See the [Font Name] option de-
scription for information about converting to more than
one point size.
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Res
The resolution (in dots per inch, dpi) of the target
printer. The default is 240 dpi, normally used on AFP
printers.

Char Set
The character set of the raster font being generated:
[US], [ISO-XB] (international ISO), [Custom] (creates
full character sets), [0-Z] (upper case and numerals
only), [a-z] (lower case only). Each corresponds to a
.GMP ASCII file in drive:\ELIXIR\FONTS\MAPS. Each
line in a .GMP file is of the form mm=nn, where mm is
the hex number of the input font and nn is the hex
number of the corresponding output font.

Range
The number for the first and last characters to con-
vert, in decimal, hexadecimal, or ASCII representa-
tion. The default range is 0-255 (decimal).

Prepare for PostScript use
Select this option when printing on a PostScript printer
to place the screen font reference in the fonts map-
ping table, PSFONT.MAP, a file containing a mapping
between the PostScript name and DOS file name for
each font. When this option is not selected, the fonts
mapping table does not include the PostScript font
name.

Keep Left Kern
Select this option (the default) to keep left kerning in-
formation for left-kerned characters.  When this option
is deselected, you delete left kerning and create a
width table in the drive:\ELIXIR\FONTS\TABLES di-
rectory containing width, height, offset, left, and right
kerning, and ASCII index values for each font charac-
ter.  The width table has the same name as the font
file and has a .TFB file extension.

Information in .TFB files allows you to build a left kern-
ing table for using the font in non-Elixir environments.

Check for size limit
Ensures that the generated font size is within your
printer's size limit. [64k] and [128k] truncate the font at
the specified limit and issue an error message. [None]
generates the font regardless of size.  
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Creating a screen font larger than 128 KB may result
in errors.  See your printer manual for printer font size
limits.

Darken characters
Due to the limitation of some printers, small fonts may
print lightly. To compensate for the problem, use
[Darken RT] to darken horizontally when printing in
portrait orientation and [Darken DN] to darken verti-
cally when printing in landscape orientation. The de-
fault is [None].

Font Orientation
Specifies [Portrait], [Landscape], [Inverse Portrait], or
[Inverse Landscape] orientation for output fonts.

Place Screen Fonts in
The directory to which screen fonts write (creates a
new directory if one does not exist).

Font naming conventions

When you select [Autoname] in the Outline-to-raster
font generator dialog box, Efont Factory generates
raster fonts and names them using the following
conventions:

A six-character stem name generates.

The first two characters of the generated font
name describe the font family from the following
table:  
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If you add a new font family without first adding a
name and descriptor to BTFONT.NAM, Efont
Factory assigns XX as the first two characters.

The third and fourth characters of the generated
font name describe the point size you enter in the
Outline-to-raster font generator dialog box.

The fifth character of the generated font file name
describes the type style from the following table:

Font family First two file characters

Courier CO (Courier)

Dutch TR (Times Roman)

Swiss HE (Helvetica)

ITC-Avant-Garde AG (Avant Garde)

ITC-Bookman BM (Bookman)

Swiss Narrow HN (Helvetica Narrow)

Symbol-Set SY (Symbol)

Century-Schoolbook CS (Century Schoolbook)

ITC-Zapf-Chancery CH (Chancery)

ITC-Zapf-Dingbats DB (Dingbats)

Zapf-Calligraphic PA (Palatino)
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Type style Fifth file character used

Normal N

Demi D

Bold B

Italic I

Bold Oblique V

Oblique O

Light Italic Q

Demi Italic R

Medium Italic S

Bold Italic T

Demi Oblique U

The sixth character of the generated font name
describes the orientation from the following table:

Orientation Sixth file character used

Portrait P

Landscape L

Inverse portrait I

Inverse landscape J

For example, a converted ITC-Zapf-Chancery, 12
point, bold, portrait font becomes named CH12BP.

FILE CONVERSIONS

7-68 ELIXIR TECHNOLOGIES CORPORATION



You can assign two-character descriptors for ad-
ditional fonts not included in the above tables as
follows:

First, determine the .TDF file name in the Input
Outline Fonts folder by selecting a font and drag-
ging it within the folder. (The cursor changes and
identifies the font name.) Press <Esc> to return to
a standard cursor. 

Next, use the DOS TYPE command to display the
contents of the .TDF file for the font . The .TDF
file displays the HPCODE, a two-character font
family identifier.

Now, edit BTFONT.NAM in drive:\ELIXIR\FONTS
\MAPS (using an ASCII editor) and add a line that
includes the following to the end of the file:

The full DOS name of the .TDF file, a space, the
two-character designator, a space, the typestyle.

Generating Elixir fonts

When using Efont Factory to create fonts for use in
ElixirForm, select the [Keep Left Kern] option in the
Outline-to-raster font generator dialog box. ElixirForm
supports left kerning, and selecting this option spaces
and kerns all form characters correctly on the screen
and on the printer output.

Generating non-Elixir fonts

If you want to use the Efont Factory to create fonts for
non-Elixir applications, do not select the [Keep Left
Kern] option.  See the description for the [Keep Left
Kern] option in the “Generating fonts from outlines”
section for more information.  
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Generating screen fonts

Screen version fonts differ for different monitors, and
therefore require regenerating when you:

copy Elixir fonts from a PC on which Elixir for an-
other monitor is installed, or

reinstall Elixir on your PC and specify a different
monitor.

You need screen fonts when creating or editing forms
with ElixirForm. Creating screen versions of forms
also allows you to preview Elixir fonts in the Elixir
Fonts folder.

You may also want to regenerate the screen version
of a new or revised Elixir character set. To do so, se-
lect its Coded Font (.CDF file) component, copy it to
the Converter icon, and select the [Screen] option.
The PC mapped file regenerates with the modifica-
tions you made. If you convert only the character set
(.HDR file) to screen format, the screen font that gen-
erates does not properly map for the keyboard. 

Adding HP PCL fonts to Windows applications

See your Microsoft Windows documentation for infor-
mation on adding HP PCL fonts to your Windows ap-
plication fonts list.

Windows character mapping

To map fonts converted with the Efont factory to the
standard Windows character set (Latin 1 - ANSI
1252):

1. Copy the outline font to the Converter icon.
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The Font Converter Options dialog box displays.

               Figure 7-39.  Font Converter Options dialog box

2. Select either [Elixir], [Screen], [Windows], or
[ATM Type 3], then click on [OK].

The Outline-to-raster font generator dialog box  
displays.

Figure 7-40.  Outline-to-raster font generator dialog box

3. Select the [Char set map - Custom] option,
then click on the [Full] button.

The Browse Code Page dialog box displays.

4. Select ANSI.GMP, then click on [OK] until all
dialog boxes close.
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Character remapping when converting ATM or True-
Type fonts to Elixir or APF formats occurs
immediately.

Converting images

Using the Elixir Desktop, you can convert
image/graphics files from the Input or Elixir Image
folders.  The Converter can also create color IM or
GOCA page segments.  Color IOCA and conversion
of full color images to AFP page segment is for future
implementation.

When you copy one or more image files from any of
the above folders to the Converter icon, the Image
Converter Options dialog box displays and contains
the following options:

       Figure 7-41. Image Converter Options dialog box 

Input Format
Displays the format of the image(s) selected for
conversion.

Output
Displays the available image conversion output
formats.
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Converting Elixir graphics files to Tiles in a Font format

This option places a grid on an image and converts
each cell of the grid to a character in an Elixir font,
starting at position Decimal 65 (A). See the Elix-
irImage User Guide for more information.

When converting Elixir-format files, select [Tiles in a
Font] and click on [OK] to display the Extra Converter
Options dialog box.

         Figure 7-42.  Extra Converter Options dialog box

The Extra Converter Options dialog box contains the
following options:

Retile
Retiles the .TXT file associated with the Elixir-format
(.LP3) file.

Orientation
Select [Port] for portrait, [Land] for landscape,
[InvPort] for inverse portrait, or [InvLand] for inverse
landscape format fonts.  

Converting to and from AFP page segments

If you are converting an AFP page segment file or converting
an image to AFP page segment format, the AFP Image Con-

verter Options dialog box also displays and contains the follow-
ing options:
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Figure 7-43. AFP Image Converter Options dialog box

Image Type
Select your image's type: [IM Image], [IOCA CCITT4],
or [GOCA].

Remove Image Whitespace
If an AFP Page Segment image contains unwanted
white space, select [Yes] to trim the white space to
create a smaller converted file. Select [No] to retain
the white space. [IOCA CCITT 4] minimizes white
space according to CCITT Group 4 facsimile format. 

Resolution of AFP Printer
Allows you to select [240 Pels] or [300 R-Units]. When
converting images to Elixir format, the file is marked
with the value you select. When reconverting from
Elixir to another image format, you must again specify
the printer resolution. During conversion from Elixir
format, the image resizes as follows:

If the Elixir file contains the resolution value to
which you want to convert the file, it does not
resize.

If the Elixir file contains a resolution value differ-
ent from the value to which you want to convert, it
resizes accordingly.

If the Elixir file contains no mark, it resizes if the
[Resolution of AFP Printer] value is other than
[300 R-Units].  
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When converting an AFP page segment to Elixir for-
mat, specify 240 pels.

When converting Elixir image files originally converted
from AFP format, specify 240 pels to retain the size. 

When converting Elixir images not converted from
AFP format, specify 300 R-Units to resize the image;
however, for producing higher quality images, use
ElixirImage for resizing.

Format of output files
Output format for AFP fonts:

[VBM] - creates files for uploading to MVS hosts using
IBM 3270, IRMA FT/3270, or compatible file transfer
packages

[AS400] - creates files for uploading to AS/400 hosts

[IRMA] - creates files for uploading to MVS hosts us-
ing the IRMA FTTSO and compatible file transfer
packages, and OS/2 creates files for use with PSF/2

[DOS/VSE] - creates AFP format files for uploading to
DOS/VSE hosts

Rotate Images
The degree the output image rotates:  [0], [90], [180],
or [270].  For PSEG-to-Elixir conversions, if a page
segment is rotated beyond 0 degrees, you must rotate
it on input to Elixir format for it to display correctly.

For example, a page segment with a 90-degree rota-
tion should be further rotated 270 degrees during the
conversion to display correctly ("upright") in a portrait
form.

Preferred Color
Color to apply to black and white image or to change a
highlight color images to during conversion.

Floating offsets
Horizontal
Shifts output right for portrait orientation, and shifts
output down for a landscape orientation by the num-
ber of dots specified.
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Floating offsets
Vertical
Shifts output down for portrait orientation, and shifts
output right for a landscape orientation by the number
of dots specified.  

Converting .TIF and .PCX files to Elixir

When converting TIFF or PCX images to Elixir, the
Image Converter Options dialog box displays. 

          Figure 7-44. Image Converter Options dialog box

Select the resolution of the image as [240] or [300]
dpi. Note that the image is resized if you do not spec-
ify its original resolution (the higher the resolution, the
smaller the image).

Adding color to images during conversion

You can apply color to black and white images or
change a highlight color image's color during
conversion.

To add or change image color during conversion:

1. Copy the Elixir image (.LP3) to the Converter
icon.
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The Image Converter Options dialog box dis-
plays.

              Figure 7-45.  Image Converter Options dialog box

2. Select [AFP PSeg], then click on [OK].

3. Select a color from the [Preferred Color]
option, then click on [OK].

For converted black and white files, color applies to all
of the black pixels.  For converted highlight color files,
color applies to the background color plane.

Converting documents

You can convert multi-page document (.DAT) files  
from the Input Document or Elixir Document folders. 

.DAT files reside in the drive:\ELIXIR\DOCS\DOC-
LIST directory (Elixir Documents folder) and contain
existing Elixir-format (.ELX) form files which together
comprise a single multi-page document. 

Each form file (without the .ELX extension) in the form
list file is preceded with %% and delimited by a car-
riage return/line feed combination. For example, a file
called TEST.DAT could contain the following lines:

%%TAX
%%FEDBANK
...
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You can double-click on any .DAT file to view the file
in Windows Notepad.

Copy a .DAT file to the Converter icon to display the
Document Converter Options dialog box.

         Figure 7-46. Document Converter Options 
dialog box

Input Format
Displays the format of the documents you are
converting.

Output
Allows you to select one or more of the displayed for-
mats to which you can convert input documents.  For-
mats to which you cannot convert display grayed.

Converting Elixir .DAT files to HP PCL documents

To convert a .DAT file to HP PCL format:

1. Copy the file(s) to convert from the Document
folder's Elixir or Input folder to the Converter
icon.

2. In the Document Converter Option dialog box
that displays, select the [HP PCL] output
format , then click on [OK].

3. Select a HP printer in the Print Driver dialog
box that displays, then click on [OK].
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The Desktop creates a .PRN file in the Output Docu-
ments, HP PCL Docs folder (drive:\ELIXIR\DOCS\
HPOUT\ ).

Converting Elixir .DAT files to PostScript documents

To convert a .DAT file to PostScript format:

1. Copy the file(s) to convert from the Document
folder's  Elixir or Input folder to the Converter
icon.

2. In the Document Converter Option dialog box
that displays, select PostScript], then click on
[OK].

3. Select a PostScript printer in the Print Driver
dialog box that displays, then click on [OK].

The program creates a .PS file in the Output Docu-
ments, PostScript Docs folder
(drive:\ELIXIR\DOCS\PSOUT\).

Converting Elixir .DAT files to AFP documents

To convert a .DAT file to AFPDS format:

1. Select the file(s) to convert from the Elixir or
Input folder of the Documents folder.

2. Copy  the file(s) to the Converter icon.

3. In the Document Converter Option dialog box,
select the [AFPDS] output format and click on
[OK] or press <Enter>.
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The AFP Page Converter Options dialog box dis-
plays.

Figure 7-47. AFP Page Converter Options dialog box

4. Select converter options, then  click on [OK].

The program creates an .AFP file in the AFP Docs
folder (drive:\ELIXIR\DOCS\AFPOUT\ directory).

AFP Page Converter Options dialog box

Options in this dialog box may or may not display, de-
pending on your selections in the Form Converter Op-
tions dialog box.

Elixir Pages in
Source directory for Elixir forms (default is drive:\
ELIXIR\FORMS\ELIXIR\).

Text Justification
Applicable for conversions to OVE and OGL. The de-
fault [Inter-Word] justifies text by adding or deleting
spaces between words. This option reduces the com-
plexity of your form so the form prints faster. [Inter-
Character] justifies text by adding or deleting spaces
between characters. This option makes the form more
readable but extends printing time.
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Rotate Pages
Rotates the screen version of a form clockwise by the
number of degrees selected. 

If you converted Elixir forms to another format and
now want to convert them back to Elixir format, you
must adjust the page rotation as follows:

   Output rotation      Input rotation

[0] [0]
[90] [270]
[180] [180]
[270] [90]

Output rotation is the rotation option selected when
the original Elixir form was converted to another for-
mat. Input rotation is the rotation option you should se-
lect when you convert the form back to Elixir format so
the form displays correctly.

Resolution of AFP Printer
Select your printer's resolution: [240 Pels] or [300 R-
Units]. When converting forms to Elixir format, the
program marks the file with the value you select.
When reconverting from Elixir to another format, you
must specify the printer resolution for resizing as
follows:

If the Elixir file contains the resolution value to
which you want to convert the file, it does not
resize.

If the Elixir file contains a resolution value differ-
ent from the value to which you want to convert, it
resizes accordingly.

If the Elixir file contains no mark, it resizes if the
[Resolution of AFP Printer] value is other than
[300 R-Units].

When converting an Elixir form originally converted
from AFP format, specify [240 Pels] to retain the size.

Format of output files
Select the output format for AFP file(s):
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[VBM] - creates AFP-format files for uploading to MVS
hosts using IBM 3270, IRMA FT/3270 or compatible
file transfer packages

[AS400] - creates AFP-format files for uploading to
AS400 hosts

[IRMA] - creates AFP-format files for uploading to
MVS hosts using the IRMA FTTSO and compatible
file transfer packages

[OS/2] - creates AFP-format files for use with PSF/2

[DOS/VSE] - creates AFP-format files for uploading to
DOS/VSE hosts

Font Type
When converting to Elixir format:

[Universal X0] - creates call-outs to X0 universal
(bounded box) fonts in the Elixir form file

[Separate X1-X4] - creates callouts that emulate un-
bounded box font types in the Elixir form file, based on
the following:

text direction = Across, X1 is called out

text direction = Down, X2 is called out

text direction = Back, X3 is called out

text direction = Up, X4 is called out

When converting AFP and OVE format forms to Elixir
format, if the form contains call-outs for X0 fonts, the
[Separate X1-X4] option is not effective. Font call-outs
in the Elixir form remain X0 call-outs regardless of the
font type option selected.

When outputting fonts to AFP or OVE and back to
Elixir format, if fonts in your form are all one direction
and/or you do not want the two-digit AFP prefix ad-
ded, select [No AFP Prefix]. 

Deselect [No AFP Prefix] if you have mixed-directional
fonts in your form and plan on proof-printing.  See the
"Font requirements for an HP-compatible printer" sec-
tion for an example.
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Units
Units for horizontal or vertical offset in pels, inches or
millimeters.

Remove Image Whitespace
Not applicable to form conversions.

Embed Page Segments
Includes converted Page Segments within the data
stream when converting to OVE.  Deselecting this op-
tion includes only a reference to the Page Segment.
Note that the Page Segment must exist in your host
Page Segment library.

Floating Offsets
[Horizontal] is applicable for converting to AFP format.
Shifts output right for portrait orientation, and shifts
output down for a landscape orientation by the num-
ber of dots specified. The offset value displays in the
unit of measurement selected in the Units option. The
default unit is pels, so offset values converted to
inches or millimeters may be slightly off due to round-
ing errors. You can edit the value displayed if
necessary.

[Vertical] is applicable for converting to AFP format.
Shifts output down for portrait orientation, and shifts
output right for a landscape orientation by the number
of dots specified. The offset value displays in the unit
of measurement selected in the Units option. The de-
fault unit is pels, so offset values converted to inches
or millimeters may be slightly off due to rounding er-
rors. You can edit the value displayed if necessary.

Fonts
Displays the MCF Fonts dialog box which contains the
following options:
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         Figure 7-48.  MCF Fonts dialog box

MCF(1)
Uses Map Coded Font Format 1 (MCF(1)) struc-
tured fields in the resulting output file.  MCF(1) is
IBM's original AFP font specification and AFP ar-
chitecture supports it as a coexistence object.
MCF(1) has been superseded by MCF(2) but is
still valid.

MCF(2)
Uses Map Coded Font Format 2 structured fields
in the resulting output file.  MCK(2) is recom-
mended for MO:DCA compliance.

Default
Converter looks in the file entered in the Charac-
ter Mapping File Name option for individual font
handling instructions.  If an entry is found for a
font used in the original Elixir form or document,
the RTYPE keyword format is used; else the font
using the coded font name in a MCF(1) structures
field record is used (default).

Coded Font Name
Converter writes all font references using the
coded font name.

Charset + Code Page Name
Converter writes all font references using a char-
acter set/code page pair.  The original font's char-
acter set and code page are referenced for fonts
originating in the AFP environment.
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The six character assigned Elixir name generates
the character set name and the code page comes
from the Default Code Page option in the Desktop
Basic Setup dialog box for non-AFP fonts.

Outline
Converter writes all font references using PSF
outline font parameters (only valid for Adobe Type
1 or True Type fonts).  You must set-up font fam-
ily name references in your AFP font mapping file
before selecting this option.  If no font matches
are found, the character set and code page
names are used.

To set up font family name references, open your
font mapping file (default is
drive:\ELIXIR\FONTS\MAPS\DEFAULT.FAM),
then follow the instructions in the "Font Family
Descriptors" section.

FGID
Converter writes all font references using the
previously-specified Global Resource Identifier
(GRID).  The GRID includes the Font Typeface
Global Identifier (FGID), Graphic Character Set
Global Identifier (GCSGID) and the Code Page
Global Identifier (CPGID) mappings.

Character Mapping File Name
Path and name of your AFP font mapping file
which provides the Converter with output overlay
and document font mapping information.  Default
is drive:\ELIXIR\FONTS\MAPS\DEFAULT.FAM.

AFP
Displays the AFP Settings dialog box which con-
tains the following options:
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     Figure 7-49.  AFP Settings dialog box
OGL

Displays the Page Source Converter Options dialog box which
contains the following options:

Figure 7-50. Page Source Converter Options dialog box

Include Author Banner
Includes the form's Page Author information in
the file conversion.  The author banner includes
the author's name at the top of the form file. See
the Page Databasing Information defaults sub-
menu in your ElixirForm for AFP User's Guide for
more information. 
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Keep Texts Boxed (OGL only)
Writes boxed text on a form into OGL as a
DRAWBOX WITHTEXT command during conver-
sion.  Boxed text with no visible border is written
as DRAWBOX WITHTEXT xxPELS xxPELS 0,
and justified text is always written as JUSTIFY
LASTNO (last line remains LEFT justified).  All
justification in this mode is done INTERWORD
(only option the OGL compiler supports).  The
BALANCE option is not supported. 

Code Page Translation (OGL only)
Writes OGL out to EBCDIC rather than ASCII
format.

Include Description Text
Converter generates a specialized comment for
inclusion after the Author Banner in OGL or LOG
source files.  The format for this comment is:

'1 [InternalName].[LocalID] [MadeFor] [Short Page
Description]

where "1" is used as a search string for host pro-
grams which produce listings of overlay source
libraries, and [InternalName] is the six-character
name of the OGL or LOG source.

See the Page Databasing dialog box in your Elix-
irForm for AFP User's Guide for information on
the other options included in this comment. Note
that the Date/Time Stamp and Long Page Com-
ments for a form are also included in the
conversion. 

Generate BPSD Tags 
Automatically generates and displays BPSD tags
in the OGL formats.

Font Assignment
For OGL, select [Auto] to map fonts from their
coded font names to six-character internal names
without the 'Xn' prefix. For LOG, the full eight-
character 'X' coded font name is retained. 

Select [Mapped] to load and use the DEFAULT.
FAM table in drive:\ELIXIR\FONTS\MAPS for
mapping font names. 
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For LOG, use this table to assign local four-
character identifier names for fonts residing on
the printer's disk. 

For OGL, use this table to assign individual
DDNAMES to fonts.  

For OVE or AFPDS, use this table to assign Font
Global Identifiers (FGIDs) to font names.  See the
"Using FGIDs in a form" section for an example of
mapping FGIDs to fonts.

You can also change your target environment
from MVS to VM by editing the drive:\ELIXIR\
DESK TOP\ SYSTEM\AFP.INI file included with
the Desktop. See the "Changing your target envi-
ronment from MVS to VM" section for more
information.

In the [Map table] field, enter the file name of the
mapping table in drive:\FONTS\MAPS to use
when you select [Mapped] in the [Font Assign-
ment] option. DEFAULT.FAM is the default.

Pseg Assignment
Select [Auto] to map page segment image names
from their external file names to six-character in-
ternal names without the 'S1' prefix. For LOG, the
full eight-character S1 name is retained.  Select
[Mapped] to load and use the DEFAULT.SAM ta-
ble in drive:\ ELIXIR\PICS\MAPS to map page
segment names. Once compiled, the page seg-
ments store inside the overlay. 

For LOG, you can use DEFAULT.SAM to assign
local four-character identifier names for fonts re-
siding on the printer's disk.  For OGL, you can
use this table to assign DDNAMES to page
segments.

You can change your target environment from
MVS to VM by editing the
drive:\ELIXIR\DESKTOP\ SYSTEM\AFP.INI file
included with the Desktop.  See the "Changing
your target environment from MVS to VM" section
for more information.  
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In the [Map table] field, enter the file name of the
mapping table in drive:\ELIXIR\PICS\MAPS to
use when you select [Mapped] in the [Pseg As-
signment] option.  DEFAULT.SAM is the default.

CONTROL
Builds the CONTROL statement used in OGL and
LOG source files:

[noSTORE] -  specifies that the form is not stored
in a library

[STORE] - stores the form in a library

[REPLACE] - stores the form in a library and re-
places any existing forms with the same name

[ALL] - displays every message the system gener-
ated during processing

[WARN] - displays only the warning messages
generated during processing

[ERROR] - displays only the error messages gen-
erated as a result of OGL/370 processing

[noSUMMARY] - specifies that a summary does
not display as part of the source listing

[SUMMARY] - displays a statistical summary as
part of the source listing

Formwidth 
Enter the FORMWIDTH command arguments di-
rectly.  For example, 3600 PELS.

Formlength 
Enter the FORMLENGTH command arguments
directly.  For example, 3200 PELS.

Copies 
This option is valid in certain circumstances. See
your Comparex documentation for information.

Margin
Enter the offset from the edge of the paper to the
beginning of the printing area. If you specify a
margin value in the Form Control Block, use the
same value. The default margin is 0. 

FILE CONVERSIONS

ELIXIR DESKTOP FOR AFP USER GUIDE 7-89



Sequence Numbers
Appends 8-digit sequence numbers to output in
columns 73-80. 

Delete
Deletes the overlay from the printer's disk after
use.  Deselect to save the overlay on the printer's
disk.

Converting AFPDS to multiple Elixir forms

To convert AFPDS files to Elixir:

1. Copy the AFPDS data stream file to the Input
AFP Docs folder and assign the extension
.AFP to the file. 

2. Copy the file to the Converter icon and select
[Elixir].

3. Select the following options from the AFP
Page Converter Options dialog box :

Figure 7-51. AFP Page Converter Options dialog box

4. Select the following options:
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Rotate Pages
Allows you to rotate the output forms with respect to
the print direction of the input forms by the number of
degrees you specify.  

Resolution of AFP Printer
Allows you to select [240 Pels] or [300 R-Units]. When
converting images to Elixir format, the file is marked
with the value you select. When reconverting from
Elixir to another image format, you must again specify
the printer resolution. During conversion from Elixir
format, the image is resized as follows:

If the Elixir file contains the resolution value to
which you want to convert the file, it does not
resize.

If the Elixir file contains a resolution value differ-
ent from the value to which you want to convert, it
resizes accordingly.

If the Elixir file contains no mark, it resizes if the
[Resolution of AFP Printer] value is other than
[300 R-Units].

When converting an AFP page segment to Elixir for-
mat, specify 240 pels.

When converting Elixir image files originally converted
from AFP format, specify 240 dpi to retain the size. 

The conversion process creates one-page Elixir forms
in the Elixir Forms folder, a .DAT file in the Elixir
Documents folder, appropriate fonts in the Elixir Fonts
folder (see the "Converting fonts" section and the
"AFP font conversion considerations" appendix for in-
formation), and any images in the Elixir Image folder.

Font Type
When converting to Elixir format, [Universal X0] cre-
ates call-outs to X0 universal (bounded box) fonts in
the Elixir form file. [Separate X1 - X4] creates call-outs
that emulate unbounded box font types in the Elixir
form file based on the following: if the text direction in
the form is Across, X1 is called out; if the text direction
is Down, X2 is called out; if the text direction is Back,
X3 is called out; and if the text direction is Up, X4 is
called out.
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When converting AFP and OVE format forms to Elixir
format, if the form contains call-outs for X0 fonts, the
[Separate X1-X4] option is not effective. Font call-outs
in the Elixir form remain X0 call-outs regardless of the
font type option selected.

When outputting fonts to AFP or OVE and back to
Elixir format, if fonts in your form are all one direction
and/or you do not want the two-digit AFP prefix added,
select [No AFP Prefix].

Note:  Do not select [No AFP Prefix] if you have
mixed-directional fonts in your form and plan on proof-
printing.  See the "Font requirements for a HP series II
printer" section for an example.

Remove Image Whitespace
Select [Yes] to trim the white space surrounding im-
ages to create a smaller converted file. Select [No] to
retain the white space. 

Converting Pagedef/Formdef resources

The Jobs folder manages Pagedef and Formdef re-
sources.  Opening the Elixir Data Jobs folder provides
access to the Elixir AppBuilder jobs database  which
is stored by default in drive:\ELIXIR\JOBS\ELIXIR.

To convert existing Elixir-format Pagedef and Formdef
resources:

1. Copy the resource to convert to the Converter
icon.

The Application Converter Options dialog box
displays.

2. Select either [PPFA Source Application] or
[AFP Compiled Pagedefs/Formdefs], then
click on [OK].

The Export Options dialog box displays.  See your
Elixir AppBuilder for AFP User Guide for a de-
scriptions of the available options.
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3. Select/enter options, then click on [OK].

The converted resources display in the Output
Jobs folder in either the PPFA Source or
PDEF/FDEF folder.

To convert PPFA source or object (compiled)
Pagedefs and formdefs into Elixir format:

1. Copy the resource to convert to the Converter
icon.

The Application Converter Options dialog box
displays.

2. Select [Elixir Application], then click on [OK].

The Import Options dialog box displays.  See your
Elixir AppBuilder for AFP User Guide for a de-
scriptions of the available options.

3. Select/enter options, then click on [OK].

The converted resources save in AppBuilder's da-
tabase and are accessible by double-clicking on
the icon in the Elixir Data Jobs folder or by load-
ing it within AppBuilder.

Converting files using DOSVSE

The DOSVSE program extracts AFP structured field
information from a downloaded phase file in prepara-
tion for conversion to Elixir generic format.

This utility converts the file into an Elixir readable file
(structured field records only).  The conversion over-
writes the existing file so make a backup before run-
ning it if necessary.

You can run DOSVSE:

as a DOS command line utility

as a utility executed from the Elixir Dispatcher
icon.
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Running DOSVSE as a DOS command line utility

To execute, type the following from the drive:\ELIXIR
command prompt:

DOSVSE [full path name\]filename.ext
<Enter>

Running DOSVSE from the Elixir Dispatcher icon

To set up a Dispatcher utility, see the "Accessing DOS
files and applications" chapter.

To execute, select the resource(s) to convert, drag
them down to the Dispatcher icon, and select the
DOSVSE utility.  

Converting files using ELX2VSE

ELX2VSE converts AFP data stream files (.SEG,
.OVE and font files) to VSE linkage editor statements.

The utility uses the CL4.DEF file to obtain the job con-
trol information included in the object deck.  You can
edit the CL4.DEF file using any standard text editor.
You should examine this file and modify it to your in-
stallation standards.  Parameters that may require
modification include CATALOG (the destination for the
phase file), DISP, and CLASS.

ELX2VSE creates a file with the name filename.DCK
in the directory where the original file resides. 

Uploading to the host
To upload the .DCK file to the host:

Use ELX2VSE to convert, then upload the .DCK
file. 

Use the DOSLOAD.BAT file to automate conver-
sion and upload.

See the "File transfer" chapter for AFPDS to VSE up-
loading procedures
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Prerequisite software levels
- VSE/ESA     APAR PL77851 in PTF UN06427
- VSE/SP V4   APAR PL76660 in PTF UL92181
- VSE/SP V3   APAR PL77268 in PTF UL89813  

Using ELX2VSE

You can run ELX2VSE:

as a DOS command line utility

as a utility executed from the Elixir Dispatcher
icon.  

Running ELX2VSE as a DOS command line utility

To execute, type the following from the drive:\ELIXIR
command prompt:

ELX2VSE [full path name\]filename.ext
<Enter>

Running ELX2VSE from the Elixir Dispatcher icon

To set up a Dispatcher utility, see the "Accessing DOS
files and applications" chapter.

To execute, select the resource(s) to convert, drag
them down to the Dispatcher icon, and select the
ELX2VSE utility.

Deleting converted input files

After converting files, the input files you copied to the
Converter icon remain highlighted in the window. 

To save disk space, you may want to delete the high-
lighted file(s).  
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Confirming file conversion

To confirm file conversion, close the input folder in
which you selected files to convert. Open each Output
folder in which the converted file(s) generate and
check the contents of the folder. You may find it easier
to find the files you want if you display the contents of
the window by date. The most recently created files
display at the beginning of the file list.  

ElixirDoc

You can run all Elixir conversion applications by copy-
ing files to the Converter icon as described in this
chapter. You can also run the conversion applications
as stand-alone programs.

To run any Elixir conversion program, open the Elixir-
Doc icon to display a window showing a list of Elixir
conversion applications. 

You can specify the setup options for the conversion
application to use by clicking on its icon, then select-
ing [Properties] from the File menu. The appropriate
property sheet for the selected conversion displays.

Specify the options and select [OK] to save the op-
tions to disk.

To run a stand-alone converter, do one of the follow-
ing:

Double-click on the icon.

Select [Open] from the File menu.

Press <F2>.

The Desktop clears and the selected converter appli-
cation runs. You can now perform file conversions as
described in this guide for each converter application. 

After conversion, select [Quit] or [Exit] to return to the
desktop.  
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8.  Accessing DOS files 
and applications

This chapter describes how the Elixir Desktop allows
access to DOS files and applications.

Desktop tools

The Elixir Desktop includes a number of tools that en-
able you to access DOS files and applications as
follows:

User Tools icon

The User Tools icon allows you to establish an icon
for any Windows application, DOS application or
batch file, so that double-clicking on the icon executes
(or starts) the application.   

User Files icon

The User Files icon provides access to all DOS direc-
tories and files.

The User Files icon also includes a Tool Link utility
that allows you to link a file with an application.  Once
linked, double-clicking on the file starts the application
and loads the file.  
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Dispatcher icon

The Dispatcher icon allows you to store up to 12 DOS
commands with optional replaceable parameters.
When you copy a file to the Dispatcher icon and select
a command, the name of the file substitutes for the
first replaceable parameter.

Creating an application icon

The User Tools icon allows you create icons for appli-
cations and batch files on your PC.

During software installation, the ELXWDATA User
Tools install.

The ELXWDATA User Tool starts a batch file that
generates a text file called ELXWDATA.TXT on the A:
drive diskette.  The file contains the contents of your
AUTOEXEC.BAT, CONFIG.SYS and INSTALL.LOG
files and other information such as existing .APP and
.EXE files and system memory.

Creating an icon

To create an application icon, open the User Tools
icon to display the User Tools window.

The User Tools window is similar to other Elixir win-
dows and includes an additional Tools menu title in
the window header.

Select the [New Tool] option in the Tools menu  to
display the User Application Setup dialog box which
contains the following options:
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        Figure 8-1.  User Application Setup dialog box

Command to Execute
The command that executes the application associ-
ated with the icon. For example, to create a WordPer-
fect icon, you would specify WP.

If you want to link the application to files in the same
directory as the application (see the “Linking files to an
already defined User Tool” section), you can also type
in the DOS command with an embedded %1 parame-
ter. The embedded %1 parameter specifies the loca-
tion in the command at which you want the file name
to appear. See also the [Prompt for parameters]
option.

Nickname for application
A nickname (up to 8 characters) for the application
you want to run. For example, you may specify VENT
as a nickname for Ventura Publisher. After creating an
icon, the User Tools window displays the icon with the
nickname under it.  
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Optional Long Name
A descriptive name for the application (up to 29 char-
acters). For example, for Ventura Publisher, you can
enter Ventura Publisher. The long name is informa-
tional only; it identifies the application in the dialog
box.

Working Directory
The DOS path for the executable. Use this field if the
application you are running is not present in the
drive:\ELIXIR directory and if you have not specified a
DOS PATH= statement for the directory in which the
application executable resides.

Command Options
Select command options:

[DOS Application]- for running a DOS applications

[Send Only Filename] - uses only the file's stem name
for command execution

[Prompt for parameters] - program  prompts for an ar-
gument to appends to the command in the  [Com-
mand to execute] option

[Run Minimized]-  executes the command in a mini-
mized window

Command Attributes
Select command attributes:

[Command is .BAT file] - for DOS batch file com-
mands; redisplays the Desktop when you exit the ap-
plication.  If the application is a batch file that calls
another batch file, the Desktop does not redisplay
when you exit the application.  See the “Starting batch
files” section for more information.

Deselect to return to the directory specified in the
batch file.

[Pause after execution] - pauses after exiting the
application
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Display Options
Select a command display option:

[Window] - displays command execution in a window

[Full Screen] - displays command execution in a full
screen environment

Browse
Displays the contents of a DOS directory from which
you can select a file.

After you specify the required fields in the User Appli-
cation Setup dialog box and click on [OK], the User
Tools window displays an icon labeled with the nick-
name you specified and an .XAP extension to identify
it as a User Tool icon. The .XAP file writes to
drive:\ELIXIR\DESKTOP\SYSTEM\USERTOOL.

Double-clicking on the icon now runs the specified ap-
plication described in the following section.

Starting the application

To start an application for which you have defined an
icon, open the User Tools window and double-click on
the icon.

If you did not select the [Prompt for parameters] op-
tion, the Desktop clears and the application starts.  If
you selected the above option, a dialog box displays
requesting that you enter an argument.  Enter the re-
quired argument and click on [OK] to run the
application.

If you selected the [Pause after execution] option, the
program  prompts you to" press any key to continue"
after exiting the application.  Press any key to return to
the Desktop.

Displaying icon properties

To check or edit the properties of a previously-
specified application in the User Tools folder, select
the application icon and do one of the following:

Select [Properties] from the File menu.
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Select [Tool Props] from the Tools menu on the
User Tools window header.

Press <F2>.

The User Application Setup dialog box displays, show-
ing the information previously specified for the
application.

User Tools example

The following example illustrates how to specify and
run Ventura Publisher from the Desktop using the
User Tools utility and how to create an icon for Elixir's
Web site.

Creating an icon for Ventura Publisher

To create an icon for Ventura Publisher:

1. Open the User Tools icon.

The User Tools window displays.

2. Select [New Tool] from the Tools menu.

The User Application Setup dialog box displays.

        Figure 8-2.  User Application Setup dialog box
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3. Type VP in the [Command to Execute] option.

4. Type VENT in the [Nickname for application:]
option.

5. Type Ventura Publisher in the [Optional Long
Name:] option.

6. Select the [Command is .BAT file] option
(Ventura Publisher runs from VP.BAT, a batch
file).

7. Do not select [Prompt for parameters].

This starts Ventura Publisher without requiring
you to enter a parameter. 

8. Do not select [Pause after execution].

9. Enter the directory path that specifies the
location of your Ventura Publisher executable
files.

For example, if the Ventura Publisher batch
(.BAT) file is on the C: (root) drive; enter C:\.

10. Click on [OK].

The User Tools window shows a User Tools icon
with a VENT.XAP label.

Checking the properties of the Ventura Publisher
icon

To check (or modify) Ventura Publisher icon
specifications:

1. Select the VP icon by clicking on it.

2. Select [Tool Props] from the Tools menu.

The User Application dialog box for Ventura Pub-
lisher displays.  Check the information you en-
tered and make changes if necessary.

3. Click on [OK].
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Starting and exiting Ventura Publisher

To start and exit Ventura Publisher:

1. To start Ventura Publisher, open the VENT
icon in the User Tools window.

The Ventura Publisher main screen displays. 

2. Exit Ventura Publisher.

The Desktop redisplays.  

Creating and icon for Elixir's Web site

To create an icon that automatically connects you to
Elixir's Web site:

1. Open the User Tools icon, then select
ELXWWW.XAP.

2. Select [Tool Props] from the Tools menu.

The User Application Setup dialog box displays.

              Figure 8-3.  User Application Setup dialog box

3. Enter your Internet browser's path in the
[Command to Execute], then click on [OK].
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Default is drive:\NETSCAPE\NETSCAPE.EXE
http://www.elixir.com.

Accessing DOS directories

To access directories and files, open the User Files
icon to display the User Files Directory Paths and Tool
Links dialog box.  An example shows in the following
figure.

  Figure 8-4.  User Files Directory Paths and Tool Links

To specify the target directories (maximum 12), per-
form one of the following:

Enter the directory into which you want to copy
files

When the directory you want to copy files to dis-
plays, select (highlight) it

Select any line that shows a path and edit it

If the directory you enter does not exist, a dialog box
displays requesting confirmation to create a new di-
rectory.  Select [Yes] to create the new directory.  An
empty window for the new directory displays. 
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You can also use wildcard characters to display a fil-
tered list of files in a directory.

Figure 8-5.  Window example

If you enter a directory that does not exist, a dialog
box displays to confirm creating a new directory.

Changing directories

The window header contains a backup button similar
to the button described in the “Elixir folders” chapter.
Click on the backup button to display the contents of
the directory one level closer to the root directory.  Re-
peatedly clicking on the backup button eventually dis-
plays a window showing the active drives on your PC.

For example, if you have the C:\TYPESET\LETTERS
window displayed and you repeatedly click on the
backup button, the following windows display after
each click:

C:\TYPESET

C:\ (the root directory)

Active drive letters (C:, A:, etc.)

To change directories further from the root, click on
any folder icon (<Dir>) to display the contents of the
folder (directory).
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Copying files between subdirectories

To copy one or more files to another subdirectory:

1. Select and drag the file(s) to the User Files
icon.

The User Files Directory Paths and Tool Links
dialog box displays with the path for your speci-
fied file(s) selected.

2. Enter the full path of the directory to copy the
file(s) or select a displaying path, then click
on [OK].

The file(s) you selected copy to the directory you
specified.

Linking files to applications

When you establish a link between an application and
a file, double-clicking on the file icon starts the appli-
cation and loads the file as a parameter to the applica-
tion command (you can link only one application to
one or more files in a directory). 

The Tools menu (accessed from the header of any
open window displayed through the User Files icon)
allows you to establish links between files in a window
and an application (executable or batch file). 

For example, if you link files created by a word proc-
essing program to the word processing application,
double-clicking on any of the file icons starts the word
processing program and loads the selected file in the
program.

You can link files to an application for which a User
Tool exists, or create a User Tool for an application
and link files to it.
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Linking files to an existing User Tool

If you created a User Tool icon for an application, you
link files in a directory to the application as follows:

Select [Tool Link] from the Tools menu to display the
Tool Link Definition dialog box which contains the fol-
lowing options:

    Figure 8-6.  Tool Link Definition dialogbox

UserTool Nickname
Enter the nickname specified when creating the user
tool.  Using the User Tools example in the previous
section, you would enter VENT for Ventura Publisher.

Open only files with extension
Only links files with the extension you specify. Leave
deselected to not use an extension filter.  Files with all
extensions link to the application.

Linking files to a new application

If you have not established an application as a User
Tool icon, you can do so by selecting [New Tool] in
the Tool Link Definition dialog box header to display
the User Application Setup dialog box.

See the “Creating an application icon” section in this
chapter for more information about fields in this dialog
box.

Checking tool properties

After you establish tool links, you can check or modify
entries for the Tool Properties from the Tools menu.
Selecting this option displays the User Application
Setup dialog box for editing.
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Opening linked files

When files in a directory link to an application, double-
clicking on a linked file starts the application and loads
the file in the application.

If you selected [Prompt for parameters] in the User
Application Setup dialog box, the Arguments to this
program dialog box shown in the following figure
displays.

           Figure 8-7.  Arguments to this program dialog box

The parameter (file name) shown in the dialog box is
the file name last entered.  (The example has no pre-
viously entered file name.)

Starting DOS executables

Double-clicking on a .EXE, .COM, or .BAT file
prompts you for an argument (file name) for the ex-
ecutable.  If required, enter an argument, or just click
on [OK] to start the executable.

Starting batch files

When you start a DOS batch file (.BAT) using the
User Tools icon, the Elixir Desktop loads an additional
COMMAND.COM program in system memory to en-
able returning to the Desktop.  The size of the pro-
gram file is about 11 KB.

If the batch file you want to start from the Desktop re-
quires a major portion of available memory, the addi-
tional COMMAND.COM file may not leave enough
memory to run your batch file (for example, a Ventura
Publisher chapter that contains many fonts and para-
graph tags consumes much memory).
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To utilize the maximum amount of system memory,
start batch files as follows:

If possible, start the application directly without
using a batch file.

Do not select the [Command is .BAT File] option
in the User Application Setup dialog box and use
an ASCII editor to add the following lines to the
end of the batch file:

drive: 
CD \ELIXIR
ELIXIR

drive: is the drive on which the Desktop installs.

Use a commercially-available memory manage-
ment program to remove unwanted memory-
resident programs from memory.  Add the com-
mand(s) required to remove the additional
COMMAND.COM program to the first line of your
application batch file.  Select the [Command is
.BAT File] option in the User Application Setup
dialog box.

Using the Dispatcher icon

The Dispatcher icon allows you to specify up to 12
DOS commands with optional embedded replaceable
parameters.  Copying a file to the Dispatcher icon
substitutes the name of the file for the replaceable pa-
rameter and invokes the command.

The Dispatcher icon provides a convenient way to
store commonly-used DOS commands, that you start
using simple mouse operations.

Some examples of functions you can store and run
using the Dispatcher icon are:

DOS batch files

Elixir utilities or batch files
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Quick DOS operations (such as the disk
optimizer).

You can use the Dispatcher icon as follows:

Copy one or more files to the Dispatcher icon and
in the displayed dialog box select the batch com-
mand you want to run with the selected file(s) as
replaceable parameter(s).

Open the Dispatcher icon, enter a batch com-
mand, and enter the name of the file you want to
run as a parameter to the batch command.

Setting up Dispatcher commands

To set up Dispatcher commands, open the Dispatcher
icon to display the Dispatcher Commands dialog box
shown in the following figure.  

           Figure 8-8.  Dispatcher Commands dialog 
          box example

The dialog box allows you to enter and display up to
12 DOS commands.

To enter a command, select a line and type the
command.

You can use a %1 replaceable parameter in the com-
mand line.  When you copy a file to the Dispatcher
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icon and select the command line, the file name sub-
stitutes for the replaceable parameter.

If you want a prompt to enter a parameter each time
you run the Dispatcher command, select the [Prompt
for parameters] option in the User Application Setup
dialog box.  The parameter you specify adds after the
Dispatcher command.

Use the <Backspace>, <Del>, and horizontal arrow
keys to edit a selected line. 

If you frequently run more than 12 Dispatcher execu-
tables, you may want to store eleven of your most
frequently-used commands and leave one line open to
enter other commands as required. 

After entering a command, select [Setup] in the dialog
box header to display the User Application Setup dia-
log box shown in the following figure.

          Figure 8-9.  User Application Setup dialog box

The User Application Setup dialog box shows the
command you entered in the [Command to Execute]
option (you can edit the command, if required).
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The User Application Setup dialog box displays the
following options:

Command to Execute
The command you want to execute through the
Dispatcher.

Nickname/Optional Long Name
Not applicable when setting up Dispatcher
executables.

Working Directory
Optional - allows you to enter the path of the directory
containing the executable (useful if the executable you
are running is does not reside on drive:\ELIXIR and
you did not specify a DOS PATH= statement).

DOS application
Select if you want to specify a DOS application (en-
ables the [Command Attributes] options).

Send Only Filename
Execution of this command uses only the stem name
of the file.

Prompt for parameters
Select to prompt for an argument when executing the
command (see the description for the Dispatcher
Commands dialog box).  This allows you to run com-
mands directly from the Dispatcher icon without re-
quiring you to copy files to the Dispatcher icon. 

Run Minimized
Executes the command in a minimized window.

Command is .BAT file
For a batch (.BAT) file, select to return you to the
Desktop after executing the command.  Leave dese-
lected (the default) to return you to DOS after execut-
ing the command.  If the executable is a batch file that
calls another batch file, you return to the second batch
file. 

Pause after execution
Select to pause after command execution and to
prompt for any keystroke to continue (redisplays the
Desktop).  Otherwise redisplays the Desktop immedi-
ately after command execution.
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Display Options
[Window] displays command execution in a window.
[Full Screen] displays command execution in a full
screen environment.

After specifying options, click on [OK] to redisplay the
Dispatcher Commands dialog box.  Click on:

[Start] to execute the highlighted command

[OK] to update information in the dialog box with-
out executing any commands

[Cancel] to cancel any changes to the Dispatcher
Command dialog box.

Executing Dispatcher commands

You can run DOS command files using the Dispatcher
in two ways:

by copying selected files to the Dispatcher icon

by opening the Dispatcher icon and executing
commands.

Copying files to the Dispatcher

To execute Dispatcher commands by copying one or
more files to the Dispatcher icon:

1. Select one or more files.

2. Copy the selected files to the Dispatcher icon
using any copy procedure, or press <Ctrl> +
<I>, or select [Dispatch] from the File menu.

The Dispatcher Commands dialog box displays.

3. Select the command line for the command
you want to execute, or enter or modify a
command on any line. 

4. Click on [Start]. 
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The Desktop clears, and the command executes mul-
tiple times, each time with one file as an argument to
the command.

Executing commands from the Dispatcher icon

To execute a command and specify a parameter to
the command directly from the Dispatcher icon:

1. Open the Dispatcher icon (double-click on it,
select it and press <Enter>, or just press
<Ctrl> + <I>).

The Dispatcher Commands dialog box displays.

2. Select the command you want to execute.

3. Click on [Setup].

The User Application Setup dialog box displays.

4. Select [Prompt for parameters].

5. Click on [OK].

The Dispatcher dialog box redisplays.

6. Click on [Start].

The Arguments to this program dialog box
displays.

7. Enter any parameter(s) required to execute
the command.

8. Click on [OK].

The command executes with the parameter you
specified.

Dispatcher example

The following example shows how you can use the
Dispatcher icon to issue a DOS TYPE command to
view the contents of an ASCII file.  This example as-
sumes that your AUTOEXEC.BAT file is on your C:
drive.
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1. Open the Dispatcher icon.

The Dispatcher Commands dialog box displays.

2. On a blank line, enter TYPE %1 | MORE and
click on [Setup].

This DOS command lists the contents of an AS-
CII file one screen at a time and then pauses and
prompts you to enter any key to continue. 

3. In the displayed User Application Setup dialog
box select the following options:

[DOS application]
[Pause after execution]
[Full Screen].

Click on [OK] twice to exit the Setup and Dis-
patcher Commands dialog boxes.  

4. Open the User Files icon.

5. On the displayed User Files Directory Paths
and Tool Links dialog box, enter C:\*.* on a
blank line and click on [OK].

A window displays the contents of the C: drive on
your PC.

6. In the window header, select [By Name] from
the View menu.

The contents of your C: drive displays in alpha-
betical order.

7. Select the AUTOEXEC.BAT file and copy it to
the Dispatcher icon.

8. In the displayed Dispatcher Commands dialog
box, select the TYPE %1 | MORE line and click
on [START].

The screen clears and the contents of your
AUTOEXEC.BAT file displays followed by a
“Press any key to continue” message.  Press any
key to redisplay the Desktop.

After specifying the DOS TYPE command in the
Dispatcher Commands menu, you can use the
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procedure above to list the contents of any ASCII
file from the Desktop.

Using the Dispatcher to run Elixir utilities

You can run DOS-based Elixir utilities from the Desk-
top in several ways (for example, by using the DOS
menu).  However, the Dispatcher allows you to con-
veniently run the utilities by copying files to the Dis-
patcher icon and specifying the commands required to
run the utilities in the Dispatcher Commands dialog
box.  The following figure shows an example of a dia-
log box with commands for some Elixir utilities.

            Figure 8-10.  Dispatcher Commands dialog  
            box example

You must install Elixir utilities in the drive:\ELIXIR di-
rectory.  Unless you have included drive:\ELIXIR in a
DOS PATH= statement, either precede each com-
mand shown in the example with drive:\ELIXIR or
specify drive:\ELIXIR for [Full path to executable for
optional lookup] in the User Application Setup dialog
box.

Some Elixir utilities require that you specify the stem
name (file name without the extension) of the file as a
parameter.  To use the Dispatcher for such utilities,
select the [Usage Switches] option from the System
menu and from the displayed dialog box and select
the [Send Only Filename on Dispatches] option.  
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DOS menu

The DOS menu allows you to enter any DOS com-
mand from the Desktop. 

Pull down the DOS menu and select [DOS Com-
mand], the only option.

Alternatively, enter <Ctrl> + <D> at the keyboard.

The DOS Commands dialog box shown in the follow-
ing figure displays.

Enter any DOS command and click on [OK] to exe-
cute the command.

The DOS command you enter executes from the di-
rectory corresponding to the top window on the Desk-
top.  If no windows are open, the command executes
from the root directory (for example, C:\).

       Figure 8-11.  DOS Commands dialog box
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9.  File transfer

This chapter describes procedures for transferring
files between your PC and a MVS host computer and
between your PC and an AS/400 computer using a
PC-to-host file transfer package. It also includes infor-
mation on using the Loader menu options to configure
host connections, specify font libraries, and download
and upload files between an AFP host and a PC.

PC-to-MVS host file transfer

You can use any host-to-PC file transfer package that
allows binary file transmission to transfer AFP font,
page segment image, one-page overlay, and multi-
page AFPDS files between an MVS host and your PC.

Elixir has tested and verified the performance of the
following file transfer packages:

IBM 3270 (recommended)
IRMA FT/3270 (recommended)
IRMA FT/TSO

Binary file transfer ensures that ASCII to EBCDIC
translation does not occur. This requirement is neces-
sary because all files (except OGL files) generated on
your PC by the Elixir Desktop are in EBCDIC format.
The above packages also allow you to transfer source
OGL files produced by Elixir Desktop to an MVS host.
Since source files created by Elixir Desktop are in AS-
CII format, source file uploading requires conversion
to EBCDIC.

Procedures for transferring files with the IBM 3270
and IRMA FT/3270 packages are similar and de-
scribed in a single section.
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Procedures for transferring files with IRMA FT/TSO
are in a separate section.

Installation

To use any of the above file transfer packages, first
install the appropriate PC card, the PC file transfer
software, and the host-resident software. 

Contact your technical support staff if you are not sure
whether you installed all components correctly.

Pre-transfer considerations

The following sections describe setup procedures on
the MVS host and on your PC before you start down-
loading or uploading files.

Downloading files

Note the following before downloading files to your
PC.

Downloading with IBM 3270 or IRMA FT/3270

To download object format AFP files (all except OGL
files) using the 3270 packages, first copy the files to a
dataset with the following DCB attributes:

RECFM = VBM
LRECL = 8205
BLKSIZE = 8209

Downloading with IRMA FT/TSO

To download object-format AFP files (all except OGL
files) using FT/TSO, first copy the files to a dataset
with a variable-blocked (VB) record format.  
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Converting OVE and AFPDS files

If you want to download and convert one-page overlay
(OVE) or multi-page AFPDS files to Elixir format, first
download all fonts and images referenced by the OVE
or AFPDS files and convert them to Elixir font, image,
and screen format files.

Converting Fonts

The Elixir Desktop can convert bounded box and
standard unbounded box AFP fonts. You must down-
load unbounded box AFP fonts to your \ELIXIR\
FONTS\ I38IN directory, and download bounded box
AFP fonts to your \ELIXIR\ FONTS\AFPIN directory.

Each AFP bounded box and unbounded box font con-
sists of the following three files, all of which you must
download:

Coded font file
Code page file
Character set file

The coded font file contains the code page file name
and the character set file name. The first two charac-
ters of a coded font file name are as follows:

If the AFP font is a bounded box font, the first two
characters are X0. 

If the AFP font is an unbounded box font, the first
two characters range from X1 — XG.

The code page file is a table file that assigns hexa-
decimal positions to each character in the character
set file. The code page file name starts with T1. You
can use one code page file for multiple character set
files.

The character set file contains the bit-map font char-
acters. The first two characters of a character set file
name are as follows: 

For a bounded box font, the first two characters
are C0. 

For an unbounded box font, the first two charac-
ters range from C1 — CG.
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Input directory information

The following table shows the directories to which you
must download AFP files for conversion to Elixir for-
mat by Elixir Desktop.

Uploading files

Note the following before uploading files from your PC
to an MVS host.

Uploading with IBM 3270 or IRMA FT/3270

If your version of IBM 3270 and IRMA FT/3270 does
not create host datasets as part of the file transfer
procedure, allocate a host dataset with the following
DCB parameters:

RECFM = VBM
LRECL = 8205
BLKSIZE = 8209

Uploading with IRMA FT/TSO

IRMA FT/TSO requires that your object-format AFP
files (all except OGL files) be fixed-length record files.
To generate the correct fixed-length record files, se-
lect [IRMA] as the output format in the appropriate
AFP Converter Options dialog box. Once on the host,

File type Extension Input directory

Font  any \ELIXIR\FONTS\I38IN
(unbounded box fonts)

Font  any \ELIXIR\FONTS\AFPIN
(bounded box fonts)

AFPDS .AFP \ELIXIR\DOCS\AFPIN

Overlay .OVE \ELIXIR\FORMS\OVEIN

Page 
segment

.SEG \ELIXIR\PICS\SEGIN
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the files break up into VBM format using IEBGENER
(see the “Using IRMA FT/TSO” section in this
chapter).

Fonts

If you have modified the bit-maps of characters in a
font and have not modified code page files or coded
font files, it is only necessary to upload the character
set file to your host computer.

Output directory information

The following table shows the directory to which each
AFP file writes after conversion by the Elixir Desktop.

File type Extension Output directory

Font  any \ELIXIR\FONTS\I38OUT
(unbounded box fonts)

Font  any \ELIXIR\FONTS\AFPOUT
(bounded box fonts)

AFPDS .AFP \ELIXIR\DOCS\AFPOUT

Overlay .OVE \ELIXIR\FORMS\OVEOUT

Page 
segment

.SEG \ELIXIR\PICS\SEGOUT
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Using IBM 3270 or IRMA FT/3270 

The file transfer procedure is determined by the type
of file you want to upload or download:

Source text files such as .OGL files 

Object-format AFP files such as multi-page
AFPDS, one-page overlays (OVE), AFP fonts, or
page segment images

Object-format AFP files are not readable, and are
stored in datasets with the following DCB
specifications:

RECFM = VBM
LRECL = 8205
BLKSIZE = 8209

Downloading object-format AFP files

To download an object-format AFP file from a host
computer, enter the following command at the DOS
prompt:

RECEIVE [path]pcfilename 'hostfilename' BI-
NARY <Enter>

This downloads the object-format file hostfilename to
the PC file pcfilename. A DOS directory path before
pcfilename is optional. For convenience, you may
want to specify the input directory path for the type of
file you are downloading.

Uploading object-format AFP files

To upload an AFP object-format file to your host using
one of the 3270 file transfer packages, follow these
steps:

1. Allocate a dataset on the host with the
following DCB specifications:

DCB=(LRECL=8205,BLKSIZE=8209,
RECFM=VBM)
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2. Enter the following command at the DOS
prompt:

SEND [path]pcfilename 'hostfilename'
CRLF BINARY <Enter>

This uploads the object-format file pcfilename to
the host dataset hostfilename. A DOS directory
path before pcfilename is optional.

Downloading text files

To download a text file (such as a source OGL file)
from your host, enter the following command at the
DOS prompt: 

RECEIVE [path]pcfilename 'hostfilename'
ASCII CRLF <Enter>

This downloads the text file hostfilename to the PC file
pcfilename. A DOS directory path before pcfilename is
optional.

The ASCII parameter specifies that the file be con-
verted from EBCDIC to ASCII.

The CRLF parameter specifies that records in the PC
file are to be separated by carriage return/line feed
combinations.

Uploading text files

To upload a text file (such as a source OGL file), fol-
low these steps:

1. Allocate a dataset on your host with the
following DCB parameters:

DCB=(LRECL=255,
BLKSIZE=3000,RECFM=VB) 

2. Enter the following command at the DOS
prompt:

SEND [path] pcfilename 'hostfilename' ASCII
CRLF <Enter>
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This uploads the text file pcfilename to the host data-
set hostfilename. A DOS directory path before pcfile-
name is optional.

The ASCII parameter specifies that the file be con-
verted from ASCII to EBCDIC.

The CRLF parameter specifies that records in the PC
file are delimited by carriage return/line feed
combinations.

Using IRMA FT/TSO 

This section describes how to use IRMA FT/TSO to
move text files (such as OGL source) and AFP object-
format files between a PC and a host computer.

Downloading object-format AFP files

As FT/TSO cannot download VBM format files, down-
loading AFP object format files requires you first con-
vert the files to variable blocked (VB) format before
downloading.

Converting the file to VB format

Use IEBGENER to convert AFP object format files
from VBM to VB format.

Parameters for downloading object-format AFP
files

To download an object-format AFP file (in VB format),
select the FT/TSO parameters using the following
values:
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Block size: 8209
Record size: 8205
Record format: VB
Line numbers: Position: 0 Length: 0
Code table: STD 
Transfer mode: BINARY
Expand tabs: NO
Truncate spaces: NO 
U/L case: ASIS
Space units: TRKS
Primary QTY: 1
Secondary QTY: 2

Parameters for downloading/uploading text files

For downloading and uploading text files (such as
OGL), use the following sample FT/TSO parameters
values. Note that since host text files may be stored in
datasets with different DCB parameters, you may be
required to change the parameters to match the exact
text file DCB parameters. 

Block size: 3000
Record size: 255
Record format: VB
Line numbers: Position: 0 Length: 0
Code table: STD
Transfer mode: EXT 
Expand tabs: NO 
Truncate spaces: NO 
 U/L case: ASIS
Space units: TRKS 
Primary QTY: 1 
Secondary QTY: 2

Downloading files

To download files with FT/TSO, follow these steps:

1. Change the current directory to the directory
which contains the FT/TSO file transfer
software.

2. At the DOS prompt, type

FT/TSO <Enter>
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3. At the PC file name prompt, enter the name of
a PC file to which you want to download the
host file and press <Tab>.

Optionally, precede the name of the file with the
DOS directory path for the appropriate Elixir input
directory for the type of AFP file you are
downloading.

4. At the dataset name prompt, enter the name of
the host dataset you want to download and
press <Tab>.

5. Enter the appropriate transfer type.

The transfer type you specify depends on whether
you are transferring AFP object-format files, like
page segment images or .OVE format forms, or
text files like OGL forms.

Note: A transfer type is a collection of file transfer
parameters that you can store and name. For de-
tails, see your FT/TSO documentation. 

6. Press <F3> to download a file from the host to
the PC.

Uploading files with FT/TSO

FT/TSO cannot transfer variable-length record files in
binary mode. To upload a variable-length file, follow
these steps:

1. Create the file as a fixed-blocked (FB) format
file by selecting [IRMA] as the output format
in the AFP Converter Options dialog box.

2. Upload the file.

3. Convert the uploaded file to VBM format
using IEBGENER.

The Desktop Converter uses a default block size of
8209 for files formatted for a host dataset. Some files
such as IBM Core fonts may require a larger block
size. If a block length error message displays during
conversion, you may need to increase the default
block size for Elixir.
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To change the block size, use an ASCII editor to mod-
ify the \ELIXIR\DESKTOP\SYSTEM\AFP.INI file Ir-
ma_block_length parameter value for all conversions
(OVE, font, and Pseg.) IBM recommends a block size
of 12288 for font resources under new PSF versions.
The AFP.INI file is similar to the following:

%%Elixir_AFP_Configuration:23.00 Feb 1994
%%Target_Environment=MVS
Irma_block_length = 8209

Parameters for uploading object-format AFP files

To upload an object-format AFP file (in FB format),
select the FT/TSO parameters according to the follow-
ing table:

Block size: Irma_block_length value (AFP.INI)
Record size: same as above block size
Record format: FB
Line numbers: Position: 0 Length: 0
Code table: STD 
Transfer mode: BINARY
Expand tabs: NO
Truncate spaces: NO 
U/L case: ASIS 
Space units: TRKS
Primary QTY: 1 
Secondary QTY: 2

Uploading the file with FT/TSO

To send files with FT/TSO, follow these steps:

1. Change the current directory to the directory
which contains the FT/TSO file transfer
software.

2. At the DOS prompt, type

FT/TSO <Enter>

3. At the PC file name prompt, enter the name of
the PC file you want to upload and press
<Tab>.
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Optionally, precede the name of the file with the
DOS directory path containing the AFP file you
want to upload.

4. At the dataset name prompt, enter the name of
the host dataset to which you want to upload
the PC file and press <Tab>.

5. Enter the appropriate transfer type.

The transfer type you specify depends on whether
you are transferring AFP object files, like page
segment images or .OVE format forms, or text
files like OGL format forms.

Note: A transfer type is a collection of file transfer
parameters that you can store and name. For de-
tails, see your FT/TSO documentation.

6. Press <F1> to upload the file from the PC to
the host.

Converting the host file to VBM format

After uploading an FB file, use IEBGENER to convert
the file to VBM format.

In the IEBGENER JCL job, specify the SYSUT1 and
SYSUT2 (input and output) DCB parameters as fol-
lows if you created the file by selecting the [IRMA]
Output Format option:

DCB=(LRECL=8205,BLKSIZE=8209,RECFM=VBM)

When you configure the DCB parameters as above,
the MVS system catalog views the AFP dataset as a
VBM file (instead of a FB file, the RECFM initially as-
signed to the file). 

The target host library (SYS1.FONTLIB or user-
defined) to which the resources copy after the
IEBGENER copy must have a block size that matches
that of the Irma_block_length value in the AFP.INI file,
and a record length equal to the block size minus 4.
Most font libraries installed for PSF version 2 have a
block size of 12288 and a record size of 12284.
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The following section provides a sample JCL to per-
form this procedure.

Converting FB to VBM format

Use the following JCL to convert a fixed-block file to
VBM format. This is a required conversion if you want
to upload a file using IRMA FT/TSO.

The JCL specifies a VBM record format on both the
SYSUT1 and SYSUT2 steps of the IEBGENER.

//LOADSEG JOB(8200,Z200-Z20001),'KASHANI7-1994',CLASS=A,
//
MSGCLASS=J,NOTIFY=00D42D,USER=00D42D,PRTY=4
//*
//* JCL TO CONVERT VBM FILE TO VB FORMAT
//*
//STEP1 EXEC PGM=IEBGENER
//SYSPRINT DD SYSOUT=*
//SYSUT1 DD DSN=DISK,DISP=OLD,
// DCB=(RECFM=VBM,LRECL=8205,BLKSIZE=8209)
//SYSUT2 DD DSN=SYS1.PSEGLIB (S1TEST),DISP=SHR,
// DCB=(RECFM=VBM,LRECL=8205,BLKSIZE=8209)
//SYSIN DD DUMMY
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PC-to-IBM AS/400 file transfer

This section describes how to upload your files to an
AS/400 computer. The requirements for file transfer
are:

You must install PC Support on your PC.

You must attach your PC to an AS/400.

You must activate the Shared Folders function of
your PC Support session.

The steps involved are as follows:

1. Convert form, image, font, or document files
to AFP format (described in the "File
Conversions" chapter) and specify [AS400] as
the output format in the appropriate dialog
boxes.

2. Create an AS/400 library and file to use as a
temporary storage area for the uploaded
resources.

3. Copy the AFP resource(s) to a Shared Folder
directory. 

4. Move the resource(s) from the Shared Folder
to the temporary file using the CPYFRMPCD
command (Copy From PC Document).

5. Install the resource(s) into the appropriate
AFP library using one of the OS/400 AFP
resource creation commands (CRTFNTRSC,
CRTPAGSEG, or CRTOVL) . You must identify
the libraries your installation uses for storing
print-ready AFP resources.

The following sections describe these steps in more
detail.  
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Creating a temporary holding library and file on the AS/400

To create a library and file on the AS/400, enter the
following commands on the command line in your
AS/400 session (in the following examples, the library
and file that generate are ELXLIB and TEMP,
respectively).

CRTLIB LIB(ELXLIB) <Enter>

This command creates the ELXLIB library. 

CRTPF FILE(ELXLIB/TEMP)
RCDLEN(1024) LVLCHK (*NO) <Enter>

This command creates a physical file with the follow-
ing attributes:

Record length=1024
Record Format Level Check = NO

Copying to the Shared Folder

The Elixir Desktop sees the Shared Folder as a stan-
dard PC hard drive and typically assigns the drive let-
ter I:. You may want to create a directory on the
Shared Folder drive for holding the resources you
copy (in the following example, we use the \ELXFOLD
directory). 

To create the directory, pull down the System menu
and select [Make Directory] (or press <CTRL> +
<M>). In the dialog that displays, type:

 I:\ELXFOLD

Click on [OK] to create the new directory.

To copy resources to the new Shared Folder directory,
open the output folder for the resource you want to up-
load (for example, for overlays, open the AFP OVE
folder).

Select the resources and copy them to the User Files
icon. In the dialog box that displays, enter
I:\ELXFOLD on a blank line and click on [OK]. The
resource(s) copy to the Shared Folder.
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Installing the resources in the AFP libraries

You must now move the resource file(s) from the
Shared Folder into the temporary file and then refor-
mat them to AS/400 database format. First move the
resource from the Shared Folder to the temporary file
by issuing the Copy From PC Document command at
the AS/400 console session. The syntax for the com-
mand is as follows:

CPYFRMPCD FROMFLR(ELXFOLD)
TOFILE(ELXLIB/TEMP)
FROMDOC(resource.nam)
TRNTBL(*NONE)

where resource.nam is the name of the resource file
you are uploading.

Next, reformat the resource into an AS/400 database
object by issuing one of the following commands.
Note that the resource name is used without the 3
character extension:

Overlays - CRTOVL (Create Overlay)

CRTOVL OVL(OVE300/resource)
FILE(ELXLIB/TEMP)

where OVE300 is the installation name for the AFP
Overlay library.

Fonts - CRTFNTRSC (Create Font Resource)

CRTFNTRSC FNTRSC(FONT300/resource)
FILE(ELXLIB/TEMP)

where FONT300 is the installation name for the AFP
Font library.

Page Segments - CRTPAGSEG (Create Page
Segment)

CRTPAGSEG PAGSEG(SEG300/resource)
FILE(ELXLIB/TEMP)

where SEG300 is the installation name for the AFP
Page Segment library.
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The resource(s) are now ready for use with your AFP
printer.

Printing fully composed AFPDS documents

You can also upload and print fully composed AFPDS
documents. To upload AFPDS files, follow the steps
above for moving the file from the PC to the Shared
Folder. Issue the CPYFRMPCD command as above
(you may want to move the document into a file other
than TEMP if you want to save the document).

To print, issue the following command:

PRTAFPDTA FILE(DOC300/TEST)
[FIDELITY(*CONTENT)]

where DOC300 is the installation AFP Document 
Library and TEST is the file to print. 
FIDELITY(*CONTENT) is optional.

Extracting object files from the AS/400 to a PC

Extracting files from the AS/400 involves creating a
special type of AS/400 file called a save file, then sav-
ing the AS/400 AFP resource object (a font, overlay
etc.) to the save file . To convert the file into AS/400
database file format, you must:

send the file to your own userid

receive the file into an AS/400 database file that
you created

Note:  Both files (AFP resource object file and save
file) must have the same record length.

Use the following commands and procedures on the
AS/400 to extract AS/400 objects to a standard
AS/400 database file:
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1. CRTSAVF Objname <Enter>.

Make a note of where (which library) you created
this file (displays in the return message).

2. SAVOBJ objname  LIB(libname)  
DEV(*SAVF)  OBJTYPE(*objtype)
SAVF(libname/objname) <Enter>.

3. SNDNETF objname
TOUSRID((YourUserID SameSystem))
<Enter>.

4. WRKNETF  YourUserID <Enter>.

5. Press PF11 (Display Type/Records).

Make a note of the record length (recl) of the file
you just sent yourself.

6. CRTPF afpfile  RCDLEN(recl)  
FILETYPE(*DATA)  LVLCHK(*NO)
<Enter>.

(This step might be redundant if completed
earlier.)

7. Select option 1 (receive network file) from the
WRKNETF screen.

8. Receive the file into the AFPFile you created
earlier.

Once the objects migrate to a database file, you can
download them to the PC using:

AS/400 PC Support (specify transfer type 6 - no
ASCII to EBCDIC conversion)

CPYTOPCD (Copy to PC Document) command
on the AS/400 to copy the member to the shared
folder using a translation table of (*NONE).
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Using the Loader

You access the Loader menu from AFP Input and
Output folders.  It contains the [Download] or [Upload]
(depending upon whether you access the option from
an Input or Output folder, respectively) and [Configure]
options.

Select the [Download] or [Upload] options to display
the Loader Load dialog box. The following figure dis-
plays the dialog box for the [Download] fonts option. 

         Figure 9-1. Loader Load dialog box

The Loader Load dialog box contains the following
options: 

for Library
The name of the system library (display only).

Download (or Upload)
Allows you to download or upload the files you select
in the Input or Output folder when you select [Selected
Files]; or to download or upload all files in the folder
from which you accessed the Loader menu when you
select [All]. 

File Name(s)
Allows you to enter the file name of the specific file
you want to download or upload (for example,
NEWNAME in the previous figure).  

For File Type
Select [Charset], [CodePage], [CodedFont] or [All] to
identify the font file components you want to download
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or upload. See the "AFP font conversion considera-
tions" appendix for information on each of the
components.

Process
For future implementation.

Process related resources
For future implementation.  

Pause After 
Select to pause after you download or upload files, or
leave unselected to return to the Desktop after the
operation.

Enter New Host Name\Library
Select to display the Host Name dialog box displayed
in the following figure when you click on [OK], or leave
deselected to accept the default host name and host
library.  

Figure 9-2. Host Name dialog box

The Host Name dialog box contains the following
options:

DOS Name
The file name as entered in the Loader Load dialog
box File Name(s) option displays.

New Host Name
The new (alternate) host name.

New Host Library
The new (alternate) host library name.

Select [Configure] from any AFP Folder window
header to display the Loader Remote Library Connec-
tion dialog box shown in the following figure.
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        Figure 9-3. Loader Remote Library Connection 
        dialog box

The Loader Remote Library Connection dialog box
contains the following options:

Remote Library Connection Options
Select [User] to access any loading system, including
AS/400 and NFS libraries; [VM] to connect to a Virtual
Storage library, or [MVS Lib] to connect to a Multiple
Virtual Storage library.

MVS Sub-Options
When you select [MVS Lib] as the Remote Library
Connection option, you can select [PComm], [NFS],
[REXXec] or [APPC] as the MVS sub-option.

Input Library
Enter the input library name when downloading files
from a remote library. The default input library name
for the form, font, or image format you are download-
ing displays.

Output Library
Enter the output library name when uploading files to
a remote library. The default output library name for
the form, font, or image format you are uploading dis-
plays.  
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Receiver & Sender
Enter the receive or send command for downloading
files from or uploading files to a remote library. The
defaults for the form, font, or image format you are re-
ceiving or sending display for the [VM] and [MVS Lib]
connection options.

The syntax for [User] library connections is::

RECEIVE pcfile hostname filetype filemode
(options)

SEND pcfile hostname filetype filemode (options)
where pcfile is the PC file name; hostname is the
name of the resource; filetype is one of the follow-
ing: OGL source (OVERLAY), OVE (OVLY38PP),
Fonts (FONT3820) or Psegs (PSEG38PP);
filemode is the VM/CMS file mode (the default is
A1); and options are the file transfer options: for
text (OGL) (ASCII CRLF RECFM F LRECL 80),
for object (CRLF RECFM 
V LRECL 8205).

For example, a text command could read:

SEND TEST.OGL TEST OVERLAY A1
(ASCII CRLF RECFM F LRECL 80

RECEIVE TEST.OGL TEST OVERLAY
A1 (ASCII CRLF

You can embed %1 to substitute a DOS filename, and
%2 to substitute a file stem name

Lister
This option is not supported for the [PComm] option.
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10.  Transformations

This chapter describes transformation operations you
can perform using the Transformer, which applies
Elixir utilities to modify Elixir-format form and image
files.

These modifications change the file header informa-
tion to make the files compatible with operations such
as uploading files to a host or sending files through a
network. 

To transform an Elixir-format file, you copy it to the
Transformer icon and select the appropriate option as
described in the following sections.

Transformer setup

To set up the Transformer properties, follow these
steps:

1. Right-click on the Transformer icon.

The Transformer Properties dialog box displays.

    Figure 10-1.  Transformer Properties dialog box

2. Click on the [Transformer Properties] button.
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The Transformer Properties Dialog dialog box
displays and contains the following options:

                  Figure 10-2.  Transformer Properties Dialog dialog
box

Working Directory
The directory in which temporary read/writes take
place during file transformations.  The default is
the root (\) directory.  You can specify a RAM disk
for faster transformations.

Confirm file overwrites during transformation
Allows you to specify whether you overwrite exist-
ing output files with files you create using the
same names.  Select this option to display a dia-
log box requesting confirmation before overwriting
an existing file. Not selecting this option automati-
cally overwrites existing files. 

Show properties before transformation
Allows you to specify default setup options for dia-
log boxes for each file transformation type. 

Pause after transformation
Select this option to pause after each
transformation.

Stop process after
Select [Error] to stop a conversion when an error
is reported, or select [All files processed] to stop a
conversion  after processing all files.

3. Click on the [Message Reporting] button.
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The Message Options Dialog dialog box displays
and contains the following options:

                Figure 10-3.  Message Options Dialog dialog box

Message Reporting
Select [Show messages after process] to display
transformation messages in the Message window
after processing, or [Write Messages to LOGfile]
to specify the .LOG file to which transformation
messages are written.

New Messages
Select [Overwrite LOGfile] to overwrite an existing
.LOG file, or [Append to LOGfile] to append new
messages to an existing .LOG file.

Transforming Elixir forms

This section describes Elixir form transformations. To
transform an Elixir form:

1. Copy the .ELX file to the Transformer icon.
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The Form Transformer Options dialog box
displays.

                  Figure 10-4.  Form Transformer Options dialog box

2. Select your option(s), then click on [OK].   

Form Transformer options

The Form Transformer Options dialog box contains
the following options:

Remap

Displays the Page Remap dialog box which contains
the following options:

Figure 10-5.  Page Remap dialog box

Input
Displays the directory and file name of the form(s) you
are remapping.   

Output
Displays the destination directory and file name of the
form(s) you are remapping.
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Original KMP File
The original keyboard mapping assigned to the file
you are remapping.

Target KMP
You can select a keyboard mapping file from the list of
files in the drive:\ELIXIR\FONTS\MAPS directory.
See the "AFP font conversion considerations" appen-
dix for more detailed information about .KMP files.

Rotate

Displays the Page Rotate dialog box which contains
the following options:

      Figure 10-6.  Page Rotate dialog box

Input
Displays the directory and file name of the form(s) you
are rotating.

Output
Displays the destination directory and file name of the
form(s) you are rotating.

Rotate
Allows you to rotate the output forms with respect to
the print direction of the input forms by the number of
degrees you specify ([0], [90], [180], or [270]). 

TRANSFORMATIONS
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Shift

Displays the Page Shift dialog box which contains the
following options:

    Figure 10-7.  Page Shift dialog box

Input
Displays the directory and file name of the form(s) you
are shifting.

Output
Displays the destination directory and file name of the
form(s) you are shifting.

Shift
The number of dots you want the printed page shifted
to the right ([Xshift]) or down ([Yshift]).

FontChange

Displays the Page Font Change dialog box which con-
tains the following options:

      Figure 10-8.  Page Font Change dialog box

Input
Displays the directory and file name of the form(s)
to which you are changing the font.

TRANSFORMATIONS
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Output
Displays the destination directory and file name of
the form(s) to which you are changing the font.

Font Map File
Click on the [FONTLIST] button to select a .LST
font mapping file from the list of files in the
drive:\ELIXIR directory.

Transforming Elixir images

This section describes Elixir graphics file transforma-
tions.  To transform an Elixir image:

1. Copy the .LP3 file to the Transformer icon.

The Graphic Transformer Options dialog box
displays.

Figure 10-9.  Graphic Transformer Options 
dialog box

2. Select [Image], then click on [OK].

TRANSFORMATIONS
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The Image Process Transformation dialog box
displays and contains the following options:

Figure 10-10.  Image Process Transformation 
dialog box

Source File
Displays the directory and file name of the image(s)
you are transforming.

Destination File
Displays the destination directory of the image(s) you
are transforming.  You must enter a file name.  Note
that using the same file name as the original may
automatically overwrite the original file with the trans-
formed file (according to how you set the confirmation
option in the Transformer Properties Dialog dialog
box.)

Mirror
This option allows you to flip an image in horizontal or
vertical directions.  To mirror an image:

1. Select [Mirror], enter a file name in the
[Destination File] option, then click on [OK].

2. In the Mirror dialog box, select [Horizontal] or
[Vertical] and click on [OK].  

TRANSFORMATIONS
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Resize
This option allows you to resize an image up or down
in independent horizontal and vertical percentages.
To resize an image:

1. Select [Resize], enter a file name in the
[Destination File] option, and click on [OK].

2. In the Resize dialog box, enter  the
[Horizontal] or [Vertical]  percentages and
click on [OK].

Note that if you are upsizing an image, you must
have enough space to the right and below the im-
age so that the image stays in the image area.

Reverse
This option changes all black dots in an image area to
white and all white dots in the image area to black.
This option does not require you to set options in any
other dialog box.  Select [Reverse], enter a file name
in the [Destination File] option, and click on [OK].

Shift
This option allows you to move an image area, or the
whole image with respect to its borders with precision.
To shift an image:

1. Select [Shift], enter a file name in the
[Destination File] option, and click on [OK].

2. In the Shift dialog box, select a direction to
shift ([Up], [Down], [Left], or [Right]).

3. Set the number of Pels (pixels) you want the
image to shift.

4. Specify whether you want circular shift and
click on [OK].

The [Shift Circular] option replaces the area that
is moved with a new version of the image.  

TRANSFORMATIONS
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Rotate
This option allows you to rotate an image on the page
by degrees.  To rotate an image:

1. Select [Rotate], enter a file name in the
[Destination File] option, and click on [OK].

2. In the Rotate dialog box, enter  the degree of
rotation and click on [OK].

.
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A.  Keyboard shortcuts

This appendix lists all keyboard shortcuts for Desktop
operations and for child window menus.

Desktop

Close dialog box/menu <Esc>

Organization of the following Desktop keyboard short-
cuts is by pull-down menu.

File menu <Alt> + <F>

Close (top window) <F3>

Convert <Ctrl> + <V>

Copy to <Ctrl> + <C>

Copy quit <Esc>

Delete <Del>

Dispatch <Ctrl> + <I>

Exit <Alt> + <F4>

Formats <Ctrl> + <F>

Help <F1>

Open <Enter>

Print <Ctrl> + <P>

Properties <F2>
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System menu <Alt> + <S>

System Configuration <Alt> + <F6>

Diagnostics <Alt> + <F5>

Make Directory <Ctrl> + <M>

Special menu <Alt> + <P>

Close All <F4>

Efont Factory <Alt> + <E>

Scheduler Action <Alt> + <F3>

Scheduler Setup <Alt> + <F2>

DOS menu <Alt> + <D>

DOS command <Ctrl> + <D>

Window menu <Alt> + <W>

Help menu <Alt> + <H>

Contents <F1>

Windows

Back up one directory level <Ctrl> + <B>

Display start of file list <Home>

Display end of file list <End>

KEYBOARD SHORTCUTS
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Display next page <Page Down>

Display previous page <Page Up>

Filter menu <Alt> + <I>

Jump to files beginning with
letter... press <letter>

Reselect <Ctrl> + <R>

Select adjascent file Left/Right/Up/Down
arrow keys

Select/Unselect All <Ctrl> + <A>

Write Selections <Ctrl> + <W>

By option name

Back up one directory level <Ctrl> + <B>

Close top window <F3>

Close All <F4>

Close dialog box/menu <Esc>

Convert <Ctrl> + <V>

Copy to <Ctrl> + <C>

Delete <Del>

Diagnostics <Alt> + <F5>

Dispatch <Ctrl> + <I>

Display start of file list <Home>

Display end of file list <End>

Display next page <Page Down>

KEYBOARD SHORTCUTS
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Display previous page <Page Up>

DOS <Ctrl> + <D>

Exit Elixir <Alt> + <F4>

Filter menu <Alt> + <I>

Formats <Ctrl> + <F>

Help <F1>

Jump to files beginning with
letter... press <letter>

Make PubFile <Ctrl> + <U>

Open <Enter>

Print <Ctrl> + <P>

Properties <F2>

Reselect <Ctrl> + <R> 

Select adjacent file Left/Right/Up/Down
arrow keys

Select All <Alt> + <A>

Scheduler Action <Alt> + <F3>

Scheduler Setup <Alt> + <F2>

System Config <Ctrl> + <F6>

Unselect All <Ctrl> + <A>

Write Selections <Ctrl> + <W>

KEYBOARD SHORTCUTS

A-4 ELIXIR TECHNOLOGIES CORPORATION



B.  Additional files and
directories

This appendix describes additional files and directo-
ries the Elixir Desktop for AFP uses.

Elixir mapping table directories

This section describes directories that contain map-
ping or correspondence tables.  You can access these
directories using the User Files icon described in the
“Accessing DOS files and applications” chapter.

PostScript mapping table directory

The PostScript mapping table directory
(drive:\ELIXIR\PSSTASH) contains the following map-
ping tables:

PSFONT.MAP
An ASCII file in which each line consists of the six-
character Xerox production printer font file name, an
equal sign (=), and the PostScript equivalent ElixiS-
cript uses.

PSTOP.PSC
This ASCII file contains macros and job setup com-
mands and is added as a header to each PostScript
job.  This file also allows access to international
characters.

PSEND.PSC
The PostScript page terminator code (such as footers,
line draw, page markers, and page eject) in ASCII
format.
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PSTRAIL.PSC
This file is appended to the end of multi-page Post-
Script jobs (status sheet).

See the “File conversions” chapter for more informa-
tion about PostScript processing.

Contour fonts mapping table directory

The contour fonts mapping table directory, drive:\
ELIXIR\FONTS\TABLES, contains the .TFB file cre-
ated when you do not select [Keep Left Kern] in the
Outline-to-raster font generator dialog box (see the
“Accessing DOS files and applications” chapter for
more information).

Bitstream Facelift fonts mapping directory

The Bitstream Facelift fonts mapping directory, drive:\
ELIXIR\FONTS\MAPS, contains the BTFONTS.NAM
and BTFONTS.MAP files.

BTFONTS.NAM
Contains an ASCII list with the following information
for each font: the .TDF font file name, the two-
character font family designator, and the typestyle.

BTFONTS.MAP
Contains a table that maps the name of a new Bit-
stream Facelift font to the name of a PostScript font
on a printer.

ADDITIONAL FILES AND DIRECTORIES
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C.  Desktop menu bar

This appendix describes or refers you to the options
and corresponding keyboard shortcuts (fast keys)
available from the Desktop pull-down menus.

Figure C-1.  Desktop menu bar

File menu

The File menu options perform operations on files,
applications, or attached devices (printers, scanners
and diskette). The following figure shows the File
menu.

Figure C-2.  File Menu

The File menu contains the following options:
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Open (<F2>)

Opens a selected icon as does double-clicking on an
icon.  Opening an icon has different meanings, de-
pending on whether the icon is a folder, Elixir file,
Elixir application, User Tool, peripheral device or icon,
as follows:

When you open a folder, a window displays showing
the contents of the folder.  A folder may contain files
and additional folders.  Each folder corresponds to a
DOS directory. 

When you open an Elixir-format file, the Elixir
Desktop runs the Elixir application associated
with the file.  For example, if you open an Elixir
form file, Elixir Forms Editor runs and loads the
form file you selected.

When you exit the Elixir application, the Elixir
Desktop redisplays.

Opening an application icon clears the Desktop
and runs the application.  When you exit the ap-
plication, the Elixir Desktop redisplays.

When you open the Diskette, Dispatcher, or
Scanners icon, a Properties dialog box displays,
allowing you to set specifications and properties
for these items.

Copy (<Ctrl> + <C>)

Copies a selected file or files to another folder or icon.
When you select this option, the screen pointer
changes to a small document icon attached to an up-
arrow.  To copy the file, click on the folder icon into
which you want to copy the file, as follows:

If copying to an Elixir folder (the Forms, Fonts,
Images or Documents folder icons on the top left
of the Desktop), click on the appropriate Elixir
folder, on an Elixir, Input or Output folder, and fi-
nally on the destination folder.

DESKTOP MENU BAR
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If copying to a non-Elixir folder, click on the User
Files icon to display the User Files Directory
Paths dialog box.  In the dialog box, specify the
directory into which you want to copy the file and
click on [OK].

For information on copying files to and from diskettes
and tapes, see the "Desktop basics" and “Peripheral
devices” chapters.

New

Creates a new file in a window folder.  A dialog box
displays in which you enter the name and extension of
the new file.

If you create an Elixir-format file in an Elixir folder, you
do not need to specify an extension because the Elixir
Desktop creates files with the appropriate extensions.

When you create a new Elixir font, you generate all
three component files.

When you create a new file in the Elixir Documents
folder, you generate a .DAT file with a sample (blank)
form.

Duplicate

Creates a duplicate of a selected file in the same
folder.  A dialog box displays and prompts you to enter
a name for the duplicate file.

If you duplicate a file in any Elixir folder and do not
specify an extension for the [into] option, the extension
appropriate for that folder generates.  

DESKTOP MENU BAR
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Delete (<Del>)

Deletes selected files and empty folders (you cannot
delete a folder that contains files or other folders). 

If [Confirm File Deletions] is selected (in the Desktop
Usage Switch Settings dialog box accessed from the
System menu), a confirmation prompt displays, show-
ing the name of the file.

Properties (<F2>)

Allows you to view or set specifications in dialog
boxes for files, the System Diskette, the converter,
dispatcher, and attached scanners and printers.

Selecting properties for the Diskette icon displays
the System Diskette dialog box described in the
“Desktop basics” and “Peripheral devices”
chapters.

Selecting properties for the Converter icon dis-
plays the Converter Properties dialog box de-
scribed in the “File conversions” chapter.

Selecting properties for the Dispatcher icon dis-
plays the Dispatch Commands dialog box de-
scribed in the “Accessing DOS files and
applications” chapter.

Selecting properties for the Scanners icon dis-
plays the User Application Setup dialog box, de-
scribed in the “Peripheral devices” chapter.

Selecting properties for the Printers icon displays
the Print dialog box described in the "Local print-
ers" appendix.

Print (<Ctrl>+<P>)

Sends one or more selected files to the default Win-
dows printer and port.  See the “Local printers” appen-
dix for more information.

Print Directory Listing

Prints the directory listing for the open Desktop folder.

DESKTOP MENU BAR
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View

This option is similar to copying a file to the Viewer
icon and displays the selected file, if its extension links
with a display application.  For example, you can as-
sociate the .PCX extension with the PaintBrush
application. 

To make a file extension link to an application, use an
ASCII editor to edit the drive:\ELIXIR\ELX.INI file and
add the line extension=application to the file.  For the
above example, you would add PCX= PBRUSH.EXE.

Formats

Displays the File Formats dialog box that shows a list
of folders that contain different formats of a selected
file (files with the same stem name but different exten-
sions).  This feature is useful for checking or deleting
different formats of a file that may exist on your hard
disk.

Convert (<Ctrl> + <V>)

For one or more files selected in any Elixir folder
(Forms, Fonts or Images), choosing this option dis-
plays a Converter dialog box that allows you to specify
the format to which you want to convert the selected
file(s).

Alternatively, copy one or more selected files to the
Converter icon (see the “File conversions” chapter for
more information).

Transform

This option functions the same as using the Trans-
former icon.

Copying an Elixir format file to the Transformer icon
allows applying utilities to the files which generally
modify the file headers without converting the file to
another format. Refer to the "Transformations" chap-
ter for more information.

DESKTOP MENU BAR

ELIXIR DESKTOP FOR AFP USER GUIDE C-5



Dispatch (<Ctrl> + <I>)

With one or more files selected, opens the Dispatcher
Commands dialog box. See the “Accessing DOS files
and applications” chapter for more information.

Close (<F3>)

Closes an open window. Alternatively, click on the
close box on the window header.

Exit Elixir (<Alt> + <F4>)

Closes the Elixir Desktop and returns to Windows.

System menu

The System menu allows you to configure the Elixir
Desktop.  The “Desktop configuration” chapter de-
scribes all options in the System menu.

Figure C-3.  System menu

System Config (<Alt> + <F6>)

Allows you to configure basic system parameters such
as warnings, logo displays,  conversion parameters
and double-click speed.
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Usage Switches

Allows you to customize the Desktop by enabling and
disabling certain options, including confirmation dialog
boxes, property sheets, saving settings on exit, con-
verter selections and processes stop.  

User Privileges

Allows you to set the level of control over certain
Desktop user operations.

For example, you can choose whether or not to allow
a user to access an Elixir application from the Desk-
top.  If you choose not to allow access, the icons rep-
resenting the Elixir application and its associated
folder do not display.

Diagnostics (<Alt> + <F5>)

Allows you to run a number of diagnostic utilities and
to enter a command to run a diagnostic program of
your choice.

Make Directory (<Ctrl> + <M>)

Allows you to create a DOS directory.

Converter Props

Allows you to specify certain initial setup options for
converting files and lets you modify control parame-
ters for the Converter icon.

Transformer Props

Allows you to specify certain initial setup options for
transforming files and lets you modify control parame-
ters for the Transformer icon.

Reset to Defaults

Resets all configuration parameters to the default
values.

DESKTOP MENU BAR
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Refresh

Refreshes the screen display. You can use this option
if closing a window does not completely remove it or
leaves “snow” on the screen.

Toolset 

Allows you to switch between Desktop toolsets.

Special menu

The Special menu contains the options shown in the
following figure.

Figure C-4.  Special Menu

Close All (<F4>)

Closes all open windows on the Desktop.

Efont Factory

Displays the Contour Fonts folder window (drive:\
ELIXIR\FONTS\CONTOURS directory which, if in-
stalled, initially contains 35 Bitstream Facelift contour
font files. 

The Elixir Efont Factory utility makes high-quality
screen and printer fonts for PostScript-compatible
printers from these contour fonts, and any other Bit-
stream Facelift-compatible contour fonts you install in
this directory.  See the “File conversions” chapter for
more information about contour-to-raster font con-
version.

DESKTOP MENU BAR
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Install Fonts

Runs the Bitstream Loadtype program that installs Bit-
stream Facelift fonts on your PC.  

Scheduler Setup (<Alt> + <F2>)

A network-independent enhancement to the Desktop
that automates file conversion and enables stand-
alone “hands off” operation of Elixir tools.

Scheduler Actions (<Alt> + <F3>)

Allows you to define up to eight Scheduler actions
such as testing for a file in a given directory or check-
ing a date and time.

Global View (<Ctrl> + <G>)

Allows you to define how files in Desktop folder win-
dows are to display, such as by Long Name or as
icons.

DOS menu

The DOS menu allows you run to DOS commands
from the Desktop.

DOS Command (<Ctrl> + <D>)

Displays a dialog box allowing you to enter any stan-
dard DOS command. 

Enter a DOS command and click on [OK] to clear the
Desktop and execute the command from the following
directories:

from the drive:\ELIXIR directory, if there are no
windows open on the Desktop

from the directory corresponding to the window, if
a window is open on the Desktop. 

DESKTOP MENU BAR
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After execution, the program prompts you to press
any key to redisplay the Desktop.  

Window menu

The Window menu contains options for arranging the
display of open windows (and dialog boxes) on the
Elixir Desktop.  It also contains an options for opening
a message dialog box that  displays current activities.

The bottom portion of the Window menu shows num-
bered entries allowing you to activate previously
opened windows and dialog boxes.

Figure C-5.  Window menu

The Window menu contains the following options:

Cascade

You can arrange open windows so each header
shows and the active window displays in full on top of
the other windows.

Tile

You can resize and arrange windows side-by-side so
each window displays fully. The active window head-
er displays as highlighted.

Arrange Icons

This option arranges icons in an orderly manner within
a window or on the Desktop.

DESKTOP MENU BAR

C-10 ELIXIR TECHNOLOGIES CORPORATION



Message

This option displays a message dialog box containing
information on current Desktop activity.

Help menu

The Help menu contains Windows on-line help for the
Elixir Desktop.  See the "Introduction" chapter for
more information.
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D.  AFP font conversion
 considerations

This appendix describes issues relating to AFP font
conversions and how to use the desktop Converter to
convert between AFP and Elixir-format fonts. The ap-
pendix also describes site-specific strategies for font
conversion.

For more detailed information, see the ElixirFont for
AFP User Guide.

Bounded box and unbounded box fonts

AFP fonts for IBM 3800 printers are unbounded box
fonts. A characteristic of unbounded box fonts is that
for printing rotated fonts, you need a separate font for
each of the three available rotations of the font (0°,
90°, and 270° from the inline print direction).

AFP fonts for IBM 3812, 3820, 3825, 3827, and 3835
printers are bounded box fonts. For printing rotated
fonts on these printers, you need only one version of
the font that you rotate "on the fly".

Additional filter options

The Filter menu in the Elixir Fonts, Input AFP Fonts,
3800 AFP Fonts, Output AFP Fonts, and 3800 AFP
Fonts window headers display additional options as
shown in the following figure:
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Figure D-1. Filter menu selections

Show Character Sets
Show Code Pages
Show Coded Fonts

Selecting each option displays different components
of fonts as follows:

If displaying the Input or Output AFP or AFP 3800
Font folders, selecting the appropriate option dis-
plays the Character Set, Code Page, and Coded
Font for each AFP font. The next section de-
scribes these components.

If displaying the Elixir Font folder:

[Show Charset] displays the .HDR component of
the Elixir font, that you should use when you want
to convert the font to another format.

[Show CodePage] displays the Elixir Code Page
files (.COD) ASCII files that are the editable
equivalents of AFP Code Pages.

AFP FONT CONVERSION CONSIDERATIONS
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Show Coded Fonts] displays the Elixir Code Font
(.CDF) ASCII files, which list the character set,
code page, and keyboard mapping file for the
font.

The following section describes these files.

AFP font components

Each AFP font has three components:

Character Set
Code Page
Coded Font

Character Set 

The Character Set contains the actual font bitmaps for
characters. For bounded box fonts, character set file
names are C0*. For unbounded box fonts, Character
Set file names are C1* - C4*, where C1 denotes an
inline print direction of 0°, C2 denotes 90°, and so
forth. 

Code Page

The Code Page is a file that maps keyboard entries to
characters in a character set. Each key on a keyboard
corresponds to a hexadecimal code point. When print-
ing, the code point matches to a graphic character ID
(GCID) in the code page (each character has its own
unique ID). Thus different code pages allow printing
subsets of characters in a character set (for example,
for different European languages).  

AFP FONT CONVERSION CONSIDERATIONS
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Figure D-2. Code Page

For bounded box and unbounded box fonts, Code
Page file names are T1*.

Coded Font

A Coded Font links Character Sets to Code Pages.
For bounded box fonts, the Coded Font file name is
prefixed with X0*. For unbounded box fonts, the
Coded Font file names are prefixed with X1* - X4*,
where X1 denotes 0° rotation from the inline print di-
rection, X2 denotes 90°, and so forth.

Note:  X3 is an invalid designation for an unbounded
box font.

Figure D-3. AFP font components

Hex Code Point    Graphic Character ID

         C1                        LA0200000
         ...            
         97                         LP0100000
         ...
         D8                        LQ0200000
         ...
         ...

Character Set

Character Set names Code Page names

Code Page

Coded  Font

Character bitmaps
and IDs

Character IDs and
keyboard mapping
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Country Keyboard Map and PC mapped font
files

When converting AFP Bounded-box or Unbounded-
box fonts to Elixir format, you can convert the full
character set or a PC mapped subset.

A PC mapped subset is an intermediate font file used
for generating screen fonts (for use in ElixirForm) and
HP proof-printer fonts.

The PC mapped subset that gets converted to Elixir
format is determined by a Country Keyboard Map file
(.KMP), which maps AFP graphic character IDs
(GCIDs) for each character to the corresponding AS-
CII keyboard position.

.KMP files are in the drive:\ELIXIR\FONTS\MAPS di-
rectory. Each .KMP file is an ASCII file with the follow-
ing structure:

Figure D-4.   .KMP file structure

The first line is a required comment identifier. The
second line is a label identifying the keyboard map-
ping. Other lines are graphic character IDs (GCIDs)
and corresponding ASCII keyboard positions in hexa-
decimal notation.

%%Elixir_Keyboard_Mapping: 1.0 June 1992

pc_keyboard-"LATIN2 MULTILINGUAL PC"

ss000000=01;

SS010000=02;

SS020000=03;

...

...

SP3000000=FF

AFP FONT CONVERSION CONSIDERATIONS
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The following .KMP files write to the drive:\ELIXIR\
FONTS\MAPS directory during installation:

.KMP file Description

T1000437.KMP Personal Computer for
US English, UK English,
and European languages
using the IBM character
set

T1000850.KMP Pc Multiligual 1 for IBM
PC multinational
keyboards

T1000852.KMP Latin2 Multilingual 2
(Slavic) for Croatian,
Czech, East German,
Hungarian, Polish, Ro-
manian, Slovak, and
Slovenian

T1000855.KMP Cyrillic

T1000857.KMP Latin 5 (Turkish)

T1000860.KMP Portugal

T1000861.KMP Iceland

T1000862.KMP Hebrew

T1000863.KMP Canadian French

T1000864.KMP Arabic

T1000865.KMP Nordic

T1000869.KMP Greek
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To select a .KMP file when converting AFP fonts to
PC mapped Elixir font formats, pull down the System
menu, select [System Config], and in the displayed
dialog box, click on the entry for Country Keyboard
Map. This displays a window corresponding to
drive:\ELIXIR\FONTS\MAPS\*.KMP. The window al-
lows you to select one of the displayed .KMP files.

Note:  US1.KMP and INTL.KMP are older .KMP files
you can still use; however, we recommend you use
the new .KMP files.

To generate a new .KMP file, we recommend you du-
plicate an existing, defined  one for your current PC
keyboard.

Usage notes

1. If a GCID exists in the AFP character set but
not in the .KMP file, the Elixir character does
not generate in the PC mapped font.

2. If a GCID exists in the .KMP file but not in the
AFP character set or code page, an empty
space is inserted with a width of zero.

Files generated for AFP font to Elixir conversions

The Converter generates the following files when con-
verting AFP fonts to Elixir format:

In the [Text Direction Support] option of the AFP Font
Converter Options dialog box, if you selected [Sepa-
rate Fonts], one screen font for each rotation you
specified generates; if you selected [Universal X0],
one screen font generates which Elixir can rotate for
all directions.

In the [Create] option, if you selected [PC Mapped
Font]:

A "PC mapped" (a partial subset) Elixir font gen-
erates (with the required .HDR, .GLH, and .GLY
components) in drive:\ELIXIR\FONTS\ELIXIR.
The Elixir font file name is the same as the Coded
Font file and starts with X.
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An Elixir Coded Font file (.CDF) generates in
drive:\ELIXIR\FONTS\ELIXIR. This ASCII file
contains a table of correspondence between
.KMP, character set, and code page for the font.
The program uses this file for ASCII to EBCDIC
translation when converting Elixir forms (.ELX) to
OVE and OGL formats.

or if you selected [Full AFP Font]:

The full AFP character set converts to Elixir for-
mat (with the required .HDR, .GLH, and .GLY
components) in drive:\ELIXIR\FONTS\ELIXIR.
The Elixir file name is the same as the Coded
Font and starts with C. You can edit this file with
ElixirFont and reconvert it back to AFP format.

 The following files also generate:

An ASCII font metrics (.HDA) file in
drive:\ELIXIR\FONTS\ELIXIR. This file contains
additional AFP font header information  required
when reconverting the Elixir font file back to AFP
format.

Elixir rotation files (.GL0 - .GL4) in drive:\ELIXIR\
FONTS\ELIXIR. These ASCII files contain met-
rics (including A-space, B-space, C-space,
GCIDs, and orientation) information for each
character rotation of the font. When converting
unbounded box fonts, .GL0 generates. When
converting bounded box fonts, .GL1 - .GL4 gener-
ate, depending on the orientations selected in the
AFP Font Converter Options dialog box. 

The Elixir Code Page file (.COD) in drive:\ELIX-
IR\FONTS\ELIXIR. This ASCII file contains
GCIDs and corresponding code points for each
character in the character set. You can edit this
file and use it to generate new code pages for
AFP member libraries.

The Elixir Coded Font file (.CDF) in drive:\ELIX-
IR\FONTS\ELIXIR. This ASCII file contains a ta-
ble of correspondence between .KMP, character
set and code page for the font.  

AFP FONT CONVERSION CONSIDERATIONS
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The PC Mapped font file (X...HDR) if you selected
the [Keep PC Mapped Font] option of the AFP
Font Converter Options dialog box. This file con-
tains only those characters from the AFP charac-
ter set that match those in the selected Country
Keyboard map (.KMP) file.

Default Code Pages

The Default Code Page (or Elixir Code Page) is an
ASCII .COD file in drive:\ELIXIR\FONTS\ELIXIR and
contains GCIDs and corresponding code points for
each character in the character set. An Elixir Code
Page is the Elixir version of an AFP Code Page, and
includes GCIDs and EBCDIC code points that convert
to Elixir format from an AFP font.

You use the Elixir Code Page when converting an
Elixir font to AFP format for the first time (i.e., if you
did not originally convert the Elixir font from an AFP
font). After converting, an AFP Code Page, a required
component of the AFP font, generates.

The Default Code Page you select at installation will
be the default when you run the Elixir Desktop. You
can change the default to another one as described in
the "Desktop configuration" chapter.  The program
uses the Default Code Page in conjunction with the
Country Keyboard Map to translate PC ASCII charac-
ters to EBCDIC characters when you convert overlays
to or from Elixir-format.

You can also download an existing AFP Code Page
from your host computer to the appropriate directory,
convert it to Elixir format, and use it as a default (see
the "File transfer" chapter for information about down-
loading AFP resources, and the "File conversions"
chapter for information about converting AFP Code
Pages to Elixir Code Pages).  
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Editing an Elixir Code Page

You can edit an Elixir Code Page using ElixirFont for
AFP.  Display the Code Pages in the Elixir Fonts
folder (pull down the Filter menu in the window
header and select [Show Code Pages]) and open it to
load the Code Page in ElixirFont.  See the ElixirFont
for AFP User Guide for more information.

You can also use any ASCII editor (like DOS EDIT) to
edit the Elixir Code Page file as follows:

1. Open the Dispatcher icon and specify 
EDIT %1 as a command on a Dispatcher line.

2. In the Dispatcher Commands dialog box, click
on [Setup] and specify the working directory
for the DOS EDIT command (normally
drive:\DOS).

3. Select [DOS application] for the Command
Options parameter and click on [OK].  

4. Click [OK] in the Dispatcher Commands
dialog box to close it.

5. Display the Code Pages in the Elixir Fonts
folder (pull down the Filter menu and select
[Show Code Page]).

6. Drag and drop .COD file you want to the
Dispatcher icon, select the line with the EDIT
%1 command, and click on [Start].  This loads
DOS EDIT and loads the selected .COD file:  
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Figure D-5.  Elixir Code Page example

Brief descriptions of lines in the sample .COD file
above follow (see the AFP Host Font Data Stream
Reference manual for more information):

Line 1: the Elixir header

Line 2: a text description of the code page

Line 3: the number of code points referenced
by the code page 

Line 4: the graphic character ID used when a
 character is not assigned to a code
 point

Line 5: print flags that reference the default
character

Line 6: the code point of the variable spacing
character

Line 7: enables or disables the variable 
spacing flag that allows the set 
variable text instructions to be used 
in the AFP data stream
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Lines 8 - end displays the flags set for each 
code point

When VALID, the character 
referenced by the GCID is 
printed. When INVALID, the
default character is substituted for the
character. 

7. After editing the Elixir Code Page, exit DOS
Editor as follows:

Press <Alt> + <F> to view the DOS Editor File
menu. 

Press <X> to exit the program (the program
prompts you to save or discard any changes).

Font conversion strategies

This section describes how best to respond to dialog
boxes presented by the Elixir Desktop when convert-
ing fonts from AFP to Elixir format.

The section assumes that you are converting AFP
fonts to Elixir format to generate Elixir forms, which
you can then convert to other formats.

The selections you make in dialog boxes are de-
pendend upon the kind(s) of fonts you require and the
type of printer(s) you are using at your site:

AFP bounded box fonts only 
AFP unbounded box fonts only
Hybrid (AFP and Xerox fonts)

When converting AFP fonts to Elixir, the AFP Font
Converter Options dialog box displays.
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Figure D-6. AFP Font Converter Options dialog box

Your response to the [Text Direction Support] option
determines how Elixir screen fonts generate as
follows:

When converting bounded box fonts, [Separate
Fonts] allows you to generate all rotated versions
or selected rotated versions of the screen font
(X1, X2, X3, or X4, where X1 is the horizontal
print direction). [Universal X0] generates only one
screen font; however, ElixirForm can use the sin-
gle screen font for displaying different rotations. 

Note 1: X1, X2, X3, and X4 correspond to the AFP
ACROSS, DOWN, BACK, and UP directions,
respectively.

Note 2:  The generated screen font names will have
the X0, X1, X2, X3, or X4 prefixes.

When converting unbounded box fonts the [Text
Direction Support] option is not available. The ori-
entation of the font you are converting is the ori-
entation of the output font.

For the [Create] option, select [PC Mapped Font]
to create a partial subset of the Elixir font. The
characters converted are defined in the default
Country Keyboard Map file you specify in the
[System Config] option on the System menu.

AFP FONT CONVERSION CONSIDERATIONS

ELIXIR DESKTOP FOR AFP USER GUIDE D-13



Select [Full AFP Font] to convert the entire char-
acter set to Elixir format. 

AFP bounded box font customers

If your printer uses bounded box fonts only, consider
the following:

1. If you require proof-printing of Elixir forms on
a HP printer and want to proof-print using font
directions other than ACROSS, select
[Separate Fonts] and the font directions you
want to proof-print.  HP printers require that a
separate font exist for each font direction.

2. If you do not require proof-printing or you
want to proof-print on a HP printer using only
the converted font in the ACROSS direction,
select [Universal X0].

3. If you want to generate separate fonts for
different rotations, select [Separate Fonts]
and select the required rotation.

AFP unbounded box font customers

When converting an Unbounded-box font to Elixir,
only the orientation of the font converts to Elixir.
Screen fonts for the rotation also generate.  You can
use each converted rotation  for proof-printing.

Hybrid customers

If you are converting fonts from an AFP source into
Elixir format for use in Elixir forms that you will convert
and print on non-AFP (for example, Xerox) printers: 

1. Generate PC-mapped Elixir fonts (non-AFP
fonts generally do not contain as many
characters as AFP fonts).  

2. For bounded box fonts, generate one font for
each rotation of the AFP font that you are
converting by selecting [Separate Fonts] and
the rotation you require.
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Glossary

This glossary provides a list of the basic terms used in
this guide.

Application: Any program you run on your PC. Elixir
applications are represented by icons on the Elix-
irForm/Elixir Desktop. If an Elixir application is not in-
stalled on your PC, its icon does not display. 

Arrow: An arrow-shaped screen pointer used for se-
lecting objects.

Boxed text: Text on a form that is bound by a column
with a set height and width.

Button (on the screen): An area on the screen that
causes a response when you click on it. For example,
an [OK] button that accepts your entries when you
click on it in a dialog box.

Click, on an item: To momentarily press and release
the left mouse button with the screen pointer on an
item.

Close: To exit from a window, dialog box, application,
or the Desktop.

Close box: A small white box at the left of a window
header and at the left of the menu bar. Clicking a
close box on a window header closes the window.
Clicking a close box on the menu bar exits the
Desktop.

Command button: A button in a dialog box that con-
firms or cancels an action when you click on it. The
[Cancel] button cancels the command. The [OK] but-
ton confirms and executes the command and saves
the information you specified in a dialog box.
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Converter icon: The icon that converts font, form, im-
age and document files to and from different formats.

Cursor: A screen pointer used when entering text in
the work area or in a dialog box.

Desktop: The Elixir Desktop working environment,
consisting of the menu bar, the screen area and icons
on the screen.

Dialog box: A rectangular box that displays and re-
quests information. You enter information in fields in
the dialog box, and normally confirm your entries by
clicking on an [OK] button or by pressing <Enter>.

Directory: A list of hard disk or diskette contents.
Desktop directories are represented by folder icons.
Folder contents can be viewed pictorially, alphabeti-
cally, by icon, by size, or by date.

Dispatcher icon: The icon in the Elixir Desktop that
stores and invokes a number of DOS commands.

DOS:  Disk Operating System, the collection of pro-
grams that gives control of a PC's resources to the
user.

Double-click: To press the left mouse button twice in
rapid succession, normally to open an icon.

Drag: To click on an item and move the item with the
mouse while holding down the left mouse button.

Drag and drop: A method used to copy an object as
follows: click on an item on the screen, hold down the
left mouse button, move the mouse to move the
screen pointer to an icon, then release the mouse
button.

Drop: To release the mouse button after dragging an
item to an icon.

Elixir folders:  The folders represented by the four
top left icons on the Desktop: the Forms, Fonts, Im-
ages and Documents folders. Each of these folders
contains a subordinate Elixir, Input and Output folder. 
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Extension: The period and three characters following
a file name. An extension identifies the type of infor-
mation in a file. For example, .ELX indicates an Elixir
format form file. 

Fast Keys:  See Keyboard shortcuts.

File filter: The use of DOS wildcard characters to dis-
play only those files with selected name characteris-
tics in a window or dialog box. For example, to display
only files that begin with ABC in a directory of many
files you could enter ABC*.*. See also, Wildcard
character.

File name: The name of a file. The ElixirForm/Elixir
Desktop uses DOS file naming conventions. DOS file
names consist of a base (stem) name containing up to
eight characters and an extension of up to three
characters. 

Folder icon: The Desktop icon representing a DOS
directory. Folders allow you to quickly organize infor-
mation on the Desktop.

Format: To prepare a diskette so it can hold informa-
tion. Formatting a diskette erases the information on
the diskette. 

Form elements: The individual lines, shapes, images,
and text that compose a form. You can create,
change, move, copy, delete, import, or load a form
element.

Form template: A form loaded as an overlay or visual
guide only for the purpose of designing new form ele-
ments around it. A form template does not become
part of the form when the form is saved, only the new
elements added are saved with the form. 

Free text: Text on a form that is not bound by a col-
umn with a set height and width. The width of the form
is the only restriction.

Grayed options: Grayed options are menu options
you cannot choose because they do not apply to your
current selection. Also called dimmed options.
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Head to head: In duplex printing, when the page top
is printed in the same position on both sides of the
page.

Head to toe: In duplex printing, when the top of one
side of the page is printed in the same position as the
bottom of the other side of the page.

Highlighted: A highlighted option appears darkened
on the screen, and indicates that it is selected.

Icon: A small, roughly rectangular-shaped symbol on
the Desktop that represents an application, a file, a
folder, or a peripheral device.

Importing files: The process of copying non-Elixir
format files from different storage media (such as a
hard disk, a diskette, or tape) to the appropriate Desk-
top input folder or to the Work area.

Information box: A white square at the right of the
menu bar identified with an "i". Clicking on the infor-
mation box displays information about the open Elixir
Desktop application.

Inverse Landscape: The orientation of fonts, logos,
or images on a page. See the definition for portrait for
a figure describing the orientation of fonts on pages.

Inverse Portrait: The orientation of fonts, logos, or
images on a page. See the definition for portrait for a
figure describing the orientation of fonts on pages.

Kerning: Adjusting the spacing between characters to
make certain letters appear better fitted together and
more attractive on the page. 

Keyboard shortcut: Also called Fast keys. A special
one- or two-key combination that allows you to exe-
cute an option without using the mouse. Keyboard
shortcuts are shown on each menu beside the name
of the option and are listed in the “Keyboard shortcuts”
appendix.

Landscape: The orientation of a page or the fonts, lo-
gos, or images on a page. A landscape page is nar-
rower on the sides than on the top. See the definition
of portrait for a figure describing the orientation of
fonts on pages.
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Menu: A list of options from which you make a selec-
tion to perform an action. A menu displays when you
select a menu title from the menu bar or from a win-
dow header, or when you click on an option.

Menu bar: The horizontal bar displayed at the top of
the Desktop from which you access pull-down menus.

Menu titles: Text that identifies a menu, displayed in
a window header or on the menu bar.

Message area: A bar just below the menu bar that
displays error messages or information about the ac-
tivity you are performing.

Mouse button: A button on the top of the mouse.
ElixirForm uses the left and right buttons of a mouse. 

Multi-select: Selecting more than one file or icon by
shift-clicking on them.

Open a folder, Elixir file, application, or peripheral
device: 1.) Opening a folder icon displays a window
showing the contents of the folder. 2.) Opening an
Elixir file icon starts the application that created the file
and loads the file .  3.) Opening an application icon
starts the application. 4.) Opening a peripheral device
displays a dialog box allowing you to set the device
parameters.

Option: A word or phrase in a menu that you can
select.

Peripheral (device): A printer, scanner, or tape drive
connected to your PC. 

Point: To move the mouse so the screen pointer (in
most cases an arrow) rests on the desired item.

Portrait:  The orientation of a page, or the fonts, lo-
gos, or images on a page. A portrait page is narrower
on top than on the side (like pages in this book). See
the following figure for the orientation of fonts on
pages.
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  Orientation of fonts on Portrait (left) and
Landscape pages

Printer icon: An icon representing a proof printer con-
nected to your PC.

Pull-down menu: See menu.

Raster graphics: Pictures composed of bit maps,
where each element of the picture is a dot defined as
black or white.

Replaceable parameter: A parameter (usually %1)
used in commands to represent a selected file name.
The selected file name replaces the parameter during
certain operations.

Run: To execute or start an application. 

Scanner icon:  The icon representing a scanner con-
nected to your PC.

Screen pointer: A pointer shaped like an arrow that
displays on the screen, and which you can move by
rolling the mouse on a flat surface.

Screen version: The version of a color or font com-
posed such that its appearance on a screen display is
as close as possible to its appearance when printed. 

Scroll: To move a directory list in a window so you
can view different parts of the list.
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Scroll bar: A bar displayed on the right side of some
windows used for scrolling. The scroll bar contains a
scroll arrow, [+] and [-] buttons, and a slider bar that
moves within the scroll box.

Select: To click on an object, menu option, or form
element. A selected item appears highlighted.

Shift-click: To click on an object while holding down
the <Shift> key. Usually used to select multiple
elements.

Slider bar: A bar in the scroll box at the side of some
windows that scrolls items in the window when you
drag it up and down.

Snap to: A function that causes form elements to
automatically align with the nearest grid point when a
grid is displayed in the Work area.

Tape icon: The icon representing a tape drive con-
nected to your PC.

Trashbin icon: The Trashbin icon is in the lower right
corner of the Desktop and represents a receptacle for
items you want to delete. You delete a file by dragging
it to the Trashbin icon.

UDK: (User Defined Key) a substitute escape charac-
ter defined by a user for specific print jobs

Unselect: To cause one or more selected (high-
lighted) icons or elements to not be selected any
more. The quickest way to do this is to click on an-
other area of the Desktop or Work area.

UserTools icon: The icon that links applications to
files.

Utilities: Special-purpose applications with which you
can perform functions from the DOS prompt. 

Wildcard character: A character in a file name, usu-
ally an asterisk (*), that specifies a matching set. For
example, *.EXE represents all files that end with the
.EXE extension.

Window: A rectangular area on your screen in which
you view information, such the contents of a folder. All
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windows contain a window header. Some windows
have scroll bars along the right side. 

Window header: The top of a window that displays
the DOS directory corresponding to the window con-
tents. Some window headers also show a close box
and a number of menu titles with pull-down menus.
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verter Options dialog
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Transformer Proper-
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TrueType Fonts At-
tributes, 7-51
User Application
Setup, 8-3
User Files: Directory
Paths and Tool
Links, 5-4, 5-12,
5-13, 8-10
User Privileges, 4-7

Dialog box Help, 1-7
directories

accessing, 8-9
Bitstream Facelift
mapping, B-2
changing, 8-11
contour fonts map-
ping, B-2
creating, 4-10
KMP files, 7-42, D-5
mapping, 3-21
PostScript mapping,
B-1
structure, 3-1
User Files, 8-9

diskette
accessing, 6-1
DOS format, 5-16,
6-1, 6-2
Elixir-format, 5-15
properties, 4-5
system, 5-15, 6-2
Xerox format, 6-1

Diskette icon, 2-5, 5-3,
5-14, 6-1
Diskette Properties dia-
log box, 4-5
Dispatcher, example,
8-21
Dispatcher Commands
dialog box, 5-4
Dispatcher icon, 2-6,
5-4, 8-2, 8-15

display options, files,
2-11
Docs Jobs

Elixir folders, 3-18
Document Converter
Options, 7-77
Document Converter
Options dialog box, 7-77
documents

converting, 7-4, 7-77
Elixir Documents
folder, 3-16
folders, 3-15
Input Documents
folder, 3-16
Output Documents
folder, 3-17

Documents folder, 2-3,
3-15, 7-4
DOS

access, 2-12, 4-9,
8-1, 8-9, C-10
batch files, 8-14
commands, 8-17,
8-24, C-10
copying files, 5-13
directories, 3-1, 8-9
diskette, 5-13, 5-14,
6-1
executables, 8-14
folders and directo-
ries, 3-1
linking files, 5-4
menu, 2-12, 8-24,
C-10
storing commands,
8-16

DOS menu, 8-24, C-10
DOSVSE utility, 7-93
double-byte font

AFP, 7-44
converting, 7-44,
7-45
Elixir, 7-45

double-click speed, 4-4
downloading files

converting fonts, 9-3
from AS/400, 9-18
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FT/TSO parame-
ters, 9-9
object files, 9-3, 9-7
overview, 9-2
text files, 9-7
using 3270, 9-6
using FT/TSO, 9-9

E
Efont Factory, 7-61
ElixiKey, 4-10
Elixir applications

conventions, 1-3
Help, 1-6

Elixir code page, D-9
Elixir folders

changing display,
3-4
Data Jobs, 3-19
Docs Jobs, 3-18
Documents, 3-16
Fonts, 3-9
Forms, 3-6
Graphics, 3-13
structure, 3-2

Elixir highlight color
forms

printing, 6-8
Elixir HP Driver dialog
box, 6-13
Elixir Image Viewer,
5-30
Elixir Publication File
dialog box, 5-18
Elixir Web site

creating icon for, 8-8
ElixirDoc icon, 7-96
ElixirFont

installation, 1-9
ElixirForm font default,
5-31
ElixirForm icon, 2-4
ELX2VSE utility, 7-94
Enter Path of Directory
to Create dialog box,
4-11

exiting the Desktop,
1-10
Extra Converter Options
dialog box, 7-72
extracting files from
AS/400, 9-18

F
fast keys, A-1, A-4
FGIDs, 7-20, 7-36, 7-88
File Formats dialog box,
5-7
File menu, 5-1, C-1
File Name Entry dialog
box, 5-7
File Object Properties
dialog box, 5-5
file transfer

AS/400, 9-14
configuration, 9-2
converting fonts, 9-3
downloading AFP
files, 9-7
downloading text
files, 9-7
from the host, 9-2
initial setup, 9-2
input directories, 9-4
object files, 9-7
output directories,
9-5
OVE/AFPDS files,
9-3
overview, 9-1
to the host, 9-5
uploading AFP files,
9-7
uploading text files,
9-8
using IBM 3270, 9-6
using IRMA
FT/3270, 9-6
using IRMA
FT/TSO, 9-9
using the Loader,
9-20

files
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.BAK, 3-6

.BAT, 8-14

.COM, 8-14, 8-15

.DAT, 7-4

.DCK, 7-94

.ELX, 7-2, 7-4

.FAM, 7-20, 7-36,
7-88
.HDR, 7-3
.INV, 3-6
.KMP, D-5
.LOG, 7-22
.LP3, 7-3, 7-36, 7-72
.OGL, 7-22
.PCX, 5-29, 7-75
.PUB, 3-6, 5-17
.SYS, 8-2
.TDF, B-2
.TFB, 7-64, B-2
.TIF, 7-75
.TXT, 7-72
access alternatives,
4-8
AFPDS, 7-90
AUTOEXEC.BAT,
4-10, 8-2, 8-21
batch (.BAT), 8-14
BTFONTS.MAP,
B-2
BTFONTS.NAM,
B-2
CL4.DEF, 7-94
code page, D-3
COMMAND.COM,
8-14
CONFIG.SYS, 4-10,
8-2
confirm/warn set-
tings, 4-5
confirm conversion,
7-95
conversion process,
7-8
converting, 7-1
copying, 5-11, 8-12
DEFAULT.FAM,
7-20, 7-36, 7-88

deleting, 4-5, 7-95
display options, 2-11
downloading, 9-2
editing, 3-3
graphics, 5-29
HP PCL, 7-25, 7-28
INSTALL.LOG,
4-10, 8-2
linked, 8-14
linking, 5-4, 8-12
management, 5-6
PostScript, 7-28
properties, 5-5
PSEND.PSC, B-1
PSFONT.MAP, B-1
PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
transfer packages,
9-1
transfering, 9-1
transforming, 10-1
uploading, 9-5
versions, 5-6

Filter menu, 2-7, D-2
folder display

changing, 3-4
folders

changing display,
3-4
copying files, 5-17
Desktop, 3-1
Documents, 3-15,
7-4
Elixir, 3-2, 3-3, 5-2,
7-2
Elixir Data Jobs
folder, 3-19
Elixir Docs Jobs
folder, 3-18
Elixir Documents
folder, 3-16
Elixir Fonts folder,
3-9
Elixir Forms folder,
3-6
Elixir Graphics
folder, 3-13
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Fonts, 2-3, 3-9,
3-18, 7-3
Forms, 2-3, 3-6, 7-2
Graphics, 2-3, 3-13
Images, 7-3
Input, 3-3
Input Documents
folder, 3-16
Input Fonts folder,
3-10
Input Forms folder,
3-7
Input Graphics
folder, 3-13
Output, 3-3
Output Documents
folder, 3-17
Output Fonts folder,
3-11
Output Forms folder,
3-8
Output Graphics
folder, 3-14
structure, 3-2
User Files, 2-4

Font-Related Converter
Options dialog box, 7-60
Font Converter Options
dialog  box, 7-38
Font Global Identifiers,
7-20, 7-88
font requirements

HP or compatible
printers, 7-38

fonts
adding HP PCL
fonts to a Windows
application, 7-69
AFP components,
D-3
AFP conversion, D-1
Bitstream Facelift,
7-61, B-2
Bitstream Fontware,
7-61
bounded box, D-1,
D-14

BTFONTS.MAP,
B-2
BTFONTS.NAM,
B-2
character set, D-3
coded font, D-4
contour, 7-61, B-2
conversion strate-
gies, D-12
converter options,
7-37
converting, 7-3, 7-37
CPGID, 7-37
DDNAMES, 7-19,
7-87
Elixir fonts folder,
3-9
FGIDs, 7-36
GCID, D-3
GCSGID, 7-37
generating Elixir
fonts, 7-68
generating non-Elixir
fonts, 7-68
HP PCL, 7-46
HP PCL in Windows
applications, 7-47
HP PCL soft fonts,
7-47
Input Fonts folder,
3-10
kerning, 7-64
loading, 7-27, 7-32
mapping, 7-20,
7-61, 7-65, 7-88
name, 7-63
naming conventions,
7-65
orientation, 7-65
outline, 7-61
outline-to-raster font
generator, 7-63
Output Fonts folder,
3-11
PSFONT.MAP,
7-64, B-1
PSSEND.PSC, B-1
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PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
screen, 7-69
TrueType, 7-50
unbounded box,
D-1, D-14

Fonts folder, 2-3, 3-9,
3-18, 7-3
Form Converter Options
dialog box, 6-9, 7-9
Form Print Properties
dialog box, 7-26
Form Transformer Op-
tions dialog box, 10-4
Formdefs

converting, 7-92
forms

converting, 7-2, 7-9
converting to graph-
ics, 7-36
Elixir Forms folder,
3-6
Input Forms folder,
3-7
orientation, 7-31
Output Forms folder,
3-8
PDF, 7-32
PostScript, 7-28
transformer options,
10-3

Forms Converter Op-
tions dialog box, 6-9
Forms folder, 2-3, 3-6,
7-2
FT/3270, 9-1
FT/TSO, 9-1

G
GCSGID, 7-37
Global Character Set ID,
7-37
Global View dialog box,
3-4
Graphic Transformer
Options dialog box, 10-7
graphics

converting to a font,
7-72
Elixir Graphics
folder, 3-13
Elixir Image Viewer,
5-30
Input Graphics
folder, 3-13
Output Graphics
folder, 3-14
tiles, 7-72

Graphics folder, 2-3,
3-13

H
Help, on-line, 1-6
Help hypergraphics, 1-7
Help menu, 1-6, C-11
Help pop-ups and
jumps, 1-7
Host Name dialog box,
9-21
HP Font Converter Op-
tions dialog box, 7-46
HP or compatible
printers

font requirements,
7-38

HP PCL
fonts, 7-47

Hybrid conversions,
D-14

I
IBM/IRMA 3270, 9-6
icons

applications, 8-2
checking properties,
8-8
Clipboard, 2-4
Converter, 2-6, 7-1
create (example),
8-6
Desktop, 2-2
Diskette, 2-5, 5-3,
6-1
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Dispatcher, 2-6, 8-2,
8-15
Documents, 2-3, 7-4
Elixir Web site, 8-8
ElixirDoc, 7-96
ElixirForm, 2-4
folders, 2-3
Fonts, 2-3, 7-3
Forms, 2-3, 7-2
Graphics, 2-3
Images, 7-3
Jobs, 2-4
modifying, 5-5
opening, 5-1, 5-3
Other Elixir applica-
tions, 2-4
Printers, 2-5, 5-3
properties, 5-5
Scanners, 2-5, 5-3,
6-3
Transformer, 4-14
Trashbin, 2-6
User Files, 2-4, 3-2,
5-11, 8-1, 8-9
User Tools, 2-5, 8-1,
8-2
Ventura Publisher,
8-6
Viewer, 2-6, 5-29

IEBGENER utility, 9-9,
9-13
Image Converter Op-
tions, 7-71
Image Converter Op-
tions dialog box, 7-71,
7-75
Image Process Trans-
formation dialog box,
10-8
Image Viewer, 5-30
images

.PCX and .TIF con-
versions, 7-75
adding color during
conversion, 7-76
converter options,
7-71
converting, 7-3, 7-71

transformer options,
10-7

Images folder, 7-3
Input folders

Documents, 3-16,
3-17
Fonts, 3-10
Forms, 3-7
Graphics, 3-13
structure, 3-3

INSTALL.LOG, 4-10, 8-2
installation, 1-9
IRMA FT/TSO, 9-9

J
Jobs folder, 2-4

K
kerning, 7-64, 7-68
keyboard mapping, 7-35
keyboard shortcuts, A-1,
A-4
KMP file, 7-42, D-5

L
linked files, 8-14
linking files, 8-12
Loader Load dialog box,
9-20
Loader menu, 9-20
Loader Remote Library
Connection dialog box,
9-22
Local view, 2-11
Local View dialog box,
3-5
logo, display, 5-9

M
mapping, 7-65, B-1

Windows character
set, 7-69

mapping table
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Bitstream Facelift
fonts, B-2
code page, D-3
contour fonts, B-2
directories, 3-21,
B-1
PostScript, B-1

MCF Fonts dialog box,
7-15, 7-83
memory, 4-9
menus

Desktop, 2-1, 5-1,
C-1
Desktop menu bar,
2-1
DOS, 2-12, 8-24,
C-10
File, 5-1, C-1
Filter, 2-7, D-2
Help, C-11
Loader, 9-20
options, C-1
Selection, 2-9
Special, 4-1, 5-1,
C-8
System, 4-1, 5-1,
8-23, C-6
Tools, 8-2, 8-12
View, 2-10
Window, C-10

message area, 2-1
Message Options Dialog
dialog box, 4-13, 4-15,
7-7, 10-3
Mirror dialog box, 10-8
monochrome monitor
setup, 4-6
mouse, 1-4
MVS host, 7-28, 9-1

O
other Elixir application
icons, 2-4
Outline-to-raster font
generator dialog box,
4-12, 7-63
Output folders

Fonts, 3-11
Forms, 3-8
Graphics, 3-14
structure, 3-3

P
Page Converter Options,
7-11, 7-80
Page Databasing dialog
box, 7-22
Page Font Change dia-
log box, 10-6
Page Remap dialog box,
10-4
Page Rotate dialog box,
10-5
Page Shift dialog box,
10-6
Page Source Converter,
7-85
Page Source Converter
Options dialog box,
7-18, 7-86
Pagedefs

converting, 7-92
PaintBrush, 5-29
peripheral devices, 6-1
PostScript

printing, 6-15
PostScript Converter,
7-29
PostScript Converter
Options dialog box, 4-12
PostScript Converter
Properties dialog box,
7-29
PostScript mapping ta-
ble, B-1
Print dialog box, 5-8,
6-7, 6-12, 6-15, 6-16
Print Driver Dialog dialog
box, 6-9
printer-specific

AFP printer resolu-
tion, 7-12, 7-80
print drivers, 7-25,
7-28
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Printers icon, 2-5,
5-3
printing Elixir forms,
6-6
printing non-Elixir
forms, 6-10
proof printing, 6-6
properties, 4-5

Printer Properties dialog
box, 4-5
Printer Setup dialog box,
6-10
Printers icon, 2-5, 5-3
printing

Desktop folder con-
tents, 5-7
Elixir forms, 6-6
Elixir forms with
highlight color, 6-8
non-Elixir forms,
6-10
PostScript, 6-15

proof printing, 6-6
properties

Converter, 4-6, 4-11,
7-4
diskette, 4-5
displaying icon, 8-6
ElixiScript Con-
verter, 7-28
file, 5-5
icons, 5-5, 8-6
printer, 4-5
scanner, 4-5, 6-3
tool, 8-14
Transformer, 4-14,
10-1
user application, 6-3

PSEND.PSC, B-1
PSFONT.MAP, B-1
PSSTASH, B-1
PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
PUB files, 5-18

copying, 5-19
creating, 5-17
restoring from disk-
ette, 5-20

Q
Quick Help, 1-6

R
refreshing screen, 4-15
Resize dialog box, 10-9
Rotate dialog box, 10-10

S
Scanner Properties dia-
log box, 4-5
scanners

icon, 6-3
properties, 4-5, 6-3

Scanners icon, 2-5, 5-3,
6-3
Scheduler Desktop

actions/tasks, 5-23
setup, 5-22
testing examples,
5-26
use, 5-21

screen, refreshing, 4-15
screen fonts, 7-69
Selection menu, 2-9
Shift dialog bo, 10-9
shortcuts, keyboard, A-1
Special menu, 4-1, 5-1,
C-8
starting the Desktop, 1-9
sub-window, 2-7
support, customer, 1-2
SYSTEM.INI file, 2-7
system configuration,
4-2
system diskette, 5-15,
6-2
System Diskette dialog
box, 5-14, 5-15
System menu, 4-1, 5-1,
8-23, C-6

T
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TDF file, 7-68
Tool Link Definition dia-
log, 8-13
tool properties, 8-14
Tools menu, 8-12, 8-14
toolsets, 4-16
Transformer

icon, 10-1
properties, 4-14,
10-1
setup, 10-1

Transformer icon, 2-6
Transformer Properties
dialog box, 4-14, 10-1
Transformer Properties
Dialog dialog box, 4-14,
10-2
transforming

forms, 10-3
images, 10-7

Trashbin icon, 2-6
TrueType fonts, 7-50
TrueType Fonts Attrib-
utes dialog box, 7-51

U
Uploading files, 9-5
uploading files

FT/TSO parame-
ters, 9-10, 9-12
object files, 9-7
overview, 9-5
text files, 9-8
to AS/400, 9-14
using 3270, 9-6
using FT/TSO, 9-9

usage switches, 4-4
User Application Setup,
8-18
User Application Setup
dialog box, 8-3
User Files

directories, 8-9
tool links, 8-9

User Files: Directory
Paths and Tool Links

dialog box, 5-12, 5-13,
8-10
User Files icon, 2-4, 3-2,
5-11, 8-1, 8-9
user privileges, 4-7
User Privileges dialog
box, 4-7
User Tools

creating application
icons, 8-2
displaying icon prop-
erties, 8-6
example, 8-6
starting an applica-
tion, 8-5

User Tools icon, 2-5,
8-1, 8-2
utilities

running, 8-23
using the Dis-
patcher, 8-23

V
Ventura Publisher

creating an icon, 8-6
from the Desktop,
8-6

View menu, 2-10
Viewer icon, 2-6, 5-29
VM host, 7-28

W
Window menu, C-10
Windows

adding HP PCL
fonts, 7-69
and the Desktop,
2-1
character set, 7-69
keyboard shortcuts,
A-2
operating system,
2-1
PaintBrush, 5-29
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print driver, 7-25,
7-28, 7-30
print drivers, 6-6

Windows applications
adding HP PCL
fonts, 7-47

Windows character
mapping, 7-69
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